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Chapter 1 

Introduction to Legacy  
Installing Legacy and Learning the Basics 

 
 
Welcome to Legacy, the premier program for working with your family history. In this 
introduction you will find the following information: How to install Legacy and what to 
do when it opens on your screen; what the options are on the ribbon bar and toolbars; 
what the different views (Legacy Home, Family, Pedigree, Descendant, Chronology, and 
Index) show; and what you can do in the views. 

 

Installing Legacy 

New Users 
Installing from the Web: 
It is recommended that you download Legacy from our website on the Internet.  This 
ensures that you are getting the latest update of the program.  Even if you have been sent 
a physical CD-ROM with the Legacy installation program on it, we still suggest that if at 
all possible, you should download the latest version. 
The latest update of Legacy is always available at: 

http://LegacyFamilyTree.com/DownloadLegacy.asp 
From this web page, you can download Legacy by choosing either Download Legacy 9.0 
Standard Edition or Download Legacy 9.0 Deluxe Edition.  The two choices actually 
take you to the same place to start the download by first asking for your email address 
and name.  You are also asked to indicate that you are not a robot by checking a box.  
After doing so, click the Next Step ->> button.  Legacy will immediately send you an 
email with the download link included.  Just click the link to display the download page 
and click on the Click Here to Download button.  Depending on what browser you are 
using, it will generally tell you or ask you where to download the installation file.  After 
it is downloaded, all you have to do is start the program (often just by clicking or double-
clicking the filename shown at the bottom of your browser window – or by double-
clicking the filename wherever you downloaded it to.  After doing so, just follow the 
prompts.  After Legacy is installed, it will automatically start.  If it is the first time you 
have installed version 9, it will take you through a startup wizard where you can choose 
some basic settings and enter your Deluxe customer number if you have one. 
 
Installing from the CD-ROM 
If you don’t have Internet access, you can initially install Legacy from your CD-ROM.   
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 Insert the Legacy CD-ROM into your CD-ROM drive. The Setup procedure begins 

automatically.  If it does not start automatically, click the Windows Start button and 
choose Run.  In the Open box type: e:LegacySetup.exe (substitute the drive letter 
for your CD-ROM drive if it is different than e:) and then click OK to start the 
installation program. 

 Follow the prompts, being sure to enter your name and customer ID number when 
asked. 

 
At the conclusion of the installation, Legacy will be located in its own folder in the 
Programs Files on the C drive (or another drive, if you changed the default). You can 

start Legacy from the icon  on the computer desktop, or choose: 
 Start > All Programs > Legacy 9.0 

 

Legacy 8 Users 
If you are upgrading to version 9 from version 8, you are probably doing so 
through our website.  Simple follow the installation steps in the email you were 
sent, or use the New Users > Installing from the Web instructions above.  Or 
you can use the Installing from the CD-ROM instructions above if you don’t 
have Internet access. 

Pre-Legacy 8 Users 
If you are upgrading to version 9 from a version older than version 8, no 
problem.  Just follow the same instructions above. 

Starting Legacy 
We recommend that you watch the Getting Started with Legacy video before 
you start to use Legacy for the first time.  There is a link on our home page.  

When you start version 9 of Legacy for the first time, you will be taken through 
a Startup Wizard.  Part of this process is to set some basic options and to also 
enter your customer number, if you have one, that will unlock all the Deluxe 
Edition features in the program – so be sure you have your customer number 
handy. 
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When Legacy Begins  

The Ribbon Bar 

 
The Ribbon is designed to help you quickly find the commands that you need to complete 
a task. Commands are organized in logical groups, which are collected together under 
tabs. Each tab relates to a type of activity, such as chart appearance or publishing. 
 
Minimizing the Ribbon 

To minimize the Ribbon, click on the minimize button  in the upper right corner of 
the ribbon.  (You can also right-click on any option and then choose Minimize the 
Ribbon).   

 
The Ribbon remains minimized with only the tabs showing.  When you click on a tab, the 
Ribbon temporarily opens and shows the options associated with that tab.  After selecting 
an option, the Ribbon closes back up again, only showing the tab headings.  (Another 
way to quickly minimize the Ribbon is to double-click the caption on any of the tabs.)  

    
Maximizing the Ribbon 

To maximize the Ribbon back to its original size, click the maximize button  
in the upper-right corner of the ribbon.  (You can also click Customize Quick 

Access Toolbar  and then click Minimize the Ribbon in the list (which 
unchecks the option - which restores the ribbon), or, double-click any tab again to 
restore the Ribbon.) 

 

 (For a complete description of how to use the Ribbon bar and what each 
tool does, see the Help index: Ribbon > Overview) 
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Legacy Home 
The  Legacy Home tab on the main screen of Legacy brings you important information 
about your family file and also gives you a global view into the world of genealogy. 
 

 
 
Legacy News 

The Legacy News box brings you articles and announcements about genealogy-
related subjects.  The contents of this box are changed often so be sure to check back 
on a regular basis to see what is new.  Most of the articles and announcments contain 
only a summary of their content but each title is a link to complete information about 
the subject.  (An Internet connection is required.) 
 
If you have an article or announcement that you would like to submit for inclusion in 
the newsletter, click the Submit News link to the right side of the Legacy News box 
header. 
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To-Do Items 
You can select the to-do tasks that you would like to be reminded of.  These 
reminders are displayed on the day you specify in the to-do item itself and remain 
visible until you either reschedule or cancel the reminder.   
 
To edit a to-do item in the list, click anywhere on the task.  To display the full list of 
to-do items, click the To-Do List link to the right side of the To-Do Items box 
header.  
 

Birthdays and Anniversaries 
You will never forget the birthdays or anniversaries of your family members again.  
Just tell Legacy what to be reminded of and it will automatically be displayed in this 
list.  You can even set the number of days in advance of the event to begin displaying 
it.  You can even be reminded of death dates if you wish. 
 
To select an individual or marriage to include in the list, put a checkmark in the 
Birthday Reminder and or Death Date Reminder box on the Individual 
Information screen or the Anniversary Reminder box on the Marriage Information 
screen. 
 
To edit an individual or marriage in the list, click anywhere on the desired entry. 
 

Statistics 
This box shows you how many individuals, families and sources are currently in your 
family file.  You can also click the Statistics title itself which is a link to display the 
General Information screen which displays many more statistics about your family 
file. 
 

Updates 
The current Legacy version is displayed.  If a newer version is available, it is also 
shown along with a Download Now! link that you can use to download the newest 
update. 
 

Support 
The Support box gives you easy access to a variety of technical support options as 
well as training material, bug reporting and a way to submit suggestions to make 
Legacy even better.  Just click on the appropriate link.  (All of the options here 
require you to be connected to the Internet.) 
 

Navigation 
The Legacy Home tab has a built-in browser that lets you view Internet content 
without ever leaving Legacy.  As you click the various links in the boxes, the 
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navigation buttons in the upper-left corner can be used to return to the original 

Legacy Home tab contents , move Back   and Forward , Refresh the 

current page , or Stop the loading of a new page . 
  

Options 
Clicking the Options button in the upper-right corner of the Legacy Home tab 
displays a popup menu with the following options: 
  
Options - Displays the Legacy Home Options screen where you can indicate your 
Internet connection method and specify how many days in advance you want to be 
reminded of To-Do items, birthdays, and anniversaries.  
  
Zoom - Lets you specify the font size to use in the browser window. 
  
Check the Internet Now - Checks the Internet (if you are connected) to refresh the 
News and Updates sections of the Legacy Home tab. 
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Family View 
The Family View window displays information about both a husband and a wife along 
with their marriage information, their children, and their parents. Navigation within this 
window is very easy and logical.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Three generations are shown in this view – the main couple are shown in the middle  
(usually a husband and wife).  The parents of the husband and the parents of the wife are 
shown above them.  The children of the couple are shown below them.  A single click on 
any parent’s or child’s name moves that person to the central Husband/Wife position, thus 
moving the display up or down one generation.  (If you want to use a double-click instead 
of a single click to move people, you can make the change on the Options > Customize 
> General section.) 
 

Click this tab to 
display the 
Family View. 

Three 
generations 
are shown. 

Click in this 
box to move 
the parents 
down to the 
Husb/Wife 
position. 

Click on a child’s 
name to move 
him/her up to the 
Husb/Wife position 
with his/her spouse. Click here to edit the husband.

Click here to enter 
marriage information. 

Click here to edit the wife. Right-click on a 
child’s name to pop 
up an options menu 
concerning the 
children. 
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If pictures have been linked to the husband or wife, small thumbnail views are shown of 
the preferred pictures. Also note the icon buttons for spouses, siblings, notes, pictures, 
etc. shown in the Husband and Wife boxes. These icons take on color if there is data in 
their respective windows.  
 
Children  
The Children’s section shows up to 21 children at a time, depending on your screen 
resolution and the size of the main Legacy window on the screen.  If there are more 
children than can be shown at once, a scroll bar is included on the right to scroll to the 
additional names. 
 
Cell- or Grid-Mode 
The list of children in the Children’s section can be shown as cells or in a grid-style 
format. 
 
Cells: 

 
Grid-Style: 

 
To change from one style to the other, right-click on the name of any child in the list and 
then choose View > Scolling List (grid) from the popup menu.  Choosing this option 
toggles back and forth from cell-mode to grid-mode. 
 
Change the Number of Columns 
When you are in cell-mode you can choose the number of columns in the list – from one 
to three.  Selecting more columns results in more names being shown but less 
information for each name (birth and death information).  There is an additional column 
option of “Best fit” that offers a compromise of benefits.  When there are few enough 
children to all fit in one column, the cells expand to the full width of the window.  If two 
columns are required to display all the names, the cells automatically change to half the 
window width.  Three columns are used if the names won’t fit in two columns. 
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Showing Half Children in the List 
Often, if there are half-children involved in a family, you will want them included in the 
list as they are really part of the current family.  To include half-children, right-click on 
any child’s name and choose View > Show ½ Kids.  Choosing this option toggles the 
inclusion of the half-children in the list on and off. 
 

Problem Indicators 

Legacy taps into its problem checking routines while displaying information on this 
screen.  When problems are found, a Problems icon  is displayed next to the piece of 
information causing the problem.  Hovering over these icons shows you a short 
description of the problem.  Clicking on the icon displays a list of the problems and how 
to fix them.   

 

Pedigree View 
The Pedigree View shows an individual with ancestral lines to the fourth or fifth 
generation.  
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Choose a four- or 
five- generation 

display. 

Clicking on the left 
arrow moves down 

one generation. 

Vital statistics for 
the current 

person. 

Click on any name to 
pop up a list of siblings, 
spouses, and children. 

Clicking on 
right arrow 

moves up one 
generation.
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When you hover the mouse over the name box of anyone in the Pedigree View a list pops 
up showing the Spouses and Children and Siblings.  You can navigate to anyone on the 
list by clicking on the desired name in the list. The selected person becomes the main 
primary person on the left side of the chart. 
 
Double-clicking on a name moves the individual to the primary position at the left of the 
screen. Clicking the left arrow to the left of the primary individual moves the display one 
generation younger (to the preferred child). Clicking on a right arrow next to the oldest 
generation along the right, moves the display back one generation older. 

 

Problem Indicators 

Legacy taps into its problem checking routines while displaying information on this 
screen.  When problems are found, a Problems icon  is displayed next to the piece of 
information causing the problem.  Hovering over these icons shows you a short 
description of the problem.  Clicking on the icon displays a list of the problems and how 
to fix them.   
 

Descendant View (Deluxe Edition) 
The Descendant View displays the current person and all his or her descendants in chart 
form for a given number of generations.  Each name is color-coded to show gender and 
many columns of information can be selected to include in the table. 
 

 

  

Double-click on
any name to

regenerate the
View for that

person.

Click on the
header to select

or rearrange
columns.

Birth and death
information is
shown for the

highlighted
person.
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Navigating the Descendant View 
As each name is highlighted, the birth and death information is shown at the bottom of 
the window along with marriage details.  If there is more than one spouse/partner, an M+ 
button appears that can be used to show a list of all the spouses/partners. 
 
By default, the Descendant View shows up to 10 generations of descendants for the 
starting person shown at the top of the chart. 
 
If you double-click on any person in the list, that person becomes the main person and is 
moved to the top and the chart is regenerated to show the descendants of that person. 
 
If you right-click on any person a menu pops up allowing you to Edit the person's 
individual or marriage information, Add surrounding relatives (siblings, parents, spouses, 
and children), View lists (parents, spouses, and siblings), and add Notes, Pictures, etc. 

 
The following options are available along the right side of the window: 
 

Edit 
Clicking the Edit button along the right side displays the current person's Information 
screen where you can view, edit, and add information. 
 

Print 
Clicking the Print button takes you to the Descendant Tab on the Report Menu where 
you can then print a Descendant Chart for the main person. 
 

Options 
Clicking on the Options button pops up a submenu where you can: 

Customize Display - Select display options for the descendant chart.  

Customize Columns - Choose the columns of information to display with each 
name. 

Zoom - Choose the text size for the descendant chart. 
 

Go To Father 
Jumps up in the descendant list to the father of the highlighted person.  If the highlighted 
person is a spouse and his or her father is not in the current list, the list is regenerated 
with the spouse’s spouse as the starting person.   
 

Go To Mother 
Jumps up in the descendant list to the mother of the highlighted person.  If the 
highlighted person is a spouse and his or her mother is not in the current list, the list is 
regenerated with the highlighted person as the starting person.   
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Customize Descendant Display 

The Customize Descendant Display screen is reached by choosing Customize Display 
from the Options button on the Descendant View. 
 

Generations to display - Sets the number of generations to show in the chart. 

Indent each generation - Spaces to indent each generation from the left column. 

Include RINs - shows the RIN number after each name. 

Include Years Lived - shows the birth and death year range after each name. 

Don’t Repeat Duplicate Lines – suppresses the printing of descendant lines that 
have already been shown previously on the report.  This can happen when a person 
marries someone he or she is related to. 

Max Individuals to Show – limits the report to a maximum number of individuals 
(up to 5000 at a time). 

 
Customize Descendant View Columns 

You can select up to 15 pieces of information to be displayed on the Descendant View 
list.  To add, remove, or rearrange the columns, either click on an existing column 
heading or click the Options button and choose Customize Columns.  

 
Selecting a Column 

To change a column, click the  icon to the right of it.  This pops up the Field Names 
to Display list where you can select the piece of information you want to show.  
Highlight the field you want to include and then click Select. 

 
Rearranging Columns 

You can move a column to anywhere in the list by clicking it to highlight it and then 

clicking the up or down  arrows to reposition it.  You can also use drag and drop to 
move fields around. 
 
Deleting Columns 

To remove a field from the list, highlight it and then click Delete.  The field is removed 
from the list and any lower fields move up to fill the gap. 

 
Saving the Column Layout 

If you find that you are reusing a particular column layout, you can save it to disk for use 
in the future.  Up to ten different setups can be saved.  To save a setup, click Save....  
When the Save Column Layout window appears, select one of the ten save positions by 
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clicking on it.  Next, enter a name (up to 40 characters) in the Name field to describe the 
setup and then click Save. 

 
Loading a Saved Column Layout 

You can retrieve a saved setup by clicking Load....  When the Load Column Layout 
window appears, highlight the entry you want to load and then click Load.  (Or just 
double-click on the entry.)  You can also right click on the column headers and choose 
another of your saved layouts.   
 
Restoring the Defaults 

To reset the column layout to just include name, sex, birth date and place, and death date 
and place, click Default. 
 
When you are done, click Close.  The new column layout is then displayed in the 
Descendant View. 

Chronology View (Deluxe Edition) 
The Chronology View shows the name of the current individual and all the 
surrounding events associated with that person. These events include the person’s 
birth, christening, death, and burial information, his or her individual events, 
marriages and marriage events, the birth of children, parents, and the individual and 
marriage notes. Grandparents and grandchildren can also be optionally included. All 
these events are arranged on the view in date order so you can see what affected this 
person throughout his or her life. 
 
To display the Chronology View, click on the Chronology tab. 
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Options 

Display Options 
Displays the Chronology View Options screen. This screen lets you select and 
deselect the information that is shown on the view, change color highlighting, change 
column widths, and set report options. (See Chronology View Options on page 22 for 
more information.) 

 

Report 
Generates a print preview of the Chronology Report using the options set in the 
Chronology View Options. This report can include a timeline chart and an ages 
column as well as other color and formatting options. (See Chronology Report on 
page 150 for more information.) 
 

Compare Two People 
Takes you to the Chronology Comparison screen where you can compare two 
people’s events to better see if they might actually be the same person. 
 

Help 
Displays the help topic describing the Chronology View. 
 

Navigating 
You can use all the standard navigation features available in Legacy while viewing 
the Chronology. These include Bookmarks and Quick Bookmarks, Individual and 
Marriage tags, the Back and Forward buttons, and the History List. You can also 
change to other individuals by using the Name List and Marriage List, as well as by 
using the Search features and the Go To ID Number feature. 

 

Chronology Display Options 
This options screen (reached by clicking the Options button and then choosing Display 
Options) lets you select and deselect the information that is shown on the view, change 
color highlighting, change column widths, and set report options. The options are 
arranged on six tabs, each of which is described below. All the options on all the tabs 
apply to both the Chronology View and the Chronology Report. 

 

Include Tab 
Individual Events   includes the person’s individual events.  You can then choose 
whether or not to include the notes, private events, event addresses, phone numbers, 
e-mail addresses, or home page URLs. 
 

LDS Information   includes the LDS ordinance information for the current 
person. 
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Marriage Events   includes the marriage events.  You can then choose from the 
options below it, which include the same choices as the Individual Events with the 
addition of whether or not to include children and spouse’s life range information. 
 
Extended Family   You can choose additional generations to include in the 
chronology view. These can include grandparents, parents, children, and 
grandchildren. There is an option to include the information from these generations 
that falls within the lifespan of the main person. 
 
Other Options 
 
Historical Timelines  You can include background timeline events in the 
chronology to give historical perspective to your ancestor's life. Legacy installs 
several general timelines to choose from, or you can create your own. You can select 
one or more timelines and limit your selection to one or more events from each 
timeline. To select one or more timelines, click the Select Background Timelines 
button. For more information see Selecting Timelines. 

 (Help index: Selecting Timelines) 
 
Notes   Select the note types you would like to include on the view or report. 
 
Cause of Death  Include how or why the person died. 
 
Stories  You can include a person’s stories in the list. 
 
Color Coding   You can have certain elements of the report shown or printed in 
color to make them more easily identifiable. These include the color of the names for 
the main person, parent's, grandparent's, children, grandchildren, marriage 
information, spouse names, and historical timeline events. 

 

Formatting Tab 
Other Formatting   options are to print all names in bold, remove quoted given 
names, print event names in bold, remove one or more leading commas on locations, 
remove two or more leading commas from locations, and add an Age column.  
 
Age Column (on screen)   Includes an age column on the screen display. The 
Age column shows how old the main person was when each event happened. 
 
Analysis Formatting   The Chronology View and Chronology Report are very 
useful when trying to see where people traveled during their lifetimes. Legacy offers 
two options that make this information much more noticeable on the report. The first 
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is the reversal of the date column so that the year comes first. This makes it easier to 
glance down the column to see what years the events occurred. The second is to 
reverse the order of the location field and place it at the beginning of the descriptive 
column in optional bold type. You can then quickly see the locations encountered 
during the person’s life. 
 
Birth and Death Information   You have the choice of including the years only, 
or the full dates and locations of the birth and death on individual names within the 
report. 

 

Column Widths Tab 
You can specify how wide the Date and Event columns will be on the screen. 

 

Report Options Tab 
Report options apply to the creation of a Chronology Report. (See Chronology 
Report on page 150 for more information.) 

 
Timeline Column   is a graphical representation of the timespan of each event 
represented on the report. It allows you to easily see how events overlapped and 
shows everything that was happening at any particular time. The bars in the timeline 
are colored according to the settings on the Formatting tab. 
 
Shading the Life Range   extends the life range of the main person down the 
entire timeline behind all other events. This way you can easily see where the events 
occurred within the life of the individual. 
 
Age Column   shows how old the main person was when each event happened.  
The Age column can also be shaded along the right edge to produce a 3D effect. 
 
Print in Black and White   The Chronology Report normally prints in color, but if 
you have only a black-and-white printer you can change the color to only black and 
white. 
 
Lines   This option allows you to print horizontal lines between each event. 
 
Average Life Span   specifies the average lifespan you want to use for child and 
spouse bars when the death dates are not available. 
 
Print Individual’s Picture   includes the picture of the individual.  You can also 
choose to have a drop shadow printed behind each picture by selecting the with 
Shadow option. 
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Print Private Individuals  includes the names of individuals who are marked as 
Private on their Information screens. 
 
Print Invisible Individuals  includes the names of individuals who are marked as 
Invisible on their Information screens. 
 
Report Title   You can change the title of the report as desired. 
 
Privacy Options 

Click this button to change the settings for printing Private and Invisible 
individuals. 
 

Change Fonts 
You can specify the font name, size, and style to be used in each section of the 
chronology report. See Report Fonts for more information. 
 

Page Setup 
You can change the settings for page margins, orientation, paper size, border 
lines, header positions, page numbering, compiler information, and footer 
contents. 

 
Printer Setup 

Lets you change the page size and orientation before generating the report. You 
can also change the target printer and its specific settings. 

 
Print or Preview 

The Print and Preview buttons are used to produce the report and send it directly 
to the Printer or to the Preview screen. 

 
Sources Tab 

Here you can choose to include source citations when printing the Chronology 
report, and specify the formatting and contents of the citations. 

 

Screen Fonts Tab 
You can select between Arial and Times New Roman for the various sections of 
the screen display.  Note, these two fonts work well on the screen.  You can 
choose other fonts when printing the report. 
 

 (Help index: Chronology: View Options) 
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Index View 
The Index View displays all the individuals in your family file. The information 
displayed by default includes the record identification number (RIN), full name, 
gender, and the birth and death date and place.  
 
 
 
 
 
         

 

 

 

 

 

 

 

 

 

 

 

 

 

Sorting the List 
The Index View can be displayed in surname, given name, or RIN order. Click the 
Surname, Given or RIN button at the top of the window, or click in the Surname, 
Given or RIN box. The list is then redisplayed in that order. 
 

Finding an Individual 
If the list is long, you can search for an individual in the list by RIN, given name or 
surname. To search by surname, click in the Surname box and type the name you 
want to find. Enter the surname first, followed by a comma and then the given 
name(s). To search by given name, click in the Given box and type the given names, 
followed by a comma and then the surname if known. To search by RIN, click in the 
RIN field and type the number you want to locate.  
 

Click RIN to sort 
the list in record 

number order. 

Enter a RIN 
here to jump 
to that record 
in the list. 

Click Given to sort 
the list in order of 
given name(s). 

Click Surname to 
sort the list in 
surname order. 

You can drag 
these column 

guides to 
change the 

column widths. 

Click 
Options for 
a menu of 
things you 
can do to 
the format 
of the Index 
View. 

Right-clicking 
a name 

displays a 
menu of 
options 

where you 
can edit, add 
relatives, etc. 
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Changing the Columns 
  To customize the columns: 

1. Click on any of the column headings. This displays the Customize Index View 
Columns screen. 

2. Add or change the pieces of information you want to display in each column. 

 (Help index: Customize Index View columns) 
3. Click Close. 

 
  To change the width of the columns: 

You can change the width of each column by dragging the right header boundary to 
the desired width. Legacy then remembers these widths. 

 

Options 
Clicking the Options button displays a shortcut menu: 
 

Include Alternate Names  inserts the alternate names for each individual into the 
name list. Alternate names are displayed with a leading tilde character (~). 

Include Married Names   adds the name of the wife (or husband) was known as 
while she (or he) was married. 

Change Sort/Search to User ID   changes the RIN search field to User ID. When 
you use this field to search, the closest matching User ID number is located in the 
list. (If you are using the User ID number for searching you should include the User 
ID as one of the columns in the Index View.) 

Customize Columns   displays the Customize Index View Columns screen where 
you can select the columns you want to include. 

Zoom   lets you select the font size for the Index View list. 
 
Edit 

You can edit any individual in the list by right-clicking his or her name and choosing 
Edit from the shortcut menu.  (You can also double-click the name.) The Information 
screen for that person is displayed. 
 

  





Chapter 2 

Using the Help System 
Looking for Assistance When You Need It 

 
 
Getting Help 

The Help System 
Legacy includes an extensive context-sensitive help system to provide you with 
easily accessible information about program features and techniques. The help 
system contains all the information in the Legacy User Guide and more, optimized 
for use while using Legacy itself. In addition, the help system is updated when 
features are added or modified in subsequent releases. 
 
Context-Sensitive Help 
To open the Help system, choose Help Index from the Help tab on the Ribbon. The 
Contents screen opens where you can select the type of help you need. 
 
You can also get immediate help about any window or dialog box in Legacy by 
clicking Help on that window.   

Scattered throughout this User Guide are help index hints:   
When you see one, you can find additional information about the current subject by 
searching for the indicated search keywords in the help system. 
 
Help Videos 
Many windows also offer short helpful videos that explain the operation and options 
on the current window.  Help buttons that include videos have a film reel graphic on 
them.    When you click these buttons, a popup menu appears with the 
options to Show Help Topic, which displays the regular context-sensitive help 
screen, or Show Help Video, which when you hover over it, shows a submenu with 
the available videos.  Clicking on a video name launches your browser and plays the 
video. 
 
Getting Help on the Legacy Homepage 
You can get a lot of help by going to our Legacy home page, 
(http://www.legacyfamilytree.com/), by clicking on the Help Center dropdown 
menu.  This gives you the following choices: 
 

Troubleshooting Help 
Submit Support Ticket 
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Make a Suggestion 
How to import files from other programs 
Learn to Use Legacy 
Tips 
Frequently Asked Questions 
User Groups 
Legacy Users’ Email List 
Affiliates 
Sitemap 
Contact Us 
 

Going through these options can answer many of the questions you might have while 
using Legacy. 
 
Learn to Use Legacy 
This option tells you how to get step-by-step instructions on using Legacy as well as 
many tutorials, videos, tips and tricks, and other helpful resources. 
 
Legacy Users Group 
There are many user groups that have been set up around the world.  These are listed 
when you click the User Groups option and gives the contact information for each 
one.  This gives you the opportunity to ask questions to other Legacy users who are 
usually more than willing to help you out.  You can also subscribe to the main 
Legacy User Group email list.  This results in all the questions and answers from all 
participants to be emailed to you each day. 
 
Legacy KnowledgeBase 
Legacy has many, many tips and how-to articles that can help you get the most from 
the program.  Click on the Tips option for a complete list. 
 
Frequently Asked Questions 
Click this option to see the list of frequently asked questions that we have received 
over the years.  These articles may be just what you are looking for. 
 
Legacy Facebook Support Group 
Got a question, want to share a favorite tip, or just want to get ideas from others? Join 
our Legacy User Group on Facebook for a thriving community of other Legacy users. 
Here we also post announcements and keep you "in the know" with what's happening 
with Legacy and our webinars. Join at 
https://www.facebook.com/groups/LegacyUserGroup for free.  
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Family File Information 
Choosing File Properties 
from the Help tab brings 
up the Family File 
Information window: 

 

This window shows the 
licensed user name and 
registration number, 
program version, build date 
(date of the program or last 
update), along with the 
location of your family file. 
In addition, the window 
displays the number of 
individuals and families in 
the current file, plus many other statistics about your file. 
 

Printing a Report 
You can print a report showing the information from this window by clicking the Report 
button at the bottom.  

 (Help index: Report: Information) 
 

Order Form 
Selecting this function from the Help tab of the Ribbon takes you to the Legacy online 
store in the Legacy Products section.  From here you can order several different 
variations of Legacy (downloaded or shipped). 
  

Other Support Features 
Tech Support – Opens the Legacy Technical Support web page in your Internet 
browser.  This contains a lot of information about solving problems you may run into in 
the program. 
Report a Bug – Opens the Problem Report Form webpage so that you can tell us about 
a problem you might be having while using Legacy. 
Request Feature – Opens the Make a Suggestion webpage so you can request a new 
feature that you would like to see in an upcoming version or update of Legacy. 
Legacy Homepage – Opens your browser window and displays the Legacy home 
page. 
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Download Update – Opens the Download Legacy Update webpage where you can 
download the latest update of the program. 
Beginners Video – Opens your web browser and displays the page where you can 
watch the Legacy for Beginners training video. 

  
About Legacy 

Choosing About Legacy from the Help tab of the Ribbon option displays the splash 
screen giving the Legacy copyright. Clicking Company displays a screen showing the 
different ways you can contact Millennia. Clicking General displays the Family File 
Information screen. 
 

 
 

Unlocking the Deluxe Edition 
If you have been using the Standard Edition of Legacy and then decide to order the 
Deluxe Edition, you will have to enter your new customer number (received when you 
purchased the Deluxe Edition) to unlock the Deluxe features.  This is done by choosing 
Unlock Legacy Deluxe from any of the tabs of the Ribbon bar and then entering your 
name and customer number. 



Chapter 3 

Entering Your Data 
Recording All the Facts and Events for an Individual 

 
Legacy has many easy-to-access forms to allow you to enter the information you have found on 
your family. 
 

Individual’s Information Window 
The Individual’s Information window is reached by right-clicking on a person’s name on 
the Family, Pedigree, Descendant, or Index View and then choosing Edit. Clicking on 
the Husband or Wife name on the Family View also opens the Information screen for that 
person.  This is where you enter all the individual information for the current person. This 
includes his or her name; birth and death dates and locations; gender; reference numbers; 
and extra event data. The name and location fields use type-o-matic (auto completion) 
fields.  
 

 
 
Legacy 'remembers' data entered into certain fields.  When you start to enter data into 
these fields Legacy will automatically, as soon as it 'recognizes' the data, fill in the 
remainder of the characters.  This may or may not be precisely what you want, so check 
carefully before saving your entry.  (For example, if you have entered "St. Paul, Ramsey, 
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Minnesota" in a location field and intend to enter "St. Paul, Alberta, Canada" in another 
field, make sure you type enough of the field to get what you want.)  
 
The Information screen also contains an Events section where you can enter separate 
items related to that individual’s life.  

 

Also from this window, you can access the Notes section, the Media Gallery, the To-Do 
List, and the Address screen, as well as the Calendar and Date Calculator and the 
Alternate Names screen. These icons take on color if there is data in their respective 
windows.  
 
Given Names 

Enter all the given names for the individual. This includes the first name and all 
middle names, including initials. Don’t include nicknames or alternate names, which 
should be entered in the Alternate Names window (see below). The Given name field 
can hold up to 120 characters. Note, you can include a quoted name in the Given 
Name to be used when creating narrative sentences on reports.  For example, William 
“Bill” Smith.  Reports have the option to use the quoted name – “Bill was born on 25 
Dec 1888…”  There is also an option to remove the quoted names. 

 

Surname 
Enter the surname for the individual. When you leave the field, Legacy applies the 
formatting specified in the Customize section (see page 212) and capitalizes the first 
letter or the entire word, depending on the format selected (unless you have used a 
capital letter in the surname.  Once you use a capital letter, Legacy switches to 
“Don’t change what I enter” mode.). Do not include things like Jr., Sr., II, III, etc., 
which should be put in the title fields. The Surname field can hold up to 120 
characters. 

 

Alternate Names 
You will often encounter given names and surnames that are spelled differently. 
Many times, the spellings differ within the same source. You can record all these 

variations as alternate names by choosing the AKA  icon to the right of the 
Surname field. (See Entering Alternate Names on page 47 for more information.) The 
Alternate given and surname fields can hold up to 120 characters. 

 
Title 

Prefix and suffix titles include Jr., Sr., Rev., Major, General, King of England, etc. 
These fields can hold up to 50 characters. 
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Living Indicator 
Use this field to show if the person is alive or dead.  This setting can then be used 
when creating reports and web pages, or exporting files, to protect the privacy of 
living individuals by not including their personal information. 

  
Gender 

Choose either Male or Female. If you don’t know the gender of the individual, click 
? (which means unknown).  If you are entering a spouse to an existing person, the 
gender is automatically selected as the opposite gender but can be changed in order to 
enter same-sex relationships. 

 

Dates 
Enter the date for each event, such as birth, death, burial, etc., that you know. You 
can enter the dates in any format desired and Legacy changes them to the date format 
set in the Customize section (see page 212). (See Enter > Dates in date fields in 
Legacy Help for more information.) Dates can be up to 45 characters long. 

 

Possible Duplicates 
As you add new people, Legacy checks to see if there is a possibility that the person 
is already in your family file.  This is done by comparing the name, birth, and death 
information with others in the file.  If a match is found, Legacy pops up a Possible 
Duplicate screen for your verification. 
 
The individual you just entered is displayed on the left side of the screen with 
whatever vital information you just entered, and the possible duplicate (or the first of 
several possible duplicates) is displayed on the right side. After comparing the two 
people's information, if you decide that they are the same person, click the Yes, or 
I'm not sure button. This will display a Merge window where you can combine the 
information from the two individuals into the existing person's record (or finally 
decide that the two are not the same). If the person on the right is not the same person 
as the one you just entered, click the No button. 
 
If Legacy finds more than one person who might be a possible duplicate, you can see 
how many there are to look at up in the upper-right portion of the window. For 
example, if six possible duplicates were found, you will see . You 
can use the left and right pointers to move to the previous or next person in the group 
to see if the person you just entered matches one of them. 

 
The rules for looking for possible duplicates can be set and changed by clicking the 
Options button in the lower-left corner  
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Calendar 
Whenever you are filling in a date field, you can use the pop-up calendar for help by 

clicking the Calendar  icon. Selecting a date from the calendar automatically fills 
in the date field. 

 

Locations 
Locations for events should be entered in a consistent format. Use the format of city, 
county, state or province, country. When entering place names in your own country, 
you may think that it is sufficient to just include the state abbreviation and leave off 
the country; however, for completeness, you should always include the country. You 
never know who might be using your family file in the future and in what country 
they might be living. The Location fields can hold up to 255 characters. You should 
use all the intermediate commas to show where information is missing and to clarify 
what each piece means. Bergen, New Jersey could mean Bergen County or the city 
of Bergen. Bergen, , New Jersey, USA makes it all perfectly clear that Bergen is the 
city and that the county name is missing. 

 

Locations can also be selected from a list of previously entered locations. Using the 

down arrow  to the right of the location fields opens the Master Location List from 
which you can find and select existing locations.  You can also quickly open the 
location edit screen to modify a location entry by right-clicking the down arrow.   
 
The Deluxe Edition of Legacy also includes a Geo Location Database containing 
millions of place names from around the world.  You can access the Geo feature by 

clicking the Geo  button to the right of any location field.   
 

Locations Memorized (Deluxe Edition Only) 
As you enter places into location fields in Legacy, the most recent ten place names 
are remembered and can be quickly displayed in a popup list and selected.  To 
display the list of the last ten place names, right-click on the field label to the left of 
any location field.  From the resulting popup list of place names you can select one to 
fill into the location field by clicking on it.  To clear the location list and start over, 
click (Clear all memorized locations) at the bottom of the list. 
 
Additional Information for Birth, Christening, Death and Burial 

fields. 
At the right end of the Birth, Christening, Death and Burial fields there is a button 

 that lets you add notes, addresses, pictures that are specific to these fields and 
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Share this event.  Click on the  for the Born field, for example, pops up a shortcut 
menu with the options: Birth Address, Birth Notes, Birth Pictures.  Clicking on the 
desire option opens the appropriate window for adding the information.  By clicking 

on the  button beside the Burial field, you can change the burial event to a 
cremated event.  Making this change changes the term used on reports for this 
individual.  It also changes the term on the Family View. 

 

US County Verifier  (Deluxe Edition Only) 
When you exit a location field, Legacy checks the validity of county names for 
locations in the United States (if the Verify US Counties in Place Names option is 
turned on in the Customize section).   An error is reported if: 
 

 No county by that name was ever found in that state.  (This could also be the 
result of a misspelling.) 

 The county was not in existence in this state at the date specified. 
 The County had been dissolved in this state before the date specified. 

 
When an error is reported, you can choose to view a list of all the counties in that 
state to see when they were founded and their periods of existence. 
 
You can turn off US County Verification while viewing any error message.  (To 
turn it back on, reset the option on the Data Entry tab of the Customize section– 
Option 2.1.) 

 

User ID Number 
The User ID field is for any reference number you want to record for this individual. 
You can use any combination of letters, numbers, and punctuation marks. 

 

Ancestral File Number 
The AFN field is for the identifying number assigned by the Church of Jesus Christ 
of Latter-day Saints when the individual has been submitted to the Ancestral File. 
Each person is assigned a unique number. The Ancestral File Number can be up to 20 
characters. 
 

FamilySearch Number 
This field is for the identifying number assigned by the LDS church when the 
individual has been added to the FamilySearch Tree. Each person is assigned a 
unique number. You can fill in the FamilySearch number yourself but it is usually 
filled in automatically when you use the Legacy FamilySearch integration module to 
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connect to the FamilySearch Tree and confirm a match. It can also be filled in when 
you import a GEDCOM file that contains these numbers. 
 

Find A Grave ID 
FindAGrave.com is a free commercial site where thousands of individuals around the 
world have submitted millions of pictures of headstones along with the information 
on them.  It is a great source of information.  Legacy includes the ability to search for 
Find a Grave memorials and link to them by the memorial number.  If you click on 
the Find A Grave label, Legacy will launch a search for the current person’s name.  
If a memorial is found, you can copy and paste any information you need into 
Legacy.  You might also want to copy the picture of the headstone, if there is one, 
and link it to the burial information or picture gallery for the person.  (If there is 
already a Find A Grave memorial number in the field, clicking the label will take 
you directly to the memorial.) Note, if you want to use a headstone photo in any 
publication, you should seek permission from the photographer who holds the 
copyright. 
 

BillionGraves ID 
BillionGraves is a free website to look up headstone photos from around the world.  
Volunteers use Smartphones to take GPS tagged photos of headstones. Photos are 
uploaded to the BillionGraves website. Photos are transcribed by volunteers. Photos 
can be easily accessed for research online. (this description is from the 
BillionGraves.com website.) 
  

Birthday Reminder 
If you would like to be reminded of the birthdate of this individual a few days before 
it happens, put a checkmark in the Birthday Reminder option in the lower-right 
corner of the window.  The reminder will be displayed on the Legacy Home tab.   

  
Death Date Reminder 

If you would like to be reminded of the death date anniversary of this individual a 
few days before it happens, put a checkmark in the Death Date Reminder option in 
the lower-right corner of the window.  The reminder will be displayed on the Legacy 
Home tab.   
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Using the Source Clipboard 
The Source Clipboard is a feature in Legacy that can tremendously increase 
the efficiency with which you document the sources of the information you 
enter into your family file. (See Source Clipboard on page 88 for information 
on how and why to use this feature.) 

 

Person Never Married 
If you know that the current person was never married during his or her lifetime, you 
can select the This Individual Never Married and had no children checkbox.  The 
Marriage bar on the Family View will then say "** Never Married**."  This box 
can only be checked if there is no spouse or child linked to him/her and no marriage 
information has been entered. 

  
Standardization Checking 

Many standardization checks have been added that pop-up if something questionable 
has been entered in the Individual's Information screen. These have also been added 
to the Potential Problems report. See the Standardization tab of the Potential 
Problems Report for a list of the problems Legacy checks.  
 

Monitor Potential Problems 
Legacy taps into its problem checking routines while displaying information on this 
screen.  When problems are found, a Problems icon  is displayed next to the piece 
of information causing the problem.  Hovering over these icons shows you a short 
description of the problem.  Clicking on the icon displays a list of the problems and 
how to fix them.   

 
Excluding this Person from Specific Potential Problems (Deluxe 
Edition Only) 

You can exclude a person from specific, verified problems and leave the remaining 
information available for future problems checks.  To do this, click the Exclude from 
Potential Problems button and select the particular problems you would like to turn 
off.  If any of the conditions are selected for an individual, an asterisk is shown at the 
beginning of the button caption. 

  
Privacy Settings for Individuals 

If you would like to be able to either suppress information or exclude this person 
from being included on reports, exports, and web pages, click the Privacy Settings 
button in the lower-right corner.  All reports, exports, and web pages have an option 
to include or exclude Private and Invisible individuals.  Information for Private 
individuals is not exported to GEDCOM files by default, however there is a 
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checkbox to include it if desired.  Invisible individuals are excluded from reports and 
exports but there is also an override option if you want to include them.   

 

Events 
You can attach any number of events to any individual’s record. Events in Legacy are 
facts about the individual’s life; an occupation, graduation, enlistment, residence and so 
on are all considered events. Legacy comes with a set of predefined events you can use, 
and provides the ability to add new event definitions (or modify the predefined ones). 
 
Events can be shared among multiple people. A minister who baptized a person might 
share the Baptism event for that person. All the individuals in a household might share 
the same Census event. Different roles can be assigned to the various people who share 
an event. In the Event list, events that have been shared from another person are 
displayed with a leading . See Shared Events for more information.  
 
An event record consists of an event name, a description of the event, the date and place 
of the event, and a comment. Only the event’s name is required, but the entry would 
probably seem meaningless without further data.  The Deluxe Edition of Legacy 
automatically creates sentences based on the data, formatted according to the event’s 
definition, for any reports you create.  
 
 Adding a New Event 
  To add a new event to an individual: 

1. Click Add to the 
right of the Events 
box to display the 
Add Event window.  

2. To select an event 
from the Master 
Event Definition 
List, either type the 
name of the event in 
the Event field, or 

click the  button 
to the right of the 
Event field to scroll 
through the list and 
select an event by 
clicking on it. (If 
you want to define a 
new event that is not 



 Entering Your Data 

Legacy User Guide 41 

 

already in the Master Event Definition List, see Editing The Master Event 
Definition List on page 43.)  

3. In the Description field, enter the event description. 
4. In the Date field, enter the date the event occurred.  
5. In the Place field, enter the location where the event took place. 
6. In the Notes tab, enter any information you want to record concerning this event. 
7. If you are using the Deluxe Edition of Legacy, you will see the event sentence 

being built as you enter your information. You can edit the Event Sentence 
Definition to fit the way you normally enter data for this Event type or you can 
override the sentence definition for this particular event by entering a new 
sentence on the Sentence Override tab. 

8. Click the Source  icon to record the source of this information if you have it. 
(See Citing Your Sources on page 71 for more information.) 

9. Click the Picture  icon to add pictures, sounds, video clips, and other files to 
the event. 

10. Click the Address  icon to record an address associated with this event. 

 (Help index: Add or edit an event) 
 

Shared Events 
A shared event has an owner and one or more witnesses. The term witness might also be 
described as participants - in other words, someone who had some connection to the 
event. Witnesses have roles in the event. The event is first entered for the owner - the 
person who is the primary participant in the event. For a Baptism event for example, the 
owner would be the person who was baptized. For a Census event, usually the owner 
would be the head of household. If your ancestor happened to be the first cousin of the 
head of household and she was temporarily living with the family during the time in 
which the census was taken, you would probably want to list her as the owner of the 
event. If you are creating a marriage event, there are two owners, the husband and the 
wife. 
 
To Create a New Shared Event 

1. Create the event for the owner. (See Adding an Event above for detailed 
instructions.) 

2. Before clicking the Save button to save the event, click the Share Event button. 
The People Who Share This Event window is displayed. (If you have already 
saved an event, then highlight the event you want to share in the Events/Facts 
window and then click the Share button. 
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3. From the People Who Share This Event window click the Add Person button 
and then choose Add a name from the name list from the submenu. The Name 
List appears. 

4. Highlight the person you want to share the event with and click Select. The 
Share Event With Another Person window is displayed. 

5. Enter the Role that this person played in the event.  
6. Enter any notes or comments you want to make. 
7. Repeat the process of adding additional persons by clicking the Add Person 

button again. 
 
Sharing an Existing Event 
You can also add witnesses or participants to events you have already added to 
individuals . From a person's Information screen, highlight the event you want to share in 
the Events/Facts window and then click the Share button. The People Who Share This 
Event window is displayed with the current person shown as the only person in the list so 
far. Now you can follow the same steps described above (from step 3). 
 

Editing an Event 
  To change the name, description, date, location, notes, etc. of an existing 

event: 
1. Highlight the event line you want to edit in the Event Box. 
2. Click Edit to the right of the list to display the Edit Event window. 
3. Make the desired changes and click OK to save them. 

 (Help index: Event, Add > Add or Edit an Event) 
 

Changing the Order of the Events 
  To change the display order of the events: 

1. Highlight the event line you want to move. 

2. Click the Up or Down arrow  at the lower-right corner of the Events box 
(labeled “Set Order”) in the direction you want to move the line. 

 
Event Clipboard 

There is a built-in clipboard in Legacy that lets you copy an event and then paste it to 
someone else. 
  To copy an Event to the clipboard: 

1. Click the  button. 
 

  To past an Event from the clipboard to an event list: 
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1. Open the Add Event window for the person or marriage you want to add the 
event to. 

2. Click the  button. 
 
Other Columns on the Event List 
There are four other columns at the right edge of the Events/Facts list: 
 

 Shows if the event had been shared by other people.  Hovering over the icon 
shows how many others share the event. 

  Shows that there is one or more source citation attached to the event. 
  Shows if any media has been linked to the event. 
  Shows if there are any potential problems associated with the event. 

 
Other Options in the Events Box 

Press the Options button to: 
 
Swap certain events with vital events.   You can swap alternate birth (Alt. 
Birth) information with the main Birth information, Alt. Christening information 
with the main Christening information, Alt. Death information with the main Death 
information, and Alt. Burial information with the main Buried information.  Be sure 
to highlight the desired Alt. event before selecting this option. 

Sort Events by Name   lets you automatically sort your list of events by the event 
name. When sorting, any events that do not have a name are moved to the top of the 
list. 

Sort Events by Date   lets you automatically sort your list of events by date. 

Delete Event   lets you delete the highlighted event in the Information window. 

Zoom   lets you vary the font size of the Events List. 

 
Editing the Master Event Definition List 

  To display the Master Event Definition List: 

Click the Down arrow  to the right of the Event field. 
 

Adding or Editing an Event Definition 
Use the Add/Edit Event Definition screen to add a new event definition or to edit an 
existing definition that you want to include on an individual or marriage record. 
 
Click the Add or Edit button on the Master Event Definition List screen to reach the 

Add/Edit Event Definition screen. (Click the down arrow  at the right side of any 
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event name field to reach the Master Event Definition List screen, or choose Master 
Lists > Event Definition from the View tab of the Ribbon bar.) 
 

 
 
Defining an event includes giving it a name, indicating which information fields you 
want to go with it, and defining how to create a sentence from the event information 
when printing a report. Legacy comes with many predefined events that all include 
sentence definitions.  If you would like to see an example, highlight one on the 
Master Event Definition List screen and click the Edit button. 

 
  To define a new event definition: 

1. Enter the name of the event. This name will appear on the Master Event 
Definition List and on the event screens and reports. 

2. Indicate the additional fields you want to include with the event. Choose 
from a Description field, a Date field and a Place field. Most events will 
include all three fields. The Description field, for example, might hold the 
name of the occupation for an Occupation or Employment event or the name 
of a school for an Education event. The Date field records the date or date 
range of the event. The Place field records where the event happened. 

3. Fill in the event sentence formula (if you are using the Deluxe Edition of 
Legacy).   

4. Click Save. 

 (Help index: Event, Add > Add or Edit an Event) 
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Defining the Event Sentences (Deluxe Edition only) 
The sentence definition is used when generating reports and indicates how the pieces 
fit together. The definition can include one or more conditional fields to show where 
each piece of information fits. Fields are entered into the sentences between opening 
and closing square brackets, such as [Desc], [Date], and [Place]. When the sentence 
is put together for a report, the fields are replaced with the actual contents of those 
fields from each event. For example, let’s say you are defining a School event. The 
sentence might look like this: He went to school at [Desc] in [Place] in [Date]. When 
the report is generated, the sentence might become: He went to school at Harvard 
College in Cambridge, MA in 1979. 

 
Because a sentence will be put together differently depending on the pieces of 
information available at the time, you can use the fields conditionally – meaning that 
the field is used in a certain way only if it contains information. For example, placing 
a [field] in angled brackets make it conditional.  < [Date]> means that if there is date 
information, it is placed in the sentence with a leading space (there is a space 
between the open < and the [Date] field).  Here is a typical sentence: 

[HeSheFirst] was cremated< [Desc]>< [Date]>< [PlaceDetails]>< [Place]>. 
Notice that [Desc], [Date], [PlaceDetails], and [Place] are all placed in conditional 
angled brackets and are therefore only included in the sentence if they contain 
information.  There is also a condition you can use to vary the wording if the event is 
being used for a marriage instead of an individual, and a condition to use if the 
individuals are still alive as opposed to dead. 

 
For a description of all the [fields] available and how the sentence formula is 
constructed, see the help topic below. 

 (Help index: Event, Add > Add or Edit an Event) 
 

Other Master Event Definition Options 
Clicking Options on the Master Event Definition List brings up a shortcut menu 
where you can choose the following: 

 
Delete   removes the name of the highlighted event if the event is not being used in 
any individual’s or marriage event list. If the event is currently being referenced, a 
message displays and the event is not removed. You must remove all references to a 
particular event before it can be removed from the Master Event Definition List. 

Tag and Untag   all master events or just the currently highlighted names. 

Combine Duplicates   combines any event names that are identical in every way. 

Purge Unused…   removes any event names that are not being used in the family 
file. 
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Import Lists   allows you to import various lists from other family files. These 
include Locations, Surnames, Event Definitions, Temples, Marriage Status, Source 
Types, Child Status, Picture Locations, and other Master Source Lists. 

Print   lets you print a report of all the event names on the list. 

Page Setup   lets you change page margins, print orientation, line spacing, paper 
size, border lines, heading and page numbering options, and footer options.. 

Zoom   allows you to vary the font size of the Master Event Definition List. 

Remove Name-Only Events  If you have events that only have an event name 
and no other information, you may want to remove them from your family file. 

Warning: This could incorrectly remove events attached to individuals or 
marriages where an event name is the only known information, for example, you 
might have an “Immigration” event.  You know the person immigrated but you 
don’t know when or where. 

Jump with Edit Sorting   The Master Event Definition List is sorted by Event 
Name.  If you edit an event name, changing it so that it will now sort to a different 
location in the list, you can choose to jump to the new location in the list when you 
Save the change, or you can choose to remain where you were after the edited event 
is moved to its new sort position. 

Set Bookmark   lets you “mark your place” in the list so that you can jump back to 
it at any time in the future using the Go To Bookmark option. 

Go To Bookmark   allows you to jump back to a previously placed bookmark. 
 

Combining Event Names 
You can easily combine two event names.  You may wish to do this if you find, for 
example, you’ve misspelled an event name.  
 
  To combine event names: 

1. Highlight the event name you want to change. 
2. Click Combine the Highlighted Event Name with Another one in the List 

at the bottom of the window. 
3. Highlight the event name you want to change it to. 
4. Click the same button again, which now reads, Highlight the Destination, 

then Click this Button. 
 
DNA Marker Test Information 

There are many companies that offer DNA Analysis so that you can explore your 
ancestry, lineage, and geographic origins.  These tests result in marker values that can 
be recorded in Legacy.  Many of these companies offer comparison searches to find 
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other individuals that have also been tested and found to be related to you.  Clicking 

the DNA  button opens the DNA Records screen where you can enter the 
test results of one or more tests. 

 

 (Help index: DNA Records) 
 

The Information Toolbar 
At the top of the Individual Information screen is the toolbar: 
 

 

Hints  
Legacy can sift through billions of records from key websites –  FindMyPast, 
FamilySearch, GenealogyBank, and MyHeritage – for new information, pictures, and 
stories about your ancestors. As you add to your tree, Legacy continues to search – 
automatically!  This is all done in the background while you are using Legacy.  When 
any hints are found for a person, a Hints icon shows up next to their name showing you 
that something has been found.  If you hover your mouse over the icon, a quick summary 
of the number of hints and where they were found is shown in a popup tooltip. 
 

 Entering Alternate Names  
Many times you will find that a person’s name is represented in more than one way. 
Either the spelling of the name will differ in various sources or the name will be 
completely different. Sometimes names were changed when a person immigrated to a 
new country. Sometimes names were recorded wrong because of misunderstandings or 
bad transcription. Many people go by different names as they grow up, going from 
nickname to nickname. All of these names should be recorded because you never know 
when a variation will be used in a new source. 
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  To display the Alternate Name List: 

Click  to the right of the Surname field.  
 
Adding New Alternate Names 

 To add a new name to the Alternate Names List: 
Click Add. An input window appears where you can type in the new name.  

 (Help index: Alternate names) 
 

Editing an Existing Alternate Name 
  To edit an existing alternate name: 

Highlight the name and click Edit. An input window, filled with the current 
spelling, appears where you can make the desired changes. 

 

Deleting an Alternate Name 
 To delete an existing alternate name from the list: 

Highlight the name and click Delete. 
 

Sources for Alternate Names 
 To add a source: 

Click the Sources icon  to add a citation to the highlighted name. 

 (Help index: Citing your sources) 
 
Swapping an Alternate Name With the Main Name 

  To replace the primary name with one of the alternate names: 
Highlight the name and click Swap Name with Main Name on Record. 

 
 

 Adding an Address  
You can enter a mailing name, address, up to two phone numbers, an e-mail address, and 
a home page address for each individual in your family file. 
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  To add an address: 

1. Click the Address  icon. If you are entering an address for the first time, 
Legacy builds a standard name and puts it in the name field. You can leave it as 
is or change it as desired. 

2. Fill in the Sort String field if you want to print labels in a different sorted order 
than what is in the Name field.  For example, you might want to enter Surname, 
Given Name so that labels will print in surname order. 

3. Continue filling in the address, phone number(s), e-mail address, and home page 
address. 

4. Click the  button at the right of E-mail and Home Pg fields to send a message 
or connect to the Internet without leaving Legacy. 

5. You can include the latitude and longitude for the location. 
6. You can associate the person with various mailing lists. The choices are 

Newsletter, Family Association, Birthday, Research, Christmas, and Holiday. 
7. Click the Tag box in the bottom right corner to select or deselect this address for 

future reporting purposes. 
8. Click the Private box to select or deselect whether or not you want this address 

printed on reports or exported to other files. 
9. Click the Notes tab to enter additional comments about this address. 
 

 (Help index: New address) 
 

Save   saves the address and closes the window. 

Cancel   closes the window without saving any entries or changes. 

Address List   opens the Master Mailing Address List. 

Unlink   removes the link to the address in the Master Address List (after asking for 
confirmation) and closes the Address window. 

Repeat   duplicates the entry made in the same field of the last address you entered 
during the current session. If the current field already contains an entry that would be 
overwritten by the Repeat option, Legacy asks for permission before replacing it. 
You can also use F8 to repeat a field. Clicking the line labels also repeats the entries. 
Clicking the “Address” label repeats both address lines. Clicking any other repeats 
just that line (including the “Name” field label). To repeat the entire address, right-
click the Repeat button. 

Help   opens Legacy Help. 

Picture   opens the Media Gallery where pictures, sounds, video, and documents can 
be attached. 
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 Notes 
You can add or edit the General, Research, and Medical notes belonging to the individual 

by clicking the Note  icon or by clicking the F5 function key.  

 (Help index: Notes) 
 

 Adding Sources 

To document where the individual’s information came from, click the Sources  icon. 
(See Citing Your Sources on page 71 for more information.) 
 

Adding Pictures, Sound, Video, Documents, and Web Links  
You can attach pictures, sounds, video, and web links to an individual by clicking the 

Media icon.   (See Adding Pictures on page 243 or Adding and Recording Sounds on 
page 282 for more information.) 

 (Help index: Media gallery) 
 

 Calendar and Date Calculator 

To access the Calendar just click the Calendar  icon. 

 

Dates From the Calendar 
You can use the built-in pop-up calendar to help you with the Marriage Date field. 

Just click the Calendar  icon.  

 (Help index: Calendar) 

Date Calculator  
The date calculator figures the time span between two dates, or calculates the 
beginning or ending date if you know one or the other along with an age.  

 (Help index: Date calculator) 
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 Adding To-Do Items 

If you would like to add a to-do item for this individual, click the  icon.  This 
displays the To-Do List where you can add new item or edit existing items.  (See page 
119 for more information.) 
 

 Hashtags (Deluxe Edition Only) 

These are useful to create groups of people with a common attribute.  For example, you 
could add a hashtag of "Civil War" to all your ancestors who fought in that war.  Or you 
could add "Farmer" to all who worked on farms for a living.  You can add an unlimited 
number of hashtags to people and you can use them while creating search lists, exporting, 
reporting, and more. 
 
  To add a hashtag: 

1. Click the Hashtag icon  
on the toolbar.  This opens the 
Hashtags window which 
shows the master list of all the 
hashtags. 

    
The hashtags assigned to the 
current person have a 
checkmark next to them.  
(You can filter the list to just 
show the hashtags with the 
checkmarks by unchecking 
the Show all Hashtags 
checkbox below the list on the 
right.)   

2. You can assign any other existing hashtag to the current person by clicking on the 
checkbox to the left of any hashtag in the list (if you have them all showing).  

3. If you want to add a new hashtag, 
click the Add button on the right.  
This opens the Add a Hashtag 
window: 

  
  



Entering Your Data 

52 Legacy User Guide 

 

 
4. A hashtag consists of the hashtag name and an optional description.  Enter these and 

then click Save.  The new hashtag will then be displayed in the Hashtags list with a 
checkmark to the left of it. 

5. When you are finished adding hashtags, click Save to return to the Information 
screen. 

 

Stories  (Deluxe Edition Only) 

Preserve the stories of your ancestors or stories of your own. The Stories tool lets you 
record, organize, and print stories for any of your ancestors.  You can add as many stories 
as you want to for each person and you can add multimedia and sources for each one.  
You can also share stories with other individuals in your family file.  These might include 
other people who are mentioned in the story. 
 
  To add a story: 

1. Click the Story icon 

 on the toolbar.  
This opens the Story List 
window: 

 
 
 
 
 
 
 
 

2. To add the first story (or 
to add an additional 
story) click the Add 
Story button.  This opens 
the Story window. 
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3. Enter a title for the story, the date or date range that the story covered, and the 
location for the story setting if applicable. 

4. Now you can enter the story itself.  The story can be up to one million characters 
long…   

5. If you want to link in some pictures or other documents, click the Add Media 
button. 

6. Sources can be entered by clicking the Sources button . 
 

Sharing Stories 
Since stories often include other people, Legacy lets you link multiple individuals to 
them so you don’t have to enter the story again for each person. 

 
  To share a story: 

1. From the Story List screen, click the Share Story button.  This displays the 
People Who Share This Story window: 
 

 
 

2. Now click the Add one or more people… button.  This opens the Name List 
where you can select a person (or persons) to share the story with.  After 
choose the desire individuals, click the Select button.  The additional people 
you chose will now be displayed in the list. 
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You can set a Private flag for each person who shares in a story.  This is 
helpful when you want to only print a story once on a report for the main 
person and not repeat it on others who share it.  To set this option, highlight 
the desired person in the list and then select the Private checkbox under the 
list. 
 

To remove a person from the list, highlight his or her name and then click 
Remove person.  After confirmation, the person is removed from the list. 

 

LDS Ordinance Information  

 
From the Individual's Information window, you can display the LDS Ordinance 

Information window by clicking the Temple  icon, provided you have Display LDS 
Information selected on the Options > Customize > General tab. This dialog box lets 
you record the date and the temple name for baptism, confirmation, initiatory, 
endowment, sealing to parents, and sealing to spouse.  (A summary of the LDS 
information is shown in a single line just below the Events/Facts box.) 

 (Help index: LDS ordinance information) 
 

Source Clipboard 
 The Source Clipboard is a feature in Legacy that can tremendously increase the 
efficiency with which you document the sources of the information you enter into 
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your family file. (See Source Clipboard on page 88 for information on how and why 
to use this feature.) 

 (Help index: Source clipboard) 
 

Repeating Fields (Ditto) 
Legacy has a Repeat feature, commonly known as Ditto. This feature lets you quickly 
enter recurring information. In all the input fields on the Information screen, except the 
User Reference Number and Ancestral File Number, you can click Repeat at the 
bottom of the screen to repeat the same information from the same field from the last 
record saved. If the current field already has an entry that would be overwritten, Legacy 
asks permission before replacing it. F8 or Alt-R work the same way, as does clicking the 
label to the left of each field, such as “born” or “died” or “in.”  
 

Memorizing Locations and Dates (Deluxe Edition) 
Legacy maintains a list of the ten most recent entries you've made in its various date and 
location fields.  
  
Memorizing Locations 
To display the list of entries, right-click on the location field's label (just to the left of the 
field).  Left-click on an entry in the list to place that data in the field.  If you want to clear 
the memorized list, click (Clear all memorized locations) at the bottom of the list. 
 
You can also "copy and paste" four separate locations to speed your data entry.  In any 
location field press Ctrl-F9 and Legacy will memorize the data in that field.  In another 
location field press F9 and Legacy places the memorized data in the field.  You can have 
up to four locations memorized this way; Ctrl -F9, Ctrl-F10, Ctrl -F11, and Ctrl -F12 
will each remember a separate bit of data.  Use F9, F10, F11, or F12 to enter the 
memorized data.  These are very useful when entering records where everything 
happened in the same place.  
 
Memorizing Dates 
Legacy maintains a list of the ten most recent entries 
you've made in its various date fields.  To display the 
list of entries, right-click on the date field's label (just 
to the left of the field).  Left-click on an entry in the 
list to place that data in the field.  If you want to clear 
the memorized list, click (Clear all memorized 
dates) at the bottom of the list. 
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Saving the Record 
When you have filled in the Information screen with all the available information, click 
Save to record the entries to disk and return to the previous screen.  (If you don’t want to 
save the information, click Cancel. 
 

The Marriage Information Screen 
The Marriage Information screen is where you record the date, place, status, and sources 
of information for the current marriage (or partnership).  The Marriage Information 
screen is reached by clicking the Marriage Bar just below the Husb and Wife boxes on 
the Family View.  It can also be reached by choosing Edit Marriage from the Edit tab of 
the Ribbon bar or Edit Marriage from the right-click menu of the husband or wife.  
 

General Tab 
 
Marriage Date 

Enter the marriage 
date if you know it.  

 
Marriage Place 

If you know where 
the marriage took 
place, enter the 
location in the field 
to the right of “in.”  

 
Marriage Status 

This field is where 
you record the final 
result of the 
marriage. The default is blank and should be left blank if the couple was actually 
married and never separated before one or the other died. The other standard choices 
for the Status field are: Annulled, Common Law, Divorced, Married, Other, 
Separated, and Unmarried. If you choose Other, you should also add an explanation  
in the Notes field of the marriage. You can also add additional status words to the 
list.   
 
If you have recorded an ending Status and there is a date associated with it, enter the 
date in the Status Date field. 

 



 Entering Your Data 

Legacy User Guide 57 

 

Did Not Marry 
If the couple did not get married, put a checkmark in the This couple did not marry 
box.  When this box is checked, Legacy uses different wording to describe the  
relationship in reports and web pages.  The wording for narrative paragraphs is 
shown on the Wording Options tab.  You can override this wording if you want to.  
See Wording Options below. 

 
Had No Children 

If you wish to indicate that this couple had no children, click the This Couple Had 
No Children checkbox. Legacy will display “** Had No Children **” in the Child 
List on the Family View for this couple.  (If you have already entered children for this 
couple, this option is disabled and not available.) 

 
Monitor Potential Problems 

Legacy taps into its problem checking routines while displaying information on this 
screen.  When problems are found, a Problems icon  is displayed next to the piece 
of information causing the problem.  Hovering over these icons shows you a short 
description of the problem.  Clicking on the icon displays a list of the problems and 
how to fix them.   

 

The Marriage Information Toolbar 
The following buttons are found on the toolbar: 

 
Notes 

To add explanations or comments about the marriage, click the Notes  icon.  

 (Help index: Notes) 
 

Pictures 

To add a picture to the marriage, click the Media Gallery  icon. (See Adding 
Pictures on page 243 for more information.) 

 

Sources of Information 

To document where the marriage information came from, click the Sources  icon. 
(See Citing Your Sources on page 71 for more information.) 

 (Help index: Source citations) 
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Address  

To enter the address of the marriage place, click the Address  icon.  

 (Help index: Address > Add) 
 

Dates From the Calendar 
You can use the built-in pop-up calendar to help you with the Marriage Date field. 

Just click the Calendar  icon.  

 (Help index: Calendar) 
 
LDS Information 

If you are recording LDS ordinance information, click the Temple  icon to 
display the LDS Ordinance Information screen where you can fill in the Sealed to 
Spouse date and Temple name, if known.  

 (Help index: LDS ordinance information) 
  

 Source Clipboard 
 The Source Clipboard is a feature in Legacy that can tremendously 
increase the efficiency with which you document the sources of the 
information you enter into your family file. (See Source Clipboard on 
page 88 for information on how and why to use this feature.) 

 (Help index: Source clipboard) 
 
Events 

You can attach any number of events to any marriage record. Marriage events in 
Legacy are facts about the couple’s life.  Legacy comes with a set of predefined 
events you can use, and provides the ability to add new event definitions (or modify 
the predefined ones). 

 
An event record consists of an event name, a description of the event, the date and 
place of the event, and a comment. Only the event’s name is required, but the entry 
would probably seem meaningless without further data.  The Deluxe Edition of 
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Legacy automatically creates sentences based on the data, formatted according to the 
event’s definition, for any reports you create. 

 
Adding a New Event 

To add a new event to a marriage: 
 
1. Click Add to the right of the Events box to display the Add A New Event window.   
2. To select an event from the Master Event Definition List, either type the name of 

the event in the Event field or click the DOWN ARROW to the right of the field to 
scroll through the list and select an event by clicking on it.  (If you want to define 
a new event that is not already in the Master Event Definition List, see Editing 
The Master Event Definition List below.) 

3. In the Date field, enter the date the event occurred. 
4. In the Place field, enter the location where the event took place. 
5. In the Comments field, enter any information you want to record concerning this 

event. 
6. Click the Source icon to record the source of this information if you have it.   

 
Shared Events 
A shared event has an owner and one or more witnesses. The term witness might also be 
described as participants - in other words, someone who had some connection to the 
event. Witnesses have roles in the event. The event is first entered for the owner - the 
person who is the primary participant in the event. For a Baptism event for example, the 
owner would be the person who was baptized. For a Census event, usually the owner 
would be the head of household. If your ancestor happened to be the first cousin of the 
head of household and she was temporarily living with the family during the time in 
which the census was taken, you would probably want to list her as the owner of the 
event. If you are creating a marriage event, there are two owners, the husband and the 
wife. 
 
To Create a New Shared Event 

1. Create the event for the owner. (See Adding an Event above for detailed 
instructions.) 

2. Before clicking the Save button to save the event, click the Share Event button. 
The People Who Share This Event window is displayed. (If you have already 
saved an event, then highlight the event you want to share in the Events/Facts 
window and then click the Share button. 

3. From the People Who Share This Event window click the Add Person button 
and then choose Add a name from the name list from the submenu. The Name 
List appears. 

4. Highlight the person you want to share the event with and click Select. The 
Share Event With Another Person window is displayed. 
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5. Enter the Role that this person played in the event.  
6. Enter any notes or comments you want to make. 
7. Repeat the process of adding additional persons by clicking the Add Person 

button again. 
 
Sharing an Existing Event 
You can also add witnesses or participants to events you have already added to a 
marriage . From a couple’s Marriage screen, highlight the event you want to share in the 
Events/Facts window and then click the Share button. The People Who Share This Event 
window is displayed with the current person shown as the only person in the list so far. 
Now you can follow the same steps described above (from step 3). 
 

Editing an Event 
To change the name, date, location or comments of an existing event: 

 
1. Highlight the event line you want to edit in the event list. 
2. Click Edit to the right of the list to display the Edit An Event window. 
3. Make the desired changes and click OK to save them. 

 
Editing the Master Event Definition List 

If you would like to add or edit an event name definition in the Master Event 

Definition List or remove an existing event from the list, click the  icon to the 
right of the Event field on the Add Event window to display the Master Event 
Definition List. 

 
To add a new event to the list: 

  
1. Click Add to the right of the event list.  The Add/Edit Event Definition 

window is displayed. 
2. Enter the name and sentence definition of the new event and click Save. 
3. Click Close to return to the Edit An Event window. 

 
To remove an event from the list: 

 
1. Highlight the name of the event you want to erase. 
2. Click Options and choose Delete from the shortcut menu.  If the event is not 

being used in any individual's event list, the event is removed from the list.  If the 
event is currently being referenced, a message displays and the event is not 
removed.  You must remove all references to a particular event before it can be 
removed from the Master Event Definition List. 
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To remove the reference of an event from the current marriage: 
 

1. On the Information window, highlight the name of the event you want to delete. 
2. Click Delete to the right of the event box. 

 
Sorting the Event List 
You can have Legacy automatically sort your list of events by the event name or date 
by clicking Sort to the right of the event list.  When sorting, any events that don't 
have a name or date are moved to the top of the list. 

 
To change the display order of the events: 

 
1. Highlight the event line you want to move. 
2. Click on the UP or DOWN arrow in the lower right corner of the Facts and Events 

box (labeled "Set Order") in the direction you want to move the line. 

 
Combining Event Names 

If you find that you have two event names that you want to combine, (for example, if 
you misspell a name), this can easily be done:   

 
1. Highlight the event name you want to change. 
2. Click Map Highlighted Event Name to Another Event Name in List at the 

bottom of the window. 
3. Highlight the Event name you want to change it to. 
4. Click the same button again, which will now read, Highlight Destination Event 

Name, Then Press This Button. 

 
Privacy Settings for Marriages 

All reports, data exports and web pages created by Legacy have an option to exclude 
Private marriages, effectively hiding this information from public view.  Click on the 
Private checkbox at the bottom of the screen to mark this as a Private marriage.   

 
Married Names 

When a couple is married, in most cases one or both of the individuals involved 
change their names.  This is usually the wife but in some cases the husband's name 
will change.  If you have a marriage name rule selected in the combo box at the 
bottom of the Married Names box, Legacy automatically makes the married name 
changes and displays them in the Husband's married name and Wife's married 
name fields.  If you have selected None - don't generate married names, the fields 
remain blank. 
  



Entering Your Data 

62 Legacy User Guide 

 

You can change the married name for either the husband or the wife by clicking the 
Change button to the right of the married name field. 
  
Married names can be included in the Name List and on the Index View.  They are 
also used when searching and when generating anniversary calendars. 
  
When you select a different married name rule from the combo box, Legacy asks, Do 
you want this change to be the default for all future marriages that you add?.  If 
you answer Yes, then any marriage you add from then on will generate married 
names according to that rule - until you change it again.  If you answer No, then the 
rule is only applied to the current marriage 
  
You can also set the default married name rule on the Options > Customize > Data 
Entry tab. 

  
Anniversary Reminder 

If you would like to be reminded of the anniversary of this couple a few days before 
it happens, put a checkmark in the Anniversary Reminder option in the lower-
middle of the window.  The reminder will be displayed on the Legacy Home tab.   

 
Tags 

You can tag individuals and marriages to mark them for various reasons.  (To use the 
tagging feature in Legacy you must have the tagging option turned on.  This is done 
on the General tab of the Options > Customize screen.) 
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Wording Options Tab 

 
Family View Labels 

Choose the labels you would like to use when displaying this marriage couple.  The 
default labels are Husband and Wife. 

 
Default Report Phrases for a First Marriage 

The traditional (and Legacy’s default) wording on reports and web pages is 
"married".  John married Sarah..., or Sarah married John....  If you have set the 
‘did not marry’ option for this couple, Legacy changes the default wording to "had 
a relationship with".  John had a relationship with Sarah...   
 
You can change the defaults to anything you like  on the Options > Customize > 
View > Default Family View Labels and Report Wording box.)  That option 
affects every report and web page you create. 
 
If you want to change the wording for this couple only, type a new word or phrase 
into the box.  For example, entering “moved in with” in the box yields the phrase 
“John moved in with Sarah.”  Keep in mind that this is just the beginning of the 
sentence Legacy builds:  date and place information (if available) gets added as well.  
So, in this example, the full sentence might become John moved in with Sarah on 
12 Dec 1888 in London, England... 
 
Also note that this wording applies to both partners.  That is, in our example, Legacy 
will generate both "John moved in with Sarah" and "Sarah moved in with John".  
So, if you changed the phrase to, say, "married his college sweetheart" the sentence 
will become "John married his college sweetheart Sarah" -- but it will also 
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become "Sarah married her college sweetheart John".  See the next section, on 
Overrides, for a way around this. 

 
Overriding the Report Phrases 

If you would like to completely change the narrative wording that Legacy normally 
uses to construct a sentence for a report, you can change it to anything you want to.  
Whereas the default wording above automatically inserts the first name of each of the 
spouses/partners, these new override phrases does not.  You must include the names 
in the phrase.  This gives you the option to modify the names and to change the order 
of the parts.  Johnny took Sarah as his wife ...  or Johnny and Sarah got married 
... or John married his high school sweetheart Sarah ....  Again, this is the 
beginning portion of a sentence that will have the date and location added to it, so 
keep this in mind.   

 
You must construct two versions of the sentence, one describing the husband's first 
marriage (or partnership) and the other describing the wife's first marriage. 

 
Default Report Phrases if this isn’t the First Marriage 

Similar to the wording for a first marriage, the default phrase used for a second or 
later marriage is "next married" or "next had a relationship with".  John next 
married Sarah..., or Sarah next had a relationship with John....  If you want to 
change the phrase for this subsequent marriage/partnership only, you can type a new 
phrase into the box. 

 
Overriding the Report Phrases 

Just as with the first marriage, you can enter your own wording for later marriages.  
Later in his life Johnny got remarried to Ruth ...  or Several years after her 
divorce, Sarah met a man named Alfred and they were married ....  Again, this is 
the beginning portion of a sentence that will have the date and location added to it, so 
don't put a period at the end. 

 
Again, as with the first marriage, you must construct two versions of the sentence. 

 
Other word substitutes 

You can also change the terms Spouse and Marriage to other words that will be used 
in various reporting situations. 

 
Adding Children 

Each marriage can have up to 60 children. The children are displayed in the Children 
list in one, two, or three columns. (You can change the setting by right-clicking on a 
child's name, moving down to View and then choosing 1, 2, 3 columns or Best Fit. 
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Children are generally added from the Family View although they can also be added 
from the Pedigree, Descendant, and Index Views by right-clicking on a name and 
choosing the Add option. 
 
To add a child from the Family View: 
 
Click on any cell in the Children section near the bottom of the screen.  If there are 
no empty cells (meaning all the cells are filled), there will be a plus sign  in the 
upper-right corner of the section that can be clicked to add a new child.  Using either 
method displays a popup menu: 
 

 
 

Choose Add a New Son or Add a New Daughter.  This opens the Information 
screen where you can enter the data. 

 

Editing the Child-Parent Links 
As you enter children for a mother and father, they are automatically sorted into 
chronological order as long as there is a birth date available (unless you have turned 
off the auto-sorting option.  Oftentimes, a child with no birth date is entered and you 
will want to place the child in a specific order within the other children.   
 
You can also assign a Status to a child, such as Twin or Stillborn. 
 
Usually the relationship between a child and his or her parents is “Biological.”  
Sometimes, however, there may be a different relationship such as “Adopted,” 
“Foster,” or “Sealed.”  There might be a different relationship between the child and 
the mother and the child and the father.  Perhaps the father adopted the child after 
marrying the mother. 
 
The above situations can all be added and edited from the Edit Children screen.  
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To reach the Edit Children list, right-click on a child's name from either the Family 
or Pedigree View and then choose Children's Settings or click the  icon in the 
upper-right corner of the Children section of the Family View. 
 
Changing the Sequence of Children 

The initial sequence of the children in the child list is set by the order in which 
they were entered. If you want to change this order, highlight the child whose 
name you want to move and then use the up and down Order arrows in the lower 
right corner to move the name within the list. 

Setting a Child to "Preferred" 
The "preferred" child is generally the child in your direct line and is indicated by 
an asterisk in the left column of the grid. Knowing who the preferred child is 
makes it much easier to move down your line from one descendant to the next. 
You can change the preferred child by highlighting the desired name and clicking 
Set to Preferred Child in the lower left corner of the window. The asterisk in the 
left column of the grid then moves to the new child's name. Note, the preferred 
child for a whole branch of a family can be set by using Tools > Set Direct Line. 

What are Those Characters? 
An asterisk (*) in the left-hand "P" column indicates that the individual is the 
Preferred child.  There is also an option to show the preferred child’s name in 
bold print. 
A plus sign (+) in the left-hand "P" column indicates that the individual is set as a 
Direct Line person. 
An asterisk (*) before a date in the Birth Date column indicates that the date was 
taken from the christening (baptism) field because there was no date in the Birth 
field. 

Sorting the List 
If you would like to sort the list in ascending order by the birth dates of the 
children, click Sort. 

Child Status 
You can tag each child with a special status if you like. These include Twin and 
Stillborn. The default setting when a child is first added to the list is None. To 
set a new status, highlight the child and then click the Down Arrow on the Child 
Status drop-down list at the bottom center. Select the new status by clicking on it. 
You are not limited to the statuses in the list. To add a new status, just enter it 
into the field. 
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Relationship to Father and Mother 
You can specify the relation of each child to the father and the mother. These 
relationships can be things like Adopted, Foster, or Sealed. They can even be 
things like Unproven or Disproven. The relationships can be specified 
differently for the father and mother. Perhaps the father is the biological parent 
and the mother is an adoptive parent. The default setting is Biological which is 
shown as a blank. To set a new parent relationship, highlight the child and then 
click the down arrow on the Relationship to Father or Relationship to Mother 
field. The Master Child-Parent Relationship List appears. Select the relationship 
by clicking on it. You are not limited to the relationships in the list. To add a new 
relationship, just enter it into the appropriate field box. 

 
Private and Invisible Relationships 

You can mark the Relationship to Father or the Relationship to Mother as 
Private or Invisible by putting a checkmark in the Private or Invisible option to 
the right of the appropriate relationship status. A Private setting causes the 
relation to not be mentioned on reports or web pages. An Invisible setting treats 
the relationship as non-existent on reports and web pages. It is as if the child and 
parent are not linked together. For example, you might have a Biological 
relationship between a child and a father that you don't want to publicize or even 
acknowledge. 

Adding Sources 
You can add source documentation to the Child Status, Relationship to Father, 

and Relationship to Mother fields.  To do this, click the Sources icon .  If the 
icon is colored it means that at least some of the information has been 
documented. 

Editing a Child's Information 
You can edit the individual information for any child in the list by highlighting 
the name and clicking Edit. The Information screen appears where you can make 
changes. 

Adding a Brother or Sister to the List 
You can add an additional brother or sister to the Child List by clicking either 
Add Brother or Add Sister. The Add window appears where you can choose to 
Add a NEW Person or Link to an EXISTING Person. 

Unlinking a Child 
To unlink a child from the list, highlight the name and click Unlink.  

Deleting a Child 
To delete a child from the list, highlight the name and click Delete.  





Chapter 4 

Using the Hint System 
Constantly Looking for New Information in the Background 

 
 
Legacy Hints (Deluxe Edition) 

How Does the Hinting System Work? 
Legacy has a powerful background Internet search engine that searches through billions 
of records from several key websites including MyHeritage, FindMyPast, 
FamilySearch, and GenealogyBank, looking for new information, pictures, newspaper 
articles, family trees, stories, and other information about your ancestors.  When things 

are found (we call them Hints), a small Hints icon  is displayed next to the name for 
which they apply.  The icon displays how many hints have been found.  (If more than 9 
hints are found, the icon will show 9+.) This is all done in the background while you are 
using Legacy.  If you hover your mouse over the icon, a quick summary of the number of 
hints and where they were found is shown in a popup tooltip. 
 
Note: When using the FamilySearch service, hint will only be returned for individuals in 
your family file who have been linked to someone in the FamilySearch Tree – or if you 
have found the FamilySearch ID number and have entered it into the FamilySearch ID 
field on the Individual Information screen for an individual. 

 
Setting up the Hint System 
  To Turn on Hints: 

1. From the Options tab on the Ribbon Bar, choose the Customize button. 
2. On the Customize Legacy screen, click 8. View in the menu on the left. 
3. Scroll down in the View Settings section on the right to section 8.13 Perform 

Background Legacy Hints. 
4. Click on the Select Background Hints button.  This displays the Legacy Hints 

screen where you can choose the particular hint services you want to use. 
5. To turn on a service, select the checkbox to the left of its name. 
6. Some of the services have options you can set for how they return results.  (You 

can click the Help button for detailed information about these options.) 
7. When you have selected the desired hint services, click Save. 
8. Back on the Customize Legacy screen, select the Show Hint result icons in 

Legacy checkbox. 
 
That’s all there is to it.  When you click Save to exit the Customize Legacy screen, hints 
will start to be collected in the background and displayed on the screen as you navigate 
around your family file.  Only the names showing on the Family or Pedigree Views are 
submitted for hints. As you navigate around your file on these two views, all the newly 
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displayed names are added to the hint search list and hint icons will start showing up for 
them too.  Hint icons only show up for people for which hints have been found. 
 
How to Use the Hints 
After you have started Legacy Hints, hint icons will start showing up next to the names 
on the Family and Pedigree Views.  They can also optionally be shown on the 
Descendant and Index Views, and the Name List.  This, of course, requires that you 
have an active Internet connection in order to collect the hints. (Remember, you must 
be using Windows 7 or higher.)  When a Hint icon appears, you can hover your mouse 
cursor over it to see what kind of hints were found and how many.  If you click on the 
icon, the Hint Results screen appears showing what has been found. 
 

 
 
Each of the hint services in the list displays how many hints were found and when the last 
search was done.  By default, particular hints are only refreshed every 120 days. 
 
To view the hints found for a service, click on the desired box in the list.  This opens a 
window in your browser, navigates to the services website, and displays a list of the hints.  
You can then use their webpage to display each individual hint and the information it 
contains. 

 

 (For more information on this topic, look in the Legacy Help index for: Hint, 
Results) 



Chapter 5 

Sources 
Creating Perfect Source Citations 

 
 

Citing Your Sources 
When you do family history research, you should keep track of each piece of information 
you collect and also where you found it. Your records should be detailed enough so that 
any other person in the future could find the same information. 
 
As you add individuals and families to the family file, you can either document the 
sources of the information as you go, or you can return later and add the documentation. 
Of course, by putting things off, you tend to forget about them, so it is strongly suggested 
that you resist the urge to save time and go ahead with documenting your sources as you 
initially enter the names. 
 
A particular source of information may be cited hundreds of times within a family file. 
You might find a book or census that contains scores of family members. The location of 
each piece of information for each individual should be recorded. Rather than record the 
entire source description dozens (or hundreds) of times, taking up huge amounts of 
storage space, it is much more efficient to enter a general source description once, point 
to it in a master list, and record just the unique information for each piece’s place within 
that source.  
 

Assigned Sources 
Window 

Displaying the 
Assigned Sources 
screen can be done by 
clicking the Source 

 icon on either the 
Individual or 
Marriage Information 
window, or with one 
of the Source buttons 
on the Family View or 
Pedigree View screen. 
Note: If you click 
from the Marriage 
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Information screen you only see the sources related to the marriage, not the entire 
Assigned Sources screen.   
 
The Assigned Sources window contains three columns: Events, Source List Name, and 
Detail.  
 
Events   Event names in the left column are taken from the data headings on the 
individual or marriage information sheets. As sources are added, they are assigned to a 
particular event name. Multiple sources can be assigned to the same event title.  

Source List Name   When a source is assigned to a specific event, the field then shows 
the name of the source or sources that have been assigned. There is also a category 
named Unspecified. This is a catch-all category where data can be assigned when 
specific sources are not available. 

Detail   Data in the Detail field shows the information entered in the Source Detail 
window shown below. 

 (For much more information on this topic, look in the Legacy Help index for: 
assigning sources to your information) 

 

SourceWriterTM Template System 
Version 7 of Legacy heralded the introduction of SourceWriter.  SourceWriter is a 
template driven sourcing system that makes it easy for you to select the correct input 
screen so that you enter all the pieces needed to correctly cite any source of information 
in the thousands of formats that exist for them.  The information you enter is correctly 
and precisely formatted to match the genealogy industry standards for source citations. 

 
Prior to version 7, Legacy’s citation methods were rather basic and required more 
understanding of sourcing to produce correct citations.  Actually, starting in version 7, 
you can use either of the citation methods, the new or the old.  We will call the new 
system SourceWriter and the previous system the “Basic System.”  If you always want to 
use the old system, go to Options > Customize > Sources and select the Basic Source 
System.  To use the new SourceWriter system, make sure the option is set to 
SourceWriter System. 

 

Adding a New Source Using SourceWriter 
There are several ways to reach the Add a New Master Source screen: 

 From the Assigned Sources List from an Individual, Marriage, or To-Do screen, click 
the Sources icon and then select Add a New Source. 

 From View > Master Lists > Source, click the Add button. 
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Choosing a Source Template 

The first step is to select the proper source template that matches the source you are 
documenting.  A source template is made up of all the potential pieces of information that you 
should record about the source.  These include both the fields for the master source and the 
fields for the details of the citation.  Some sources require only a few bits of information and 
others require many.   
 
There are two different ways to find the source template that you want to use.  The first is by 
entering keywords to display the Source Template Index showing you all the templates that 
match your query.  From there, you select the template that matches the source you are 
entering.  The second method is to select the template by first selecting the general type of 
source and then choosing subcategories that refine the choice down further and further until 
you have the desired template that matches the source.  These two methods are described in 
detail below. 
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Selecting by Keyword(s) 
 
  What kind of source do you want to cite?: 

 
Begin by entering one or more keywords into the field and then click the Search button.  This 
then displays the Source Template Index showing you all the templates that match your 
keywords.  For example, if you entered book authored, the Source Template Index would 
show you a list of about 100 templates.  These would be grouped into four sections; Audio 
book, Book, CD, and DVD.  It would be fairly straightforward to then select the actual book 
type that you are dealing with.  If you knew that you were citing a source from a basic printed 
book, you could have entered the keywords, book authored basic, the resulting index list 
would have only contained 12 templates.  As you use the Source Index more and more, you 
will get better and better at selecting the desired keywords that will make the template 
selection go more quickly.  
 
Note:  The SourceWriter templates are a complete implementation of Elizabeth Shown Mills’ 
Evidence Explained book.  If you have the book and want to use one of the templates, you 
can enter the template number into the Keyword field to instantly select it. 
 
Filtering the Source Index List – There is an option at the bottom of the Source Template 
Index called, Filter the list when searching.  Selecting this option cause the list to only show 
the templates that match all of your keywords.  With the option unchecked, the list will 
include the entire index with the first template that matches your keywords highlighted.  You 
can then use F3 to jump from matching template to matching template down through the list.  
(Shift-F3 jumps backwards up the list.) 
 
Changing the Keywords 
You can add or remove keywords from the search field at the top and then click the Search 
button to create a new list of matches. 
 
Choosing the Template from the List 
When you find the correct template, click on it to highlight it and 
then click the Go button.  (Or you can simply double-click the 
template line.)  You are then taken to the screen where you 
actually enter your source information into the template fields.  
See Filling in the Source Template below for more information. 
 
Selecting a Template by Type 
Selecting a template by type is a multi-step process.  Begin by 
selecting the desired type from the list box on the left.  When you 
have clicked on the type you want to select, you may be prompted 
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for subcategory types to narrow the choice for the final template you should use.  Some types 
require up to four subcategories, others don’t require any.  For example, it you selected the 
Books type of source, the next prompt would be: 
   

1) Was the book authored or edited? 

 
 

Click on the down arrow  to display the possible choices:  

 1) Was the book authored or edited? 
 
 

 
 
 

 
 
 
Choose the appropriate subcategory.  For example, Book, authored.  The next prompt would 
be: 

 2) Select the type of author: 
 
 
 
 
 
 
 
 
Selecting Author known would then bring up the final prompt: 

 3) Select the medium: 
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As soon as you have answered the last prompt in the series, the  button is 
enabled so that you can click it to continue on to the actual source template.  See Filling in 
the Source Template below for more information. 
 

Bookmarks 
After you have cited many sources in your family file you may find that you are using one or 
more of the same templates on a regular basis.  For example, many people cite a basic format 
authored book many times.  A certain type of cemetery record or federal census found online 
may also be a popular choice.  When you find a particular template that you are using over 
and over again, you can save a bookmark for it so that you can easily and quickly select it 
again in the future.  
 
To save a bookmark, first make all your type and subcategory selections until the 

 is enabled.  But before you click it, click on the Create a bookmark for 
the selected source link at the bottom of the screen.  Legacy saves the template in the 
Bookmark List: 
 

 
Create a bookmark for the selected source 
Delete Bookmark 
 
To select and use one of your bookmarks, click on the desired bookmark to highlight it and  
 

then click the  button to the right of the Bookmark List to continue on to 
the actual source template.  See Filling in the Source Template below for more information. 
 
To delete a bookmark, highlight it and then click the Delete Bookmark link. 
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Filling in the Source Template 
The second step to adding a new source using SourceWriter is to fill in the actual fields of the 
template for the master source.  Here is a typical master source template for an online census 
record: 
 

 
 
The name of the source template that you have selected is shown in the header.  In this 
example it is:  Census records > United States > Federal census records > 1820 
population schedule > Online images.  It is a long name but it precisely identifies the 
template type and subcategories.  Many names are shorter, some are longer. 
 
Below the header is the actual template.  The first tab, Source Info, contains the fields that 
you will be filling in.  The other three tabs, Text, Repository, and Multimedia are included 
so that you can add additional information about the source as well as pictures and other items 
of interest. 
 
To the right of the input section is the Output Preview.  As you enter the information about 
the source, it is instantly processed and displayed in three different formats so that you can 
see how it will look when included on a report, book, or webpage.  The Footnote/Endnote 
Citation output is used for the first occurrence of a footnote (at the bottom of each page 
where a source is cited) or endnote (at the end of each generation, chapter, or book) on a 
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report.  The Subsequent Citation is used in the same places as the footnotes and endnotes 
but uses a condensed format that doesn’t require as much room.  The Bibliography is printed 
at the end of a report and is a summary of all the master sources cited in the report and is 
shown in alphabetical order. 
 
 
The Parts of the Source Info Tab 
 
Field Examples – Most input fields have some kind of instruction or example in grey 
lettering centered in the field.  This text gives you a sense of what the field is for.  When you 
click in a field (or tab to it), the example text disappears so that you can enter your 
information.  Note:  The example text is also shown as a tool tip when the mouse pointer is 
held over the field label so that you can remember what the example was when you are filling 
in the field. 

 
Default Entries – Some fields have default entries.  In most cases, this is what should 
remain in the field.  You can replace it if needed. 
 
Locked Fields – Some fields have default text and are locked so that you cannot change the 
contents.  They are actually part of the source citation output and are only shown so that you 
will know what part of the citation they are. 
 
Scrolling – If there are more than ten input field, a scrollbar is shown allowing you to 
manually scroll up and down in the field list.  When you are entering information and tabbing 
down the list, it scrolls automatically for you. 
 
 
Filling in the Source Template Fields 
 
Master Source List Name – Enter a name for the master source record.  This name will be 
used in the Master Source List whenever it is displayed.  It is not part of the source citation 
output. The source name is generally an abbreviation of the source title.  For example, if you 
are working from a book called "Gilbert Radcliff Johnson of Wilderberry County, South 
Dakota and all Known Descendants Through 1945", you might want to name the source 
something like "G.R. Johnson Descendants." You might also want to begin the source 
name with the type of source, place, or surname.  (Examples of each of these can be seen in 
the Sample family file included in the Legacy installation.) 
 
Template Fields – Tab from field to field and fill in the information you have about the 
source.  Locked fields with default text are skipped while tabbing.  When the cursor enters a 
field, the example text disappears.  (Again, you can see the example text as a tool tip when 
the cursor is held over the field label so that you can remember what the example was when 
you are filling in the field.) 
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Text Tab – Here you can record actual source text and comments about the source.  The text 
box can be a word-for-word copy of any description contained in the source.  Don't enter 
opinions about the source by you or the compiler.  This should only include "what the original 
record keeper said" as opposed to any interpretations.  The Comments box is used to record 
notes for each master source you enter.  This is a good way to document how you found a 
particular source and other interesting and important information about it. 

 
Embedding Formatting Codes into the Notes – You can add formatting codes to 
your source text and comments so that portions print in bold, italics, underline and 
superscript.  These codes are used when printing reports, producing word processing files 
and Web pages. 

  
Repository Tab – Record the name and address of the place where this source is stored.  It 
may be a cemetery, library, or archive.  It can even be the address of another person who has 
a copy of the document. 

  
Media Tab – Used to attach graphic files and other files to the source.  These may be 
scanned images such as birth certificates, obituaries, sound files, etc. 

  
Override Tab – You can override any of the automatically formatted Bibliography output 
that SourceWriter produces.  You can pre-fill the Bibliography override section by clicking 

on the  button to its right.  You can change the output to anything you want.  To actually 
override the default output, you must also checkmark the option just below the Bibliography 
section.  Note: Overriding of the Citation and Subsequent Citation output can be done from 
the Source Detail screen. 

  
Other Options 
Below the tabbed sections of the template are two more fields and three options: 
 
Recorded Date   
This is the date you recorded the source citation. 

  
File ID #   
You can assign your own filing number if desired.   
  

File ID Assistant – To help you figure out the next available file ID number, click the 

Assistant button .  (See File ID Number Assistant on page 277 for more 
information.)  
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Verified – This checkbox is used when you have verified the source information.  For 
example, if you receive information from another person, either through a GEDCOM import 
or by email or other means, you should verify that the source citations are true and accurate.  
As you check each citation, you can mark Verified to indicate your confirmation of the 
source information.  Note:  How you use the Verified field is up to you.  You can also use the 
Surety Level and Source Quality Analysis features to record whether the information itself 
checks out.  These are described down in the Source Detail section. 
 
Tag – Sources can be marked with a tag so that later you have the option to print only the 
tagged sources when doing a source report. 
 
Exclude from reports – Select this option to exclude this source from the footnotes, 
endnotes, and bibliographies when printing reports or books.  Normally you will only want to 
print a few of your best and most reliable sources for each event on a report or book.  You 
might have a dozen or more sources for a person’s name, for example, but it doesn’t make 
sense to include all of them on a report.  The resulting footnotes end up very long and take too 
much space at the bottom of each page. 
 
Other Options 
In the header at the top of the screen there is an Options button.  From here you can set the 
Font size used for the Output Preview by using the Zoom option.  You can also save a 
bookmark for the current template so that you can easily use it in the future.  See Bookmarks 
a few pages back. 
 
Selecting a Different Template 
If you are adding a new source (as opposed to editing an existing source) you can go back to 
Step 1 and select a different template if you wish by clicking the Click here to select a 
different source template link in the header section. 

 
Saving the Source  
To save the source, click Save.  If you are adding a citation, you will be taken next to the 
Detail screen where you can enter additional information pertaining to the particular citation 
of the source that you are making.  This is usually a page number, item number, etc. 
  
 

Recording the Details 
The third step in adding a source citation is to fill in the detail information.  A particular 
master source of information may be cited an unlimited number of times within a Family 
File.  You might have found a book or bible that contains hundreds of family members.  The 
location of each piece of information for each individual should be recorded.  Rather than 
record the entire source description hundreds (or thousands) of times, taking up huge amounts 
of storage space, it is much more efficient to enter a general source description once, point to 
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it in the master source list and record just the unique information for each piece's place within 
that source.  
  
The Source Detail window is where you enter information about a source that indicates where 
in a specific source the cited information was found.  Most source templates contain 
additional detail fields, that when filled in, are incorporated into the final output of the 
footnotes or endnotes.  A typical Source Detail screen might look like this: 
 

 
 
 Detail Fields – Enter the requested information if you know it.  These is usually page 
numbers, volume numbers, item numbers of a microfilm rolls, line numbers, etc. 
  
Surety Level – While specifying the source detail, you can also indicate the Surety Level of 
the information.  This number, from zero to four, shows how sure you are of the information. 
  

0 indicates that you have not yet made up your mind about how convincing this source of 
information is. 

  
1 indicates that there is a little evidence to support this fact but it is not too convincing. 
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2 indicates that this is probably a true fact.  You don't have any reason to doubt it but 
there is no other evidence that backs it up. 

  
3 indicates that this is almost certainly a reliable source with factual information. 
  
4 indicates that you are as sure as you can be about this piece of information.  There are 

multiple sources supporting this fact, or you know someone who was there, or you 
were there yourself.  You are convinced that it is true. 

  
Source Quality Analysis – Pressing this button displays the Source Quality screen.  The 
basic principle is explained by Elizabeth Shown Mills in her Evidence Explained book: 
 

SOURCES provide INFORMATION from which we select EVIDENCE for 
ANALYSIS.  A sound CONCLUSION may then be considered “PROOF.” 

 
SOURCE 
Select whether this source is an Original or a Derivative of the original.  Or choose I 
don't know if you are not sure. 
  
INFORMATION 
Select Primary if the information in the source was provided by someone with firsthand 
knowledge, or Secondary if the information is secondhand.  Or again, I don't know if 
you are not sure. 
  
EVIDENCE 
If the source answers the question you are trying to resolve all by itself, select Direct.  If 
the source helps to answer the research question but doesn't do it directly, select 
Indirect.  Or, if you can infer an answer to the research question by the lack of 
information in the source, select Negative.  Or, if you are not sure, select I don't know. 
  
Click Save when you are finished. 

 
Recorded Date – This is the date you recorded the source citation. 
  
File ID # – You can assign your own filing number to the citation if desired. 
  

File ID Assistant 
To help you figure out the next available file ID number, click the Assistant button 

.  (See File ID Number Assistant on page 277 for more information.)  
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Include this Citation on Reports – By default each citation is marked to be included on 
reports and webpages.  If you would like to exclude this citation, uncheck the Include this 
Citation on Reports option. 
 
Detail Text Tab – Here you can record actual source text and comments about the source 
pertaining to this citation.  The text box can be a word-for-word copy of any description 
contained in the source.  Don't enter opinions about the source by you or the compiler.  This 
should only include "what the original record keeper said" as opposed to any interpretations.  
The Comments box is used to record notes for each source citation you enter.  You can also 
include your opinion of this particular citation or the interpretations of the compiler/indexer 
etc. 
 

Embedding Formatting Codes into the Notes – You can add formatting codes to your 
source text and comments so that portions print in bold, italics, underline and 
superscript.  These codes are used when printing reports, producing word processing files 
and Web pages.   

  
Multimedia Tab – Used to attach graphic files and other files to the source.  These may be 
scanned images such as birth certificates or obituaries, or you can include webpage URLs.  
Some source templates have space for a URL but it’s normal not to link to the specific detail 
webpage in a source because it is so subject to change – but it makes sense to add some of 
these to the Media section for quick access to the original. 

 
Overrides Tab – You can override any of the automatically formatted output that 
SourceWriter produces.  You can pre-fill each override (Footnote/Endnote Citation, 

Subsequent Citation) section by clicking on the  button to its right.  You can change the 
output to anything you want.  To actually override the default output, you must also 
checkmark the option just below each section. 
 
Output Preview 
To the right of the input section is the Output Preview.  As you enter the information about 
the source detail, it is instantly processed and displayed in three different formats so that you 
can see how it will look when included on a report or book.  The Footnote/Endnote Citation 
output is used for the first occurrence of a footnote (at the bottom of each page where a source 
is cited) or endnote (at the end of each generation, chapter, or book) on a report.  The 
Subsequent Citation is used in the same places as the footnotes and endnotes but uses a 
condensed format that doesn’t require as much room.  The Bibliography is printed at the end 
of a report and is a summary of all the master sources cited in the report and is shown in 
alphabetical order. 

 
Verified – This checkbox is used when you have verified the source detail information.  For 
example, if you receive information from another person, either through a GEDCOM import 
or by email or other means, you should verify that the source citations are true and accurate.  
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As you check each citation, you can mark Verified to indicate your confirmation of the 
source detail information.  (Master Sources also have a Verified checkbox for the same 
reason.)  You should be checking to make sure that you (or the person you’ve imported the 
source from) has properly read what the source actually says. 

  

Citing an Existing Source Using SourceWriter 
 From the Assigned Sources List from an Individual, Marriage, or To-Do screen, click  

Cite a Master Source.  The Master Source List appears. 

 

Master Source List 

 

 

 

 

 

 

 

 

 

 

 

 
(The output and the options below the list relate to the currently highlighted 

source in the list.) 

 

What Is Included in the List? 
The Master Source List shows all the sources being cited by any piece of information 
in your family file. If a source is referenced from more than one place, only one copy 
is recorded in the Master Source List and all references point to this one master copy. 
The lines showing in the Master Source List are the Source List Names. These names 
are displayed alphabetically.  (Remember to choose the Source List Name carefully 
as you’ll be using it to find each Master Source in the future.) 

 

Select this box 
to exclude the 

source on 
reports. 

Click Options 
to access 
tagging, 
combining 
duplicates, 
purging, 
importing, 
printing, and 
zooming. 

Select this box 
when you have 

verified the 
source. 
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Showing Source Details 
Below the Source List Name window, the details of the highlighted source are shown. 
This includes the Output, Text/Comments, Repository, and Pictures associated with 
the source. As you move the highlight bar up and down in the list, the details for the 
currently highlighted line are shown. 

 
Selecting a Source  

To select a particular master source, highlight the desired line and click Select, or 
double-click on the line. 

 
Tagging a Source 

You can tag Individual source lines in the Master Source List by either clicking in the 
Tag column of the desired source line, or by clicking the line to highlight it and then 
clicking the Tag checkbox. When a source line is tagged, a check mark appears in the 
Tag column. The tags can be used to limit the included sources when printing a 
Source Citation Report. 

 
Excluding a Source 

You can exclude an individual source from reports by either clicking in the Excl 
column of the desired source line in the Master Source List or by clicking the line to 
highlight it and then clicking the Excl from Reports checkbox. When a source line is 
selected for exclusion, a checkmark appears in the Excl column. 

 
Adding a New Master Source 
  To add a new source: 

1. Click Add. The Add a New Master Source window appears. (For more 
information on filling in this window, see Adding a New Source Using 
SourceWriter on page 72.) 

2. Fill in the source definition. 
3. Click Save. 

 (Help index: for Basic-style sources: Define or Edit a Master Source) 
 (Help index: for new SourceWriter sources: SourceWriter) 
 

Note:  If you want to add a new source that is very similar to one you have 
already entered, you can edit that existing source and then Save it as a new 
source. 

 
Editing a Master Source 
  To edit an existing source: 

1. Highlight the source entry you want to change. 
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2. Click Edit. The Edit Master Source Definition window appears. 
3. Make the desired changes to the source definition. 
4. Click Save. 

 
Note:  When you edit a master source and then click Save, a Changing… window 
appears asking if you would like to Apply the changes to ALL references of this 
master source or Apply the changes to a NEW copy of this master source.  If you 
apply the changes to ALL references, then every bit of information you linked the 
source to will show the new edits.  If you would like to create a new source with the 
edits, choose the NEW copy… option.  This will leave all the other existing 
references alone and just apply the newly edited version of the source to the current 
link. 

 
Other Options 

The Options button brings up a menu where you can choose the following: 
 

Delete Master Source  lets you erase a master source from the list.  If you try to 
delete a source that is being used anywhere in your family file, you receive a message 
to that effect and you are offered the option to view all the records that use it. 
 
  To remove a master source from the Master Source List: 

1. Highlight the source line you want to erase. 
2. Click the Options button and choose Delete Master Source from the popup 

menu. If the source is not being cited by any record in your family file, the 
source is removed from the Master Source List. If there are one or more 
records connected to the master source, a message is displayed indicating 
that the source cannot be deleted because it is in use. The message offers to 
display a list of the records currently using the source. Click Yes and a 
window with a list of all individuals who use the master source appears. If 
you still want to delete the master source, click Delete this Master Source 
and All Citations to It. 

 

Tag/Exclude   brings up the Tag/Exclude Option window where you can quickly set 
or clear all general source or report exclusion tags. 

Change Surety Settings   lets you modify the surety level setting of the 
highlighted master source. 

Combine Duplicates   combines any sources that are identical in every way. 

Purge Unused Sources   removes any master sources that are not being cited 
from anywhere in the entire family file. 

Import Lists   lets you import various lists from other family files. These include 
Locations, Surnames, Event Definitions, Temples, Marriage Status, Source Types, 
Child Status, Picture Locations, and other Master Source Lists. 
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Print   prints either a list of all the Master Sources or a Source Citation List that 
shows every individual and marriage that cites each source. 

Zoom   lets you vary the font size of the Source List Name column. 

Options for Non-Sources  lets you move information from master sources that 
doesn’t belong there.  This usually originates from imported material where other 
people have entered information that really belongs in a notes field instead of a 
master source record. 

 
Show List 

The Show List button displays a list of individuals who use the highlighted master 
source(s). 

 (Help index: Who is using this) 
 
Show Only 
If you would like to filter the Master Source List so that 
only certain sources are showing, you can choose the subset 
you would like to see by selecting the desired categories 
from the Show Only box.  When you want to see all the 
sources again, uncheck all the options. 
 
Searching for a Specific Source List Name 

If your list of master sources is extensive, you may have a need to search the list for a 
specific entry.  

 
  To search for a source list name: 

1. In the Find field above the Source List Name column, type the text you want 
to find. This should be the beginning of the source list name. As you type, 
Legacy displays the closest matching line in the list. 

 
Note:  When you have a lot of master sources, you will find that it is very 
advantageous to adopt some kind of system when naming the sources.  Some 
people use mainly locations, some use source types, some use surnames, or 
something similar. 
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Source Clipboard 
The Source 
Clipboard™ is a feature 
in Legacy that can 
tremendously increase 
the efficiency with 
which you document the 
sources of the 
information you enter 
into your family file. 
The Source Clipboard 
holds a copy of the 
source citation you are 
currently working from. 
You can then record the 
source of each piece of 
information by simply 
clicking one button. 
 
Legacy can store up to 10 different Source Clipboards allowing you quick access to each 
one. You can quickly switch between sources when assigning sources to the details for 
one or more individuals. Use saved Clipboards when you have two or more individual 
sources you often use and want a quick way of choosing which is used for each fact or 
event.  (See Saving a Source Clipboard, Loading a Saved Source Clipboard, and 
Quick-Loading a Saved Source Clipboard at the end of this help topic for more 
information.  

 

To get to the Source Clipboard, click the  button on any form that contains sourceable 
information.  These include the Individual and Marriage Information screens, the Event 
screen, the Children List, and many others. 
 
You can add or change the citation on the clipboard by clicking the Set button. (See 
Master Source List on page 84 for more information.)  The clipboard also holds the 
detailed information about where in the source the current information came from. This is 
usually a page number, microfilm item number, etc. The actual source text being cited 
can be entered on the Text/Comments tab. You can also set the surety level for the 
source information as well as set the Source Quality. This reflects your confidence in the 
accuracy of the information. (See Recording the Details on page 80 for more 
information.) In addition, you can enter a user file number to cross-reference the 
photocopies, extracts, and documents you find as you research your family. 
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  To exclude a source citation on a report: 
Deselect Include this Citation on Reports.  

 
  To include the actual source text in citations: 

Select Add this Text to the Source Citation on Reports on the Text/Comments 
tab. 

 
  To be prompted for the Source Detail each time you use the clipboard: 

Select Prompt for Detail at the bottom of the window. This is a convenient way to 
cite sources that are on many different pages of a document. 
 

Adding Multiple Sources to the Clipboard 
The ability to place up to five source citations on the clipboard is optional in Legacy. 
To do this, click the Options button and choose Allow multiple sources on the 
clipboard.   
 
Note:  You can also set this option in the 7. Sources section of the Customize Legacy 
screen which is reached by choosing Customize from the Options tab on the Ribbon bar.  
Scroll down to the 7.5 Source Clipboard - Capacity box and select the allowance of only 
one or up to five sources at a time on the clipboard.  (When you paste a source clipboard 
with multiple sources on it, all the sources (up to five) are added.  It doesn't matter which 
tab is current - all the source on the tabs with the asterisk (*) are pasted.) 
 
When you have entered the current source information, click Save to return to the entry 
form. 

 

Using the Source Clipboard 
Perhaps some examples will help to illustrate the value of this feature: 

 
You have just been to the local library and found a book that contains a lot of 
information about your ancestors. Page 211 of the book contains the following text: 

 

James Michael Martin Sr. was born on the 23rd of December, 1762, in 
Hackensack, New Jersey. On the 16th of May, 1784, Jim married Sarah Rebecca 
Gilbert somewhere in rural Bergen County, New Jersey, and they had the following 
children: 

 

1.  James Michael Martin Jr. Born 30 Apr 1785 in Hackensack. He married Ida 
Fredricks, daughter of Henry R. Fredricks and Millie Andrews, on 25 Dec 1806. 
Jim Jr. died in 1838 in New York, NY. 
2.  Sarah Martin Born 22 Jun 1786 in Hackensack, NJ. Died young and was 
buried in Hackensack. 
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3.  Rebecca Martin Born 8 Sep 1788. Married William Demarest in about 1807. 
They had six children. Becky died 15 Oct 1867 and was buried in Ohio. 

 

As you enter the information for each person on this page of the book, you should record 
the source of the information. Let’s go through the steps: 

 

1. On the Individual’s Information window, enter the information for James 
Michael Martin Sr.  

2. When you have finished, but before you click Save, set up the Source Clipboard 

with the source information. Click the Source Clipboard  button.  
3. First make an entry in the Master Source List about the book we are using. To do 

this, click Click here to select or change the master source to cite to bring up 
the Master Source List window. 

4. Click Add to display the Add a New Master Source window. 
5. Choose the source template to use and then click Go to Step 2 
6. Enter the source information into the template fields.   
7. Save the master source and Select it for use in the Source Clipboard. 
8. In the Detail Information section, fill in the details fields. 
9. Set the surety level to reflect your confidence in the accuracy of this information. 
10. Click the Analyze Source Quality button to set the source quality. 
11. Click Save to close the Source Clipboard and return to the Information screen. 

 
Now you are ready to assign the source citation to the information you have entered for 
James Michael Martin Sr. You have three choices from the Individual’s Information 
window: 

 

1. You can place the cursor in the Given field and click the  button to assign the 
source to just that piece of information. Place the cursor in the Birth field and 

click  again. Continue doing this in each field on the window to assign the 
source from the clipboard. 
 

2. Or, you can click  to have Legacy automatically assign the source to every 
field on the Information form that is not blank. 
 

3. Or, you can click  and have the source assigned to the general Unspecified 
category for this person. 

 

Option 1 is used when you return to add a newly found piece of information to an 
individual at a later time and want to assign a different source citation to that entry 
specifically. 
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Option 2 is generally the best and fastest method to use when entering information 
for an individual for the first time.  

 

Option 3 is used if you are not interested in keeping specific source information for 
each type of event for an individual, but just want to record the source in one place. 

 
Saving the Source Clipboard 

If you find that you are reusing a particular source citation, you can save it to disk for 
use in the future. Up to ten different citations can be saved. To save a citation, click 
Save after loading the desired master source and filling in the detail fields. When the 
Save Source Clipboard window appears, select one of the ten save positions by 
clicking it. Next, enter a name (up to 40 characters) in the Name field to describe the 
setup and then click Save. 

 
Loading a Saved Source Clipboard 

If you have saved one or more Source Clipboards, you can quickly load one back in. 
Simply click Load. When the Load Source Clipboard window appears, highlight the 
entry you want to load and then click Load. (Or just double-click on the entry.) The 
citation is loaded from disk and is placed on the clipboard. 

 
Quick-Loading a Saved Source Clipboard 

You can also load any of your saved clipboards by right-clicking on the   button 
whenever it is visible. This pops up a small list of the saved clipboards where you can 
simply click the one you want to load. 

 
Erasing Saved Clipboards 

To erase an entry from the list, highlight it and then click Delete. 





Chapter 6 

Lists and Tags 
Working With Master Information Lists 

 
The Name List 

What It Shows 
The Name List displays a list of individuals. It can either contain all the individuals in 
the entire family file or just a search subset. The list has a minimum of six columns: 
one for the RIN number (or the User File#), one for the individual’s full name, one 
for the individual’s sex, and three tag columns. You can also show all nine tag 
columns as well as columns for Potential Problem alerts and Hints. The area to the 
right of the list contains information about the highlighted individual and his or her 
family. The information shown can be customized. (See Displaying and Changing an 
Individual’s Details on page 96.) The Name List is displayed by clicking the Name 

List  icon on the My Toolbar tab of the Ribbon bar.  
   

The Name List can also include the alternate names as well as married names that 
have been recorded for various individuals. This makes the list especially useful 
when trying to find a specific person whose name may have been spelled differently 
on different records or when a nickname or married name has been used. 
 
To include alternate names or married names (Deluxe Edition only), click on the 
Options button and select Include Alternate Names and/or Include Married 
Names. 
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Sorting the List 
The Name List can be displayed in either surname order, given name order, or RIN 
order. Click Surname, Given or # at the top of the window, or in the boxes next to 
them. 

 

Finding an Individual 
If the list is long, you can search for an individual in the list by RIN, given name, or 
surname. To search by surname, click in the Surname box and type the name you 
want to find. Enter the surname first, followed by a comma and then the given 
name(s). To search by given name, click in the Given box and type the given names, 
followed by a comma and then the surname if known. To search by RIN, click in the 
# field and type the number you want to locate. As you type, Legacy automatically 
jumps to the nearest matching name in the list.  
 

Click # to sort the 
list in record 

number order. 

Enter a RIN 
here to jump to 
that person in 
the list. 

Click Given to 
sort the list in 
order of given 
name(s).

Click Surname to 
sort the list in 
surname order. 

These tabs 
display 
additional 
information 
for the 
highlighted 
person. Click 
a tab to 
change the 
information 
shown. 

 

Click Select 
to bring up 
the 
Information 
screen for 
the 
highlighted 
person. 

These nine 
columns 

show the tag 
settings for 

each 
individual. 

Click First to 
jump to the 

beginning of 
the list. 

Click To-Do 
to create a 
list of tasks 
needing to 

be done. 

Click Options for a 
menu of things you 

can do from the 
Name List. 

Click Search to 
find individuals and 
marriages using 
specific criteria. 

These icons show 
that Legacy has 
found Hints that 
you might want to 
view. 

These icons show 
that Legacy has 
found Potential 
Problems you 
might want to view. 
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Selecting an Individual 
To select an individual from the list, highlight the name and click Select, or double-
click the name in the list. 

 

Editing an Individual 
If you want to edit the information for any one person in the list, highlight the name 
and click the Edit tab. The individual’s edit fields appear. 

 (Help index: Edit: Tab on Name List) 
 
Adding, Deleting, or Editing an Individual’s Events 

If you want to add, delete, or edit an individual’s events, highlight the name and click 
the Events tab. 

 (Help index: Event: Tab on Name List) 
 
Displaying and Editing an Individual’s Family 

To display a list of an individual’s family members, highlight the name and click the 
Family tab. The individual’s parents, siblings, spouse, and children appear. You can 
edit a family member or marriage information by highlighting the family member 
and clicking the desired edit button below the list. 

 (Help index: Family tab: on name list) 
 
Adding, Deleting, or Editing an Individual’s Sources 

If you want to add, delete, or edit an individual’s sources of information, highlight 
the name and click the Sources tab. 

 (Help index: Source: tab on name list) 
 
Adding, Deleting, or Editing an Individual’s Notes 

If you want to add, delete, or edit an individual’s notes, highlight the name and click 
the Notes tab. 

 (Help index: Notes: on name list) 
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Displaying and 

Changing an 

Individual’s Details 
To display changeable 
details about an 
individual, highlight the 
name and click the 
Detail tab. There are up 
to eight lines on the 
Detail screen that can 
contain information. 
Each of these 
information lines can be 
changed to other pieces 
of information you 
might want to view instead. To change the lines, click any of the descriptive labels to 
the left of the lines (for example, “Born,” “Chr,” “Died,” or “Buried”). The 
Customize Name List Fields window then appears where you can select the new 
information you want to see.  
 
  To select the pieces of information to be shown on the Detail tab: 

1. Click  at the right of the item you want to change. 
2. From the resulting Field Names to Display list, select the new item by 

highlighting it and clicking Select.  
3. Continue with steps 1 and 2 until you have selected the information you want 

to display. If you want to display fewer than eight items, choose blank – 
display nothing from the Field Names to Display list. 

4. When you are finished, click Close. 
 

You can save up to ten arrangements of custom fields for future use.  To save the 
current arrangement, click Save.  To reload an arrangement that was previously 
saved, click Load.  (You can also reload a saved arrangement by right-clicking on 
the field names back on the Name List.  This pops up a small list of your saved 
arrangements where you can select the desired one.) 

 
Navigating 

Detail Tab  At the bottom of the 
Detail tab is a three-generation 
pedigree chart. The starting person on 
the chart is the highlighted person in 
the Name List. Use the pedigree chart 
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to navigate along family lines. Click on anyone in the pedigree chart to navigate to 
that person in the Name List. The chart is then redrawn for the new person. 

 
Family Tab   The 
Immediate Relatives list 
shown on the Family tab 
can also be used for 
navigating through family 
lines. Double-click any 
name to navigate to that 
person in the Name List. 

 
Creating a To-Do List 

To create a To-Do List of 
tasks (like finding a birth certificate), that need to be done, click the To-Do icon 

 in the lower-left corner. (See The To-Do List on page 119 for more details.) 

 (Help index: To-Do lists) 
 
Printing a Name List Report 

Whenever you create a list of individuals or marriages, you can also print a report 
containing those names. For example, if you search for all the people in your family 
file who have lived in New Jersey, a list is displayed containing the names found. 
This list can be printed by clicking the Options button at the bottom of the Name List 
window and then choosing Print… from the menu. The List Report Options window 
appears, where you can select the information you want to include on your report. 
 

 For complete information about printing list reports from the Name List, see 
the Legacy Help system and search the index for: List report options 

 
Other Options  

Clicking Options displays a menu of options you can do from the Name List. 
 

Include Alternate Names (Deluxe Edition only)  includes the alternate name 
entries for each individual in your family file. When turned on, the alternate names, 
also known as AKAs, are shown in the list with a leading tilde (~) character. 
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Include Married Names (Deluxe Edition only)  includes the married name 
entries for individuals in your family file. When turned on, the married names are 
shown in the list with a leading (§) character. 
 
Show User ID Number in List (Deluxe Edition only)  toggles the RIN column 
in the Name List with User ID#. When the User ID#s are being displayed, typing in 
the # field at the top of the form searches for ID numbers. 
 
Show Tags to include in the list  lets you choose between showing any three 
tags or showing all nine tags.  
 
Include Potential Problems in the list  shows the potential problems icons.  
 
Edit an Individual   lets you make changes to the individual’s information for any 
person highlighted in the list. 

 (Help index: Information screen) 

Delete Individual   erases the highlighted individual in the list. 

Advanced Deleting   allows you to delete tagged individuals. 

 (Help index: Advanced deleting) 

Advanced Tagging   lets you can tag an individual, their family, descendants, or 
ancestors. In addition, you can tag a focus group or everyone in the file. You can 
untag everyone in the file. 

 (Help index: Advanced tagging) 

Advanced Sourcing    displays the Advanced Source Citation screen where you 
can assign the current Source Clipboard citation to multiple records in your family 
file. 

 (Help index: Advanced: source citations) 

Set Living   allows you to set the Living status to Yes or No for multiple 
individuals at one time.  

 (Help index: Set living) 

Set Bookmark   lets you set a bookmark on the highlighted name so you can 
quickly and easily return to it later.  
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Go to Bookmark   returns to the bookmarked name at any time. 

Customize Display   lets you select the fields shown on the Detail tab. 

 (Help index: Customize name list detail) 

Zoom   zooms in and out, which changes the size of the lettering in the list.  You can 
choose a font size or have Legacy size the font automatically. 

 
Searching for Individuals 

You can search for individuals in your family file in many different ways by clicking 
Search. The type of searches you can do include: Query by Example, Detailed 
Search, and Miscellaneous Searches. (See Searching for Individuals on page 257 for 
more details.) 

 (Help index: Search) 

Find…  Displays the Search window where you can search for whatever you desire.   

Show Name List   This option causes the Name List to display the contents of the 
last search list.   

Show All Tagged   You can choose to limit the Name List contents to just those 
individuals who are tagged on a certain tag number.  Choose 1 through 9 (1 through 3 
in the Standard Edition). 

Show All Untagged   You can also display only individuals who are untagged on a 
certain tag number.  Again, choose 1 through 9 (1 through 3 in the Standard Edition). 

Show Everyone with a Hashtag of…   You can also display only individuals 
who have a specific hashtag assigned to them.  The Search Hashtags screen is 
displayed where you can select the desired hashtag. 

Search Internet for Current Person  displays the Search the Internet screen.  
(See Search the Internet for more information.) 

 

Jumping Into the List 
If you are in name-order mode, jump to the first name beginning with any letter by 
clicking the letter buttons above the list. You can also jump to the beginning or end 
of the list by clicking First or Last. 

 

Tagging Records  
You can tag or untag records using any of the nine tag numbers for an individual by 
double-clicking the appropriate tag column to the right of each name in the list. 
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Legacy also offers some advanced options for tagging records. (See Advanced 
Tagging on page 124 for more information.)  

 

Note:  If a tab caption is preceded by an asterisk (*), it means that there is information to 
view on that tab.  If all the fields on a tab are blank, there is no asterisk shown. 

 
The Marriage List 

 
The Marriage List 
shows husband-wife 
combinations. If a 
person was married 
three times, there are 
three entries in the 
list. The Marriage 
List is displayed by 
clicking the Marr 

List  icon on the 
toolbar. 

 

 

Editing a Marriage 
To edit the marriage information for a couple, highlight the names and click Edit 
Marriage. The Marriage Information window appears. 
 
To edit either the husband’s or wife’s information, click Edit Husband or Edit Wife 
respectively. The Individual’s Information window appears. 
 

Searching for a Husband or Wife  
If the list is fairly long, you can search for either a husband’s name or a wife’s name 
by typing the name in either the Husband or Wife field, starting with the surname. 
As you type, the nearest matching name is displayed in the list. You can also search 
by marriage record ID number (MRIN) by typing the number into the MRIN box. 
 

Jumping Into the List 
You can jump down into the list to names beginning with a certain letter by clicking 
the letter buttons above the list. This feature is available while the list is sorted by 
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either the husband’s or wife’s name. If the list is sorted by MRIN, only the First and 
Last buttons are enabled. 

 

Selecting a Marriage 
To select a marriage, either highlight the line and click Select or just double-click the 
line. 

 

Bookmarks 
You can set a bookmark in the marriage list so that you can return quickly and easily 
to it later, by clicking Set. To return to the bookmark later, click Go to. 

 

Options 
The following options are available by clicking Options: 
 
Sort by Given Name, Surname   (Deluxe Edition only) changes the sort order 
of the Husband or Wife column and shows the given names before the surnames.  
When in this sort mode, this option changes to Sort by Surname, Given Name so 
that you can change back if desired.  

Print   displays the Marriage Report Options screen where you can print a Marriage 
List report. 

Remove Marriage Link   unlinks the husband and wife from each other and from 
any children. 

Untag All  lets you remove the marriage tags for any of the displayed tag numbers in 
the list. 

Zoom   zooms in and out, which changes the font size for the Marriage List. 
 

The Spouse List 
The Spouse List shows 
all the spouses for the 
current individual along 
with the dates and 
locations of their 
marriages.  The Spouse 
List is reached by 
clicking the Spouse List 

icon  on the Husband 
or Wife toolbar. 
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Selecting a Spouse to Display 
  To change the currently displayed spouse: 

Highlight the desired spouse and click Select. You can also double-click on the 
desired spouse to select him or her. 

 
Changing the Sequence of Marriages 

  To change the order of the entries in the Spouse List: 
1. Highlight the line you want to move. 

2. Click Up or Down  in the lower-right corner of the window to move the 
line up or down in the list. 

 
Sorting the List 

  To sort the Spouse List by the marriage dates: 
Click Sort. All marriages with no marriage date are sorted to the beginning and 
the remainder are displayed in date order. 

 
Setting a Spouse to Preferred Status 

A preferred spouse is the spouse that is automatically shown when that person’s 
husband or wife is selected or displayed on the Family View or Pedigree View as you 
navigate through your ancestors and descendants. This avoids having to ask which 
spouse to display each time you change generations. The spouse that is currently set 
as preferred has an asterisk (*) in the P column of the Spouse List. 

 
  To move the preferred setting to a different spouse: 

Highlight the spouse you want to set as preferred and click Set to Preferred in 
the lower-left corner.  

 
Adding a New Spouse 

  To add a new spouse to the Spouse List: 
1. Click Add New Wife (or Add New Husband) near the lower-right corner.  
2. From the Add window, choose Add a New Person. The Information screen 

is displayed.  
3. Fill in the new information and click Save. 

 

Linking to an Existing Spouse 
  To link the current individual as a spouse to another person in the family 

file: 
1. Click Add New Wife (or Add New Husband) near the bottom-right of the 

screen.  
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2. From the Add window, click Link to an Existing Person. The Name List 
appears. 

3. Select an existing individual. 
 
Unlinking a Spouse 

  To remove the marriage link of the current individual from a spouse in the 
Spouse List: 
1. Highlight the spouse you want to unlink. 
2. Click Unlink at the right side of the window. The Unlink window is 

displayed. This window shows the name of the current individual from 
whom the spouse will be unlinked, along with a list of any children who are 
currently linked to these two people. If you continue with the unlinking, the 
children will remain linked to the current individual but will be unlinked 
from the spouse. 

3. If you are sure you want to unlink this spouse, click Yes. Otherwise, click 
Cancel to abort the command. 

 
Note: Unlinking a spouse from a marriage does not delete the person from the family 
file. It just breaks the marriage tie. The unlinked person still shows up on the Name 
List and is available for linking to someone else. 

 
Deleting a Spouse 

  To delete a spouse from the Spouse List: 
1. Highlight the name of the spouse you want to delete. 
2. Click Delete at the right of the window. The Delete window appears showing 

the names of those who will be affected by this deletion. These include the 
parents of the person being removed (who will lose a child), the current 
individual who is the husband or wife of the person being deleted, and the 
children of the marriage (who will be losing a mother or father). 

3. If you are sure you want to delete this person, click Yes. Otherwise, click 
Cancel to abort the deletion. 

 
Note: When you delete an individual it totally removes that person from the family 
file and also removes any links between the individual and any other person in the 
file. Before completing this command, Legacy displays a window warning of the 
consequences and listing all the people from whom this individual will be unlinked. 
These include parents, spouses, and children. If you are sure that you want to 
continue, click Yes. If you want to abort the command, click Cancel. 
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The Child List 
The Child List shows all the children linked to the current parents.  To display the Child 

List click the  button in the upper-right corner of the children list.  You can also reach 

it by either choosing Children’s Settings  from the View tab of the 
Ribbon bar or right-click on any child’s name in the list of children on the Family or 
Pedigree Views and then choose Children’s Settings. 
 

 
 

Changing the Sequence of Children 
The initial sequence of the children in the Child List is set by the order in which they 
were entered. If you want to change this order, highlight the child whose name you 

want to move, and then use the Up and Down  arrows in the lower-right corner to 
move the name within the list. 

 
Setting a Child to Preferred Status 

The preferred child is generally the child in your direct line and is indicated by an 
asterisk (*) in the P column of the list. Knowing who the preferred child is makes it 
much easier to move down your line from one descendant to the next. You can 
change the preferred child by highlighting the desired name and clicking Set to 
Preferred Child in the lower-left corner of the window. The asterisk in the left 
column of the list then moves to the new child’s name. 
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Sorting the List 
If you would like to sort the list in ascending order by the birth dates of the children, 
click Sort.  Note, you can also globally sort all the child lists for all families in your 
family file.  

 (Help index: Sort > Children > Sort Children, Marriages, and 
Events) 

 
Child Status 

You can tag each child with a special status if you like. Choose from Twin, Triplet, 
Stillborn, etc. You can also add new statuses. The default setting when a child is first 
added to the list is blank. To set a new status, highlight the child and then type the 

new status or click the Down  arrow on the Child Status field at the bottom and 
select the new status by clicking on it. 

 
Relationship to Father and Mother 

The link between a child and his/her father and mother can be specified and sourced.  
Choose from such things as Biological, Adopted, Guardian, Sealed, Step, as well as a 
place to record Challenged and Disproved relationships.  The default setting is blank, 
meaning Natural.  To set a new status, highlight the child and then type the new 

status or click the Down  arrow on the Relationship to Father or Relationship to 
Mother fields at the bottom and select the new status by clicking on it. (These fields 
are displayed on both Children List window as well as the Parents List window.) 
 

Private and Invisible Relationships 
You can mark the Relationship to Father or the Relationship to Mother as Private 
or Invisible by putting a checkmark in the Private or Invisible option to the right of 
the appropriate relationship status.  A Private setting cause the relation to not be 
mentioned on reports or web pages. An Invisible setting treats the relationship as 
non-existent on reports and web pages. It is as if the child and parent are not linked 
together. For example, you might have a Biological relationship between a child and 
a father that you don't want to publicize or even acknowledge. 

 

Editing a Child’s Information 
You can edit the individual’s information for any person in the list by highlighting 
the name and clicking Edit. The Information screen appears, where you can make 
changes. 
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Adding a Brother or Sister to the List 
You can add an additional brother or sister to the Child List by clicking either Add 
Brother or Add Sister. The Add window appears, where you can choose to Add a 
NEW Person or Link to an EXISTING Person. 

 
Unlinking a Child 

  To unlink a child from the list: 
Highlight the name and click Unlink.  

 
When you choose to unlink an individual from his or her parents, you are telling 
Legacy to break the tie that exists between that person and his or her parents and 
siblings (if any). Unlinking a person does not delete the individual from the family 
file. It simply disconnects him or her from having a child relationship to the current 
parents and a brother-sister relationship with any siblings. 

 
Before completing the Unlink command, Legacy displays a window containing the 
name of the parents and a list of any siblings currently linked to the individual. You 
can then complete the unlinking by clicking Yes, or abort the command by clicking 
Cancel. 

 
Deleting a Child 

  To delete a child from the list: 
Highlight the name and click Delete.  

 
Deleting an individual totally removes that person from the family file and also 
removes any links between the individual and any other person in the file. Before 
completing this command, Legacy displays a window warning of the consequences, 
and lists all the people from whom this individual will be unlinked. These include 
parents, spouses, and children. If you are sure that you want to continue, click Yes. If 
you want to abort the command, click Cancel. 
 
Note: Deleting a person can have several effects. The person will no longer be listed 
as a child of their current parents. The person will no longer be listed as a parent to 
children. Any children currently linked will no longer be connected to their 
grandparents. Before deleting a person, make sure it is what you really want to do. 
Once a person is deleted, the only way to get that individual back is to re-enter a 
record from scratch. 
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The Parents List 
This is a list of all the names who are currently linked to an individual as parents. A 
person might have more than one set of parents if an adoptive family line is being 
tracked, for example. 
 
Setting Parents to Preferred Status 
The preferred parents are shown in the list with an asterisk (*). These parents are shown 
on the Family View and Pedigree View.  
 
  To assign preferred status to other parents: 

1. Highlight the line by clicking on it. 
2. Click Select. The window closes and the new preferred parents are displayed. 

 
Adding New or Additional Parents 

You can also add a new set of parents by clicking Add New Parents. This adds a 
new set of “Unknown” parents to the list. Click Add Father and Add Mother to fill 
in their information. (See How to Add > Additional Parents in Legacy Help.)  If you 
want to attach a set of parents who are already in the family file, click Link to 
Existing. The Marriage List appears, where you can select the couple to add. 

 
Unlinking a Set of Parents 

  To unlink a set of parents in the list: 
1. Highlight the line by clicking on it. 
2. Click Unlink From Child. The Unlink box appears, showing the parents and 

siblings who will be unlinked by this action.  
3. Click OK to confirm your intent. 

 
Zooming the Parents List 

If you would like to have the font size in the Parents List made larger or smaller, 
click Zoom. The List Font Size window appears, where you can select a different 
font size. When you return, the list redisplays in the new size. 

 

Master Location List 
The Master Location List contains all the location names that are being used in the 
current Family File.  Legacy only records one copy of each different location and points 
any use of it to its entry in the list.  This saves a lot of disk storage space by eliminating 
duplications. 

 
To the right of the list of locations is the People using this location box.  The box shows 
which individual in your family file are using the currently highlighted location. 
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Below the list of locations is a map of the current location.  To see the map you must 
have Internet access and be online.   

 
Selecting a Location from the List 
To select a particular location, click on it and click the Select button.  You can also select 
a location by double clicking. 

 
Adding New Locations 
When you enter a location in a Place field, Legacy checks to see if the name is already in 
the Master Location List.  If it is not found, it is added to the list.  Depending on the 
setting in Options, you may or may not be prompted for confirmation.  When the Master 
Location List is displayed, you can add new locations by clicking the Add button below 
the list.  This pops up a form where you can type in the name of the new location, a short 
name, notes and latitude and longitude coordinates, which is then added to the list.   

 

 (Help index: Adding or Editing Master Locations) 
 

Editing Locations 
You can change the spelling of any location in the Master Location List by selecting it 
and clicking the Edit button.  Remember, however, that a change to a location in the 
master list affects all references to it. 

 
Tagging Locations 
You can tag locations so that you can filter the Location Report to a certain subset.   To 
tag a location, click the checkbox in the Tag column to the right of the desired location 
name. 

 (Help index: Location Report) 
 

Verifying Locations (Deluxe Edition only) 
From time to time you need to do some cleanup on your Master Location List.  This 
includes combining locations that are really the same, getting rid of locations that are no 
longer used, things like that.  Sometimes you will run across various locations that appear 
to be in conflict with each other.  For example, New Barbadoes, Essex, New Jersey and 
New Barbadoes, Bergen, New Jersey.  Which one is right?  Well, after doing a little 
research you find that they are both correct.  New Barbadoes was in Essex County from 
1693 to 1710 and was then transferred to Bergen County (and even later became the city 
of Hackensack).  You want to keep them both but somehow you need a way to mark 
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them as such.  This is where the Verified tag comes in.  Simply click on the checkbox 
column to mark them as verified, thus indicating to you later that they are "keepers."  
(You can also put a comment in the Notes fields, describing this.) 

 
Notes 
If you have added a note to a location (by using the Edit feature), an X shows in the N 
column in the list. 

 
Other Options 

 
Clicking the Options button displays a shortcut menu where you can choose from the 
following options: 

 
Deleting a Location 
If a location in the master list is not being used, you can remove it from the list by 
highlighting it and then choosing the Delete option.  Legacy confirms that the location is 
not being used and removes it from the list.  If one or more records are referencing the 
location, it cannot be removed. In this case, Legacy offers to display a list of all records 
currently using the name. 
 
Tag and Untag 
You can tag All Records in your location list or just the Highlighted Records.  (You can 
highlight more then one location in the list by holding down the Ctrl key while you click 
the locations.) 
 
Combining Duplicate Locations 
When correcting misspelled place names, you may find that you end up with duplicates 
within the Master Location List.  To remove these duplicates and clean up the list, choose 
the Combine option.  Legacy then goes through the list, combines the duplicates and 
moves the links. 
 
Purging Unused Locations 
To remove unused locations from the Master Location List, choose the Purge option.  
Legacy checks each name to see if it is being used.  If not, it is removed from the list. 
 
Importing a Locations List 
You can import a list of locations from a different Family File by choosing the Import 
option.  Legacy prompts for the name of the other Family File and then loads its list.  (If 
you end up having duplicate master locations that only differ by format, you should 
combine them together.  See Combining Multiple Locations below in this topic.) 
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Printing the List or the Map 
You can print the contents of the list in two different formats by clicking Print...  
Choosing Location List from the submenu prints a simple report listing the locations in 
the current sort order.  Choosing Location Report opens the Location Report options 
screen where you can print a report showing who uses each location and where they use 
them.  Choosing Bing Maps... prints the map for the current location.  (See Mapping My 
Places on page 113 for more information.) 

 
Page Setup 
You can change page orientation, margins, paper size, and font size before printing a 
report. 
 
Zoom 
You can change the font size of the master list grid. 
 
Options for Non-Locations 
If you have entries in your list that are not actual places but are valuable information that 
you would like to keep, you can move these entries into the Notes fields of the 
individuals and marriages that use them.   
 

 (Help index: Moving Non-Locations Out of the Location List) 
 
Jump with Edit Sorting 
When you edit a location name, it is immediately re-sorted into its new position in the 
Master Location List.  Sometimes this moves the edited location far away from the 
current position.  You can choose to have the current position move to the new point in 
the list or to just stay where you were and move to the next location name.  If there is a 
checkmark next to the Jump with Edit Sorting option, the current position will move to 
the next location name after the newly sorted position of the edit name.  If there is no 
checkmark next to the option in the shortcut menu, the current position will just move 
down to the next location.  Clicking the option toggles the checkmark on and off. 
 
Bookmarks 
If you are working your way down the Master Location List cleaning it up by combining 
variations of the same location name, correcting comma locations, etc., you can drop a 
bookmark to save your place until you return to resume the process.  Click Set 
Bookmark to drop a bookmark.  Click Go To Bookmark to return to the previously set 
bookmark. 
 



 Lists and Tags 

Legacy User Guide 111 

 

Contract/Expand Location Parts 
Legacy can automatically expand and contract state, province, and country names within 
your master locations. 
 

 (Help index: Contract/Expand Location Parts) 
 
Who is Using This Location 
The list to the right of the locations shows a list of all the individuals who are using the 
current location.  As you highlight each name in the list, you can see which events use the 
current location.  These are shown below the list, under the Edit button. 

 
Editing a Person in the List 
To edit a person in the list, click the Edit button to display their Information screen. 

 
Options 
 
Click the List Options button for the following commands: 
 
Create Search List 
You can create a new search list of names (replacing whatever is in the current search 
list) or add the names to the current search list. 
 
Print the List 
You can print a report list showing the names that use the current location.   
 
Tag or Untag All the Records in the List 
If you have just the records in the list tagged on a certain number, you can quickly jump 
to each of them by clicking the right or left tag arrow on the Family/Pedigree View.  You 
can then edit each record and remove or change the list reference.   
 

To tag the records in the list: 
 
1. Click the List Options button, hover over the Tag Everyone in List option and 

then choose the tag level you want to use from the flyout menu. If you would like 
to make sure all the other records in the Family File are untagged first, hover over 
the UnTag Everyone in File option and choose the desired tag level. 

2. To tag all the entries in the list, click Tag Everyone in List. 
3. Click Close. 
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Now, when you return to the Family/Pedigree View, you can rotate through all the tagged 
records and make the needed changes. 

 

 (Help index: Tagging Records) 
 

Adding a Picture to a Location 

Click the Picture  icon to add pictures, sounds, video clips, and documents to the 
location. 

  
Deleting a Location 
You cannot easily remove a location from the master list if it is being used by one or 
more individuals or marriages.  If you are sure you want to delete a location, you will 
have to remove the references to it shown in the list of individual who are using the 
location. 

 
Sorting the List 
You can display the Locations List in different sorted orders for the purpose of finding 
duplicate entries by clicking the Sort button. 

 

 (Help index: Sort Location List) 
 

Combining Multiple Locations 
Often, through entering information and by importing records from other people you will 
end up with two or more variations of the same location, spelled a little bit differently.  
For example, you might end up with: 
 

Pompton Pl., Morris, NJ 
Pompton Plains, Morris, NJ 
Pompton Plains, Morris Co., NJ 
Pompton Plains, Morris, New Jersey 
Pompton Plains, Morris, New Jersey, USA 
 

All of these locations are obviously the same place and should be combined into just one, 
"good", location name.  This is very easy to do in Legacy.  To combine multiple 
locations: 
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1. Choose one of the locations that you want to keep.  If it isn't exactly like you 
want it formatted, use the Edit button to fix it.  This is now your "good" location 
name. 

2. Highlight all the other locations in the group.  If the group is contiguous, you can 
highlight the top location and then hold down the shift key while you click on the 
bottom location.  The entire group will then be highlighted.  If the various 
locations are not in a continuous block, highlight the first one and then press and 
hold down the Ctrl key while to click on each of the other locations in the group.  
Each one will remain highlighted as you click the others. 

3. Click the Combine button at the bottom of the list.  The caption on the button 
will now change to read Combine With. 

4. Highlight the "good" location line by clicking on it. 
5. Click the Combine With button at the bottom.  All the "bad" locations are then 

combined with the "good" one and all the records in your family file that were 
pointing to the "bad" ones now point to the "good" one… (saving you potentially 
hours of editing). 

 

Distance and Bearing Calculator 
If you have the Deluxe Edition of Legacy you have access to the Distance and Bearing 
Calculator.  Using this calculator you can figure the distance between any two cities in 
your family file that have latitude and longitude coordinates.  To do this, you can 
highlight the two cities (click on the first city to highlight it and then find the second city 
and hold down the Ctrl key while you click on it.  This will leave both cities highlighted) 

and then click the  button and choose Distance and Bearing Calculator.  You can 
also figure the direction to travel to get from one to the other. 

 

 (Help index: Distance and Bearing Calculator) 
 
The Master Locations List is reached by clicking the down arrow next to any location field.  It 
can also be displayed by choosing Master Lists > Locations from the View tab of the Ribbon 
bar. 
 
 

Mapping My Places 
When all the locations where a family lived and worked are plotted on a map together, 
you can easily see the overall area in which the family spent their lives.  You can 
visualize how the family members migrated from place to place as they grew older.  (Or 
you can see if they stayed in one place their entire lives.)  New research opportunities 
come to light as you see the surrounding cities, counties, provinces, and countries. 
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With Legacy Mapping you can see an overall view of a family’s territory spanning the 
entire earth if necessary.  You can also zoom right into the street level of anywhere in any 
country in the world. 
 
There are two places in Legacy where mapping is available, the Master Location List and 
the Map of Places for an individual. 
 
Note: An active Internet connection is required in order to use the mapping feature in 
Legacy.  If you are not online, the maps will not be displayed.   

 

Master Location Mapping 
Whenever the Master Location List screen is displayed, the current location in the list is 
shown on a map in the lower half of the window.  (Unless you have the Show Map 
option unchecked or you are not connected to the Internet.)  As you highlight locations in 
the list, the map is redrawn to display that place.  If the location has an L in the L column 
(which stands for Latitude/Longitude) the map is drawn for the coordinates in the latitude 
and longitude fields for that location.  If there is no L, Legacy submits the place name to 
Bing MapsTM over the Internet where it is matched with a location in its worldwide 
database.  The resulting latitude and longitude coordinates are then recorded in Legacy 
for future use.  Sometimes an acceptable close match in Bing Maps cannot be found for a 
place name.  In this case, a small window is displayed with two or more location names 
to choose from.  For example, Dixville, Morrison, Minnesota results in the following 
possibilities: 

 
If you find one that is acceptable, click on it.  If none of the choices are correct, click the 
close button in the upper-right corner. 
 
If no possibilities are found by Bing Maps, which is rare, a message is shown telling you 
that you will have to use other tools to figure out the real location name.   
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Since Bing Maps only looks for current locations, a historically accurate place name that 
no longer exists may trigger a Place Not Found message. 
 
Bing Maps is even smart enough to find US and Australian Postal Codes locations.  If 
you only know a person’s Zip Code, enter it into a master location.  The map will display 
the location.  Once this is done, you can change the zip code location to the actual city 
name found. 
 
Sometimes Bing Maps returns some really ridiculous possibilities as it tries to find a 
place name match.  Look them over carefully before accepting one.  Note, You can 
always find the position on the map for yourself and then right-click to set the pin. 

 

Geo-coding Your Locations 
Geo-coding is a process that runs through all your locations and tries to find a match in 
the Bing Maps location database.  Upon finding a match, the latitude and longitude 
coordinates are then recorded in Legacy.  As you highlight any location in your Master 
Location List, this geo-coding is automatically attempted.  You can have Legacy run 
through all of your locations automatically geo-coding what it can by clicking the Geo-
Code button and then choosing Geo-code all unresolved locations through Bing Maps.  
As each location is resolved, an V is shown in the L column.  At the end of the process, 
any location without an V will have to be looked at so see if you can figure out where 
they refer to. 
  
If you would like to redo the geo-coding for a specific location, highlight the place name, 
click the Geo-Code button and then choose Geo-code current location again through 
Bing Maps. If mapping comes up with an obvious location error, you can also click the 
Geo-Code button and choose Do not auto geocode this location.  Then use another 
location closer to the proper place to get the map close and then re-highlight the place 
you are mapping and right-click on the map to set the pin in the proper place. 
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Working with the Maps 
Here is a typical map, in this case showing Paris, France: 

 

 
 

Notice the  pushpin on the map at the location.  The map only shows the current 
location.  If you hover the mouse over the pin, the location name is displayed in a popup. 
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In the upper-left corner of the map is the 
View Control.  The View Control lets you 
zoom in  and out , pan the map up and 

down and sideways , switch from 
Road (drawn map) to Aerial (satellite view) 
to Hybrid (a combination of Road and 
Aerial) and Bird’s eye (an angled airplane 

view). 
 

You can hide the View Control by clicking the  button at the upper-right corner.  To 

display the View Control again, click . 
 
If you double-click anywhere on the map, the point where you clicked will move to the 
center of the map and the map will zoom in one setting.  You can also drag the map in 
any direction with the mouse. 
 

The 2D view is a rendered (drawn) view. 
 

Printing a Map 
If you would like to print the map, click the Options button near the upper-right corner of 
the window and choose Print > Bing Maps… from the submenu.  If you would like to 
print the map in landscape mode, click Preferences from the Print dialog box and 
change the Orientation to Landscape and then click OK.  Click Print to send the map 
to your printer. 
 

How to Make a Graphic File from the Map 
If you would like to save the map as a graphic file that can be attached to a person, event, 
location, source, etc., you can use any good screen capture program, or you can use the 
Windows Snipping Tool (Google Windows Snipping Tool for instructions on how to use 
this tool that is built into Windows.) 
 

Event / Repository Addresses 
The Event Address and Repository Address screens provide researchers a place to record 
addresses where key events took place (for example a church) or where important records 
are located (for example an archive or library). The Event Address and Repository 
Address screens look and behave like the Mailing Address screen, except that they do not 
build a name and do not have Mailing List options. 
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  To open an event address: 

1. Click the  button to 
the right of a birth, 
christening, death, or 
burial event on a 
person’s Information 
screen and then choose 
the Address option 
from the popup menu. 
The Event Address 
window appears.  It 
can also be reached by 
clicking the Address 

 icon in the Add or 
Edit Event window for 
an individual. In 
addition, the screen 
can be opened by 
selecting Master Lists 
> Address Lists from the View tab of the Ribbon bar, then choosing Event. 

2. Select an address from the Master Event Address List. 
 
  To open a repository address: 

1. Select View > Master Lists > Address Lists > Repository.  The Master 
Repository List appears. 

2. Select an address. 
 

You can enter a name, address, and up to two phone numbers for each event or repository 
address. You can also include e-mail and Internet addresses, plus latitude and longitude, 
notes, and pictures. 
 
  To add a repository address: 

1. Click Add on the Master Repository List window. 
2. Fill in the address, phone number(s), e-mail address, and Internet address. 

3. Click the  button at the right of e-mail and Internet addresses to send a 
message or connect to the Internet without leaving Legacy. 

4. You can include the latitude, longitude, and notes about the address. 
5. When you are finished, click Save. 
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Other Address Options 

Save   saves the address. 

Cancel   closes the window without saving any entries or changes. 

Address List   opens the Master Mailing, Event, or Repository Address lists. 

Delete   removes an address from an individual or event. 

Repeat   repeats the entry made in the same field of the last address you entered 
during the current session. If the current field already contains an entry that would be 
overwritten by the Repeat option, Legacy asks for permission before replacing it. 
You can also use F8 to repeat a field. Clicking on the line labels also repeats the 
entries. Clicking the Address label repeats both address lines. Clicking on any other 
box label repeats just that line (including the “Name” label). You can repeat an entire 
address by right-clicking Repeat. 

Help   opens Legacy Help. 

Picture   opens the Media Gallery, where pictures can be added. 
 

The To-Do List 
The To-Do List 
makes it easy to 
track research and 
other tasks that need 
to be done. Legacy 
allows you to create 
General and 
Individual To-Do 
Lists. For example, 
you can create a 
General To-Do List 
of books and 
microfilm to search 
when visiting a 
library; or create an 
Individual To-Do 
List for your great 
grandfather by listing your need to find his obituary, his World War I service record, and 
his birth certificate. To-Do Lists can be printed out for research trips or used as research 
logs to be placed with your transcriptions, photocopies, and correspondence. 
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Find   Type the first few letters of a To-Do Item name to jump to it in the list. 

To-Do Type   By default, General To-Do Lists display when opening the To-Do 
List from the toolbar or from the View tab of the Ribbon bar. By default, Individual 
To-Do Lists display when opening the To-Do List from an Individual’s Information 
screen, the Husband or Wife box in the Family View, or when the primary individual 
is selected in Pedigree View. To select the type of To-Do item you want to view, 

click the Down  arrow (to the left of the Close button) and choose from the list. 
 
The To-Do Item List 

Status   indicates whether the task has been completed or not (O = Open, C = 
Closed). 

To-Do Item   is the name of the task. 
Date   is the opening date of the task. 
Type   is the type of task (R = Research, C = Correspondence, O = Other). 
Priority   indicates the importance of the item: High, Medium, or Low. 
Tag   indicates whether the To-Do items has been tagged for printing. 

 

Tabs 
Tabs that display an asterisk (*) contain information. 

To-Do   shows who or what the highlighted item is for, as well as the task name, task 
type, status, open date, closed date, priority, and filing reference number. 

Task Description   is the detailed description of the task to be done. 

Results   shows the outcome of the task. 

Repository   is the location or repository to visit or contact to accomplish a task. 

Filter Options   lets you choose the criteria (category, locality, status, type, priority, 
and tagged) used to display To-Do items on the list. When your selection is complete, 
click Apply Filter. To see every To-Do item on the list, click Show All. 

Sort Order   lets you sort items on the To-Do List. For example, the primary 
consideration might be status (open), the second, priority, and the third, open date. 
This order ensures that all items marked Open go to the top of the list, sorted by 
priority, then date. After selecting the three sort levels, click Apply for your choices 
to take effect. 

 
Buttons 

Close   exits the window. 

Add   adds a new To-Do item. 

Edit   allows you to edit a highlight item on the list. 
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Print   prints a To-Do List. 

Options   gives you a choice to Delete, Combine Duplicates, Import, Tag, Untag, 
and Zoom. 

Combine Highlighted To-Do Item to Another To-Do Item in the List   
allows you to select a To-Do item on the list that you want to combine with another 
item. Click this button and the button face changes to Highlight Destination To-Do 
Item. Then Click This Button. 

 

Sources of Information 

To attach a source to the to-do item, click the Sources  icon. (See Citing Your 
Sources on page 71 for more information.) 

 Source Clipboard 
 The Source Clipboard is a feature in Legacy that can tremendously increase the 
efficiency with which you document the sources of the information you enter 
into your family file. (See Source Clipboard on page 88 for information on how 
and why to use this feature.) 

 (Help index: Source clipboard) 
 
To-Do Clipboard (Deluxe Edition only) 

You can copy To-Do items to the clipboard and then paste them again where desired. 
 
  To copy a To-Do item to the clipboard: 

1. Highlight the item you want to copy. 

2. Click the  button. 
 

  To paste an item from the clipboard to a list: 
1. Open the To-Do list you want to add the item to. 

2. Click the  button. 
 
  To Save the current clipboard to disk: 

1. Click the  button. 
2. Highlight one of the ten entries where you want to save the clipboard. 
3. Enter the name for the saved clipboard in the Name field. 
4. Click Save.    

 
  To load a clipboard item previously saved: 
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1. Click the  button. 
 

Tag Checkbox 
The To-Do List contains a Tag column. You can tag a To-Do item by clicking its 
checkbox, or by highlighting the item and selecting the checkbox in the lower-left 
corner of the window. 

Creating a New To-Do Item 
 

  To create a To-Do item: 
1. To create a general To-Do 

item, click the To-Do  

icon on the toolbar or 
select To-Do List from the 
View tab of the Ribbon 
bar.  
Or 
To create an individual To-
Do item, click the To-Do 

 icon associated with 
the individual in Family 
View or Pedigree View, or 
open the Information 

screen and click the To-Do  icon. 
2. In the To-Do List window, click Add to create a new To-Do item. 
3. In the To-Do Item window, select a category for the task in the Category field. 
4. Enter the locality of the task in the Locality field. 
5. Enter a task name in the Task Needing to be Done field. 
6. Note that the Open Date defaults to the current date and the Status  defaults to 

Open when adding a new item. 
7. If you want to be reminded of this To-Do item on the Legacy Home tab, enter a 

reminder date.  The reminder will start showing on the Home tab when the 
advanced reminder time arrives. 

8. If the task involves visiting or writing to a specific place, click Add on the 
Repository tab to enter it on the Master Repository List. Type the name, address, 
phone number(s), plus e-mail and Internet addresses. If the location is already on 
the list, click Select and choose it from the Master Repository List. 

9. Indicate the Type of task to be done by selecting Research, Correspondence, or 
Other. 

10. Indicate the Priority of the task by selecting High, Medium, or Low. 
11. Click the Task Description tab to enter a brief explanation of the task. 
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12. Click the Results tab to enter a summary of the results. 
13. Click Save when finished. 

 
Editing an Item 
 

  To edit a To-Do item: 
1. From the To-Do List screen, highlight the To-Do item to be edited. 
2. Click Edit to modify the selected item. 
3. Edit the To-Do item. 
4. Click Save when done. 

 

Tagging Records 
You can tag individuals 
and marriages to mark 
them for various 
reasons. For example, 
you might want to tag 
some people to be 
included in a report, or 
tag some individuals 
whom you are currently 
researching so you can 
find them quickly when 
you get more 
information. There are 
nine tag numbers you 
can use for each 
individual and for each 
marriage. (If you are 
using the Standard 
Edition, only three are 
available.) This allows you to use different tag numbers for different purposes. Perhaps 
you want to export all #3 tagged individuals, print an ancestry report for all #2 tagged 
people, and use #1 tags for names you are currently working on. 
 
To tag an individual, click the desired tag number  in 
either the Husband or Wife box. To tag a marriage, click the desired tag on the Marriage 
bar. 

 

When an individual or marriage is tagged, the tag box is filled with a color other than 
white  . When it is untagged, it is filled with white. 
(You can set the tag colors in the Customize section.) 
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Advanced Tagging 
The Advanced Tagging window is used to quickly tag or untag families and other larger 
groups of related people. Entire ancestral or descendancy lines can be tagged (or 
untagged) with the click of a button. This window is activated by right-clicking one of the 
three tag boxes. The Advanced Tagging window appears. 

 

The person whose name appears in the box at the top is considered the current individual. 
All tagging actions (listed below) are done with this individual in mind. If you want to 
change to a different person, close the window, navigate to the new person, and then 
right-click on the Tag box again.  

 

The Tag number (1 through 9) boxes under the name show the current status of each of 
the nine tags (three in the Standard Edition). You can tag or untag any of these by 
clicking on them. 
 
Tagging or Untagging 

Select either Tag or Untag to specify the type of action you want to accomplish. All 
further actions will follow this command. 

 

Tag Number 

Use the Up and Down  arrows to the right of Make changes on # to select the tag 
number to work with. All further actions will affect this number. 

 
Tagging an Individual 

To tag (or untag) a specific individual, select (or clear) the desired Tag boxes under 
the name box. You generally don’t come in here just to tag an individual. It is much 
easier just to click their Tag box on the Family View or Pedigree View, but the option 
is included here just in case. 
 

Tagging a Family 
A family is considered to be the 
selected individual and his or 
her spouse(s) and all the 
children from the individual and 
his or her spouse(s). To tag (or 
untag) a family, click Family. 
The Spouse List for the current 
individual appears.  
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If the individual has more than one spouse, you can select one of them or all of them 
by clicking the appropriate button on the right side. 
 
You can also use the four checkboxes above the spouse list to expand the scope of 
the family. You can include: 
 
 The parents of the current individual. 
 The parents of the selected spouses. 
 Multiple parents, if any. 
 The spouses of the children. 

 

Tagging a Person’s Ancestors 
You can tag (or untag) all the direct-line ancestors of the selected individual for a 
specific number of generations and even include the descendants of those ancestors if 
you want to include an entire branch of a family. 
 
To tag (or untag) ancestors, click Ancestors. The Ancestor Options window appears.   

 (Help index: Tag:Ancestors) 
 

Tagging Everyone in the Entire Family File 
You can tag (or untag) every person in the entire family file by clicking Everyone. 

 
Tagging a Person’s Descendants 

A person’s descendants include the individual’s children from every marriage, their 
children from all of their marriages, and so on.  
 
To tag (or untag) descendants, click Descendants. The Descendants Options window 
appears.  

 (Help index: Tag:Descendants) 
 
Tagging Everyone in the Current Search List 

You can tag everyone in the current search list by clicking Everyone in Search List. 
(If there is no current search list, this button is disabled.) 

 

Tagging Everyone in the Entire Family Line 
You can tag (or untag) everyone connected to the current person by clicking Entire 
Family Line. This means all of the individual’s ancestors and descendants. It also 
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includes all the descendants of the ancestors, ancestors of the descendants, and all 
their spouses. Everybody linked in any way to the starting individual is included. 
This is a great way to separate one tree from another in a family file. 

 
Clear All Tags on All Numbers, For Everyone 

You can clear all tags on all tag numbers for everyone in the entire family file, by 
clicking Clear All Tag Numbers For Everybody. Warning: If you have set any tag 
numbers as permanent tags to indicate things like having finished researching this 
person for the moment, you probably don’t want to use this option to clear ALL the 
tags.  Just clear as many tags as needed for the new project. 

  
Naming the Tags 

You can enter a description in the Tag Descriptions fields for each of the nine tag 
numbers to remind you what they are being used for. These descriptions are optional 
and for your own information.  

 

Selecting the Tag Numbers for the Family View and Pedigree View 
In the Deluxe Edition, the Family View, Pedigree View , and optionally the Name List 
show all nine tags. Optionally, in the Name List, you can choose to display only three 
tags.  You can choose which three to show on the Name List on the Advanced 
Tagging screen.  (Note, only three are available in the Standard Edition).  
 



Chapter 7 

Creating and Printing Reports 
What Goes In Should Come Out 

 
There are several different report formats available within Legacy. They are accessed by 
choosing the Reports tab on the Ribbon bar. 
 

Select a Report 
Choose the Reports tab on the Ribbon bar.  

 
This tab contains many different kinds of reports. These are grouped into four different 
types: Reports, Book Reports, Blank Charts, and Wall Charts.   
 
Illustration of the Family Group Records report is shown as an example for all of the 
screens. 
 
This Family Group 
Report screen is 
representative of what 
you will see on the other 
report tabs on this 
window. 

 
Report Language 

For many of the 
reports in Legacy, 
you can choose from 
different languages 
when generating 
them.  For example, 
you might want to 
produce a Family 
Group Record in German to send to a cousin there.  To select a language, click the 
Report Language button and choose the language file to be used when generating 
the report.  There are many language files available.  These can be found on the 
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www.LegacyFamilyTree.com web site.  To reset the language selection back to the 
default value, click the Reset button. 

 

Color Text and Boxes 
When printing reports that included boxed information, you can select from four 
different coloring styles (or none at all).   
None 

Prints black text in boxes with a white background. 
Color all text and boxes the same 

You can choose the text color and the background color of the boxes.  You can 
also choose to Only color individuals tagged on a certain tag number and/or 
Only color individuals with a certain hashtag. 

Male / Female Colors 
You can select the text and background colors to be used for males and females. 

Ancestor Colors 
Choose to use group 1 or group 2 ancestor colors for the boxes. 

 

Options 
All the reports from the Reports and Book Reports section of the Reports Tab of the 
Ribbon Bar except those under Other Reports and the Statistics Report have a Report 
Options button. There are also Index Options from which you can choose index 
style, number of columns, and border lines. A Location index is also available. (See 
Index Options on page 130 for a complete description of all the available index 
options.)  
 
Selecting or clearing the appropriate checkboxes and option buttons establishes what 
will appear in the report. If an option is not available for a particular report, the check 
box or option button will be disabled. 
 

Report Options 
Click Report Options to open the Report Options window where there are five tabs. 
Each tab contains several options that you can use to customize the printout. Each tab 
and its options are described below.  (Note: Some options are greyed out/disabled 
either because they are mandatory or because they don’t apply to the particular 
report.)  For a complete explanation of what each option means see: 
 

 (Help index: Report Options) 
 

Include Tab 
Lets you specify what you want to include in the report.  These include individual 
pieces of information, events, addresses, and notes. 
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Format Tab 

These options control the overall look of the report including boxes, lines, 
highlighting, compression of information (so that more will fit on a page), name 
formatting, section page renumbering, removal of blank lines, formatting of event 
paragraphs, and inclusion of address information. 

 
Notes/Stories Tab 

The options on this tab let you choose the type of notes you want to include on the 
report.  In addition to notes, you can select which stories to include. 

 
Sources Tab  

Choose to include source citations, how they should be formatted and where to print 
them.  You can also include pictures. 

 

Pictures Tab  
This is where you indicate that you want to include pictures in a report, which 
pictures to include, what size, if you want drop shadows, etc.   
 

Other Options 

Privacy Options 
Clicking the Privacy Options button on the right edge of the Report Options window 
displays the Privacy Options screen.  From here you can suppress the details for 
living individuals, and details for deceased spouses or children of living individuals.  
You can also override the default privacy settings so that people who are marked as 
private or invisible are included in the report. 
 
Page Setup, Headers, Footer Options 
Clicking the Page Setup, Headers, Footers button displays the Page Setup screen. 
 

Page Setup Tab 
Set the page margins, orientation, and size.  You can also choose double-sided 
printing if your printer supports it.  Border lines can also be selected. 

 
Headers and Page Numbering Tab 
Choose the header position and page numbering options. 

 

Footers Tab 
Set options for compiler and report credit information. 
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Report Fonts  
Choose the fonts to use on the report and what size and attributes to use.  You can 
also set the line spacing. 

 
Index Options  

Name Index  

Birth & Death Years on 
Names   includes birth and death 
years in parentheses after names. 

Include Alternate Names  to 
include each individual’s alternate 
names in the report index, select 
this option.  The alternate names 
are shown with a leading tilde 
character (~). 

Include married names  to 
include the married names of the 
individuals in the name index.  
(Married names are entered on the 
Marriage Information screen, 
either manually or automatically, 
depending on the married name 
rule setting.  Note: The married 
name entered via the married name rule setting can be overridden and the name you 
enter will be used in the index.) 

Style 1   shows each surname only once in the index, with associated given names 
arranged under it. 

Style 2   shows each individual by surname and given name in the index. 

Uppercase SURNAMES  formats surnames in uppercase. 

Columns   chooses one, two, or three index columns per page. 
 

Location Index 

Include a Location Index   adds a Location Index after the regular index. 

Include Latitude and Longitude   includes these values in the index entries. 

Include Notes   includes the location notes (if any) along with the index entries. 
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Display each location in reverse order   causes the locations to be printed from 
the largest jurisdiction to the smallest.   Seattle, King, Washington would be printed 
as Washington, King, Seattle. 

Columns  Choose one, two or three index columns per page. 

 

Use Leaders   adds leaders (. . . . . . .) between the name and its page number(s). 

Start Indices at Odd Page Number   starts an index on an odd page number. 

 
Printing the Report 

There are several different ways that you can produce reports.  (Due to the formatting 
requirements of various reports, some of the output formats may not be available): 

 

 Preview 
 Print 
 Create a Text file 
 Clipboard as Text 
 Create an HTML file 
 Create a Rich Text file 
 Create a PDF file 
 
Preview 
Click Preview to 
generate and 
display the report 
on the screen. This 
step should be 
taken to proof the 
report prior to 
printing, as it can 
keep you from 
wasting paper and 
help you save time. 

 
 

Note:  When you 
are viewing a report 
in the Preview 
window, you can 
then produce a 
matching PDF file 
by clicking the Create PDF button. 
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Print 
Click Print to sent the report directly to your default printer.  This should only be 
done when you are confident that the report format is just as you want it. 
 
Create a Text file 
Use this output option to create your report as a text file (with no special 
formatting)  When you choose this output format, the Preview button is disabled 
and the Print button is changed to Create.  Clicking Create prompts you for an 
output file name and location. 
  
Create Report on the Windows Clipboard as a Text file 
This option creates a text version of the report (with no special formatting) and 
then places it on the Windows clipboard.  You can then paste the report 
anywhere text can be placed.  This is a great way to quickly include a report in an 
email. 
  
Create an HTML file 
Creates your report as an HTML file – the same format used on web pages. 
When you choose this output format, the Preview button is disabled and the 
Print button is changed to Create.  Clicking Create prompts you for an output 
file name and location. 
 
Create a Rich Text file 
Your report is created as a rich text file along with all the formatting included in 
a printed report.  This type of report file can be loaded into a word processor 
where you can add or edit it as desired.  When you choose this output format, the 
Preview button is disabled and the Print button is changed to Create.  Clicking 
Create prompts you for an output file name and location. 
 
Create a PDF file 
Use this option to output your report as a PDF (Portable Document Format) file.  
This popular type of file retains all the formatting of a printed report and is easy 
to attach to emails.  When you choose this output format, the Preview button is 
disabled and the Print button is changed to Create.  Clicking Create prompts 
you for an output file name and location. 

 

  For complete information about previewing reports, see the Legacy Help system 
and search the index for: Print Preview 
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Ancestor Book  
An Ancestor book (also known as an Ahnentafel 
report) is a book-style report beginning with a 
specific person and moving back through the 
person’s ancestors for a given number of 
generations. (Ahnentafel means ancestor table in 
German.) This type of report describes each person 
in a narrative format and gives each person a 
unique ahnentafel number. The starting individual 
is given a number of 1. From then on, an 
individual’s father is assigned a number that is two 
times the number of the individual. The mother is 
assigned a number that is twice the individual’s 
plus 1. If you are number 1, your father is 2, your 
mother is 3, your father’s father and mother are 4 
and 5, and your mother’s father and mother are 6 
and 7, and so on. If a person is missing, their 
number is skipped. 
 
  To create an Ahnentafel (or Ancestor) book: 

1. From the Reports tab on the Ribbon bar choose . 
2. Set the desired options. 
3. Click Preview or Print. 
 

 The Ahnentafel (Ancestor) Book/Report Options window has five tabs and three buttons 
that you can use to customize the printout. Each tab and button is described below: 
 
Options Tab 

Insert Underlines   inserts an underlined space so that missing given names, 
surnames, and dates and places can be filled in later. 

Total Generations   sets the number of generations to include in the report. A 
three-generation report would include an individual, his parents, and his 
grandparents. 

Table of Contents   generates a table of contents, listing the starting page for each 
generation included in the report. You can specify the format of the table. 
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Other Report Options 

 
Click Index Options, Report Options , and Title Page at the bottom of the Options 
tab to open up additional screens where you can select many more customization 
features. Click Help on these screens to read all about the options available.  

 
Page Layout Tab 

Start New Page After Each Generation   starts each generation on a new page. 

Print Names in Bold   puts each name in bold-face type. 

Paragraph Indents   set the distance to indent each type of paragraph included in 
the report. 

Custom Report Spacing  choose blank space to be included above the report 
sections. 

 

Heading Layout Tab 
Title for Page 1   prints the title only at the top of the first page of the report.   

 (See Help for field codes that can be used in Titles and Headings.  Help 
index: Report, Title options) 

 

Headings   prints the title at the top of all the pages after the first page. 

Subtitles   specifies the type of generation subtitles printed. These can include the 
generation number (Generation One, Generation Two), or the relationship of the 
generation (Parents, Grandparents), or both (Generation Two, Parents). You can also 
specify the position of the subtitles as being left-justified or centered. 

 
Wording Tabs 

You can specify phrases when creating narrative paragraphs of the report. 
 

 (Help index: Ancestor book reports) 
 

  



 Creating and Printing Reports 

Legacy User Guide 135 

 

Ancestor Chart 
The Ancestor tab is used to create a report listing 
the ancestors for any given individual selected 
from the family file. Birth dates, RINs, generation-
level numbers, and the number of generations to 
show are controlled here.  
 
  To create an Ancestor chart: 

1. From the Family View or Pedigree View, 
highlight the person you wish to begin 
with. 

2. Click the Reports  icon to display the 
Select a Report screen. 

3. Click on the Ancestor tab. 
4. Set the desired options. 
5. Click Preview to view the report on the 

screen before printing, or click Print to 
send the report directly to the printer. 

 

 (Help index: Ancestor reports) 

 

Chronology Report (Deluxe Edition) 
The Chronology Report is produced from the Chronology View screen. (See 
Chronology View on page 18 for more 
information.) This report shows an individual 
and all the surrounding events associated with 
that person. These include the person’s birth, 
christening, death and burial information, his or 
her individual events, marriages and marriage 
events, parents, the birth of children, and the 
individual and marriage notes. All these events 
are arranged on the view in sorted order so you 
can see what affected this person throughout 
his or her life.  
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Options 
You can include and exclude many items in 
this report, including a timeline chart and an 
ages column to further illustrate the life 
events of the individual. These options are 
all selected on the Chronology Display 
Options screen (page 22). 

 

Descendant Book 
A Descendant Book is a book-style report 
that begins with a specific person and moves 
forward through the person’s descendants for 
a given number of generations. Descendant 
Books are available in both Register and 
Modified Register (NGSQ) formats. The 
Modified Register (NGSQ) format describes 
each person in a narrative format and gives 
each person a number. The starting individual is given a number of 1. From then on, each 
person encountered is assigned the next higher number. Children with an upcoming main 
entry are displayed with a “+” to the left of the child number.  The Register format is 
similar to the Modified Register (NGSQ) except that only individuals who have children 
are assigned a number. 

 

  To create a Descendant book: 

1. From the Reports tab of the Ribbon bar, choose  . 
2. Click Descendant Book under the Book Report column. 
3. Choose either Register or Modified Register (NGSQ) format. 
4. Set any other desired options. 
5. Click Preview or Print. 

 (Help index: Descendant book report) 
 

Report Options 
There are five tabs and three buttons that you can use to customize the printout. Each 
tab and button is described below: 
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Options Tab 
Insert Underlines   inserts an underlined space so that missing given or surnames, 
or date or places can be filled in later.  You can also have spaces reserved for death 
information even though the person is marked as living. 

Total Generations   Sets the number of generations to include in the report. A 
three-generation report would include an individual, his parents, and his 
grandparents. 

Table of Contents   generates a table of contents listing the starting page for each 
generation included in the report. You can specify the format of the table, including 
the option to include leader lines (………) between the chapter names and the page 
numbers. 

Include Main Entries For   includes individuals with children but no spouses 
(standard format), individuals with children or spouse(s), or all individuals. You can 
also choose to show the family line back (in parentheses) to the starting ancestor after 
the name of main individuals using either generation numbers or person numbers 
after their names. 

 
Other Report Options 

 
 
Click Index Options, Report Options , and Title Page at the bottom of the Options 
tab to open up additional screens where you can select many more customization 
features. Click Help on these screens to read all about the options available.  

 
Page Layout Tab 

Start New Page After Each Generation   starts each generation on a new page. 

Print Names in Bold   puts each name in bold-face type. 

Paragraph Indents   sets the distance to indent each type of paragraph included in 
the report. 

Custom Report Spacing  choose blank space to be included above the report 
sections. 

 
Heading Layout Tab 

Title for Page 1   prints the title only at the top of the first page of the report.  

Headings   prints the title at the top of all the pages after the first page. 



Creating and Printing Reports 

138 Legacy User Guide 

 

 (See Help for field codes that can be used in Titles and Headings.  Help 
index: Report, Title options) 

Subtitles   specifies the type of generation subtitles printed. These can include the 
generation number (Generation One, Generation Two) or the relationship of the 
generation (Parents, Grandparents), or both (Generation Two, Parents). You can also 
specify the position of the subtitles as being left-justified or centered. 

 

Wording Tabs 
You can specify phrases when creating narrative paragraphs of the report. 
 

Print the Book 
The book can be printed in different ways. See page 131 for the various options. 

  

Descendant Chart 
The Descendant chart includes much of the same 
information for each individual as the Ancestor 
chart but the design of the page is different. In this 
report, the individual is placed at the top of the 
page and each successive generation is indented to 
the right. All members of each family are listed.  
 
  To create a Descendant chart: 

1. From the Family View or Pedigree View, 
highlight the person you wish to begin 
with. 

2. Click the Reports  icon to display the 
Select a Report screen. 

3. Click on the Descendant tab. 
4. Set the desired options. 
5. Click Preview to view the report on the screen before printing, or click Print to 

send the report directly to the printer. 
 

 (Help index: Descendant chart) 
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Descendant Narrative Book 
 
A Descendant Narrative Book is a book-style 
report that begins with a specific person and moves 
down through the person’s descendants for a given 
number of generations. The descendants of each 
new child are exhausted before the next child is 
introduced.  This type of report describes each 
person in a narrative format and may or may not 
give each person a number. 
 
  To create a Descendant Narrative book: 

1. From the Reports tab on the Ribbon bar 

click . 
2. Set the desired options. 
3. Click Preview or Print. 
 

 (Help index: Descendant narrative report) 
 
 The Descendant Narrative Book Options window has five tabs and three buttons that you 
can use to customize the printout. 
 
 Options Tab 

Insert Underlines   inserts an underlined space so that missing given or surnames 
can be filled in later. 

Total Generations   sets the number of generations to include in the report.  A 
three-generation report would include an individual, his parents, and his 
grandparents. 

Table of Contents   generates a table of contents listing the starting page for each 
generation included in the report. You can specify the format of the table, including 
the option to include leader lines (………) between the chapter names and the page 
numbers. 

Numbering System   You can choose between three numbering systems for the 
report: Generation numbers, Henry numbers, or de Villiers numbers – or you can to 
not number the entries. 

Gender for Children   Shows the gender of each child. 
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(See page 137 for descriptions of the Page Layout, Heading Layout, and Wording 
tabs.) 

 (Help index: Descendant, Narrative report) 

 

Family Group Record 
The Family Group Record report provides 
information about a particular family and includes 
excellent detail concerning the parents and their 
children. 
 
  To create a Family Group Record: 

1. Highlight the Husband or Wife on either 
the Family View or Pedigree View. 

2. Choose Family Group from the Report 
tab of the Ribbon bar. 

3. Set the desired options on the screen. 
4. Click the Index Options and Report 

Options buttons to set additional options. 
5. Click Preview to view the report on the 

screen before printing, or click Print to 
send the report directly to the printer. 

 (Help index: Family group records) 
 
There are many options that can be selected when printing a Family Group Record. (See 
Printing the Report on page 131 for more information.)  You can also print blank Family 
Group Records by clicking Blank Report. 

 
Family Tree Picture Report (Deluxe Edition) 
 

The Family Tree Picture Report produces a one- to four-
generation picture pedigree chart superimposed on an optional 
background picture. 
 
  To create a Family Tree Picture Report: 

1. Highlight the person you want to start with on either 
the Family View or Pedigree View. 
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2. Choose Other Reports from the Reports tab of the Ribbon bar and then choose 
Family Picture Tree from the dropdown list. 

3. Set all the desired options from the various tabs on the screen. 
4. Click either Print or Preview to view the report. 

 (Help index: Family Tree Picture Report) 
 

Individual Report 
The Individual tab is used to build a report on all 
items related to the personal information of the 
person. These items include names, dates, event 
information, parents, children, notes, pictures, etc. 
Select the items you want to include in the report.  
 
There are many options that can be set on the 
Individual Report, including two different styles 
(Regular and Summary). You can also print a blank 
Individual Report form by clicking the Blank 
Report button.  
 
  To create an Individual Report: 

1. Highlight the person you want to start with 
on either the Family View or Pedigree View. 

2. Choose Chart Reports from the Reports tab of the Ribbon bar and then choose 
Individual Chart from the dropdown list. 

3. Set all the desired options on the screen. 
4. Click the Index Options and Report Options button to set additional options. 
5. Click either Print or Preview to view the report. 

 

 (Help index: Individual: Reports) 
 

Lineage Report 
The Lineage Report is a very simple report 
showing the father-to-father ancestry line from 
the selected individual along with the siblings. 

 

  To create a Lineage report: 
1. Highlight the person you want to start 

with on either the Family View or 
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Pedigree View. 
2. Choose Chart Reports from the Reports tab of the Ribbon bar and then choose 

Lineage Chart from the dropdown list. 
3. Set the desired options on the screen. 
4. Click the Index Options and Report Options buttons to set additional options. 
5. Click Preview to view the report on the screen before printing, or click Print to 

send the report directly to the printer. 
 

 (Help index: Lineage reports) 
 

Migration Report 
It is interesting to see where the descendants of a particular ancestor spread out to over time. 
These include new towns, new counties, new states or provinces, and new countries. People 
move, striking out for new opportunities or to avoid unpleasant situations. Give Legacy a 
starting person and it will gather all the descendants, see where they were born and produce a 
nice report on the results. 

 
The Migration report is reached by choosing Other Reports > Migration Report from the 
Reports tab on the Ribbon bar. 
 
  To print a Migration Report: 

1. Highlight the person you want to start with on either the Family View or Pedigree 
View. 

2. Choose Other Reports from the Reports tab of the Ribbon bar and then choose 
Migration Report from the dropdown list. 

3. On the Options tab, set the number of generation to look back and other desired 
options. 

4. On the Format tab, set the formats and colors you want. 
5. On the Privacy tab, select any overrides you would like to use. 
6. Click Preview to view the report on the screen before printing, or click Print to send 

the report directly to the printer. 
 

 (Help index: Migration report) 
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Multiple Lines of Descent Book 
 

A Multiple Lines of Descent Book Report is a book-style report that begins with various 
specified people and moves forward through their descendants for a given number of 
generations.  This type of report describes each person in a narrative format and gives 
each person a number.  It is in the same format as the Descendant Book report.  (See 
Descendant Book on page 136.)  The starting individual is given a number of 1.  From 
then on, each person encountered is assigned the next higher number.  The multiple lines 
usually intersect at some point.  These intersections are indicated in the report. 
 
  To create a Multiple Lines of Descent Book Report: 

1. Choose Multiple Lines of Descent Book from the Reports tab of the Ribbon 
bar. The Select Multiple Lines of Descent window is displayed. 

2. Select two or more couples to include in the report by entering their MRIN 
numbers.  (You can use the Marriage List to help select the couples.) 

3. Set all the desired options on the various tabs. 
4. Click the Index Options and Report Options buttons to set additional options. 
5. Click either Print or Preview to view the report. 

 

 (Help index: Multiple Lines of Descent Book) 

 
Origins Report (Deluxe Edition) 

It's nice to know where we came from - where our ancestors were born. Most of us are a 
mixture of nationalities who have joined together and split apart for centuries. Legacy can 
gather all the ancestral birth places in your family file and let you know what percentage 
of each nationality makes up your heritage. 

 
  To create an Origins Report: 

1. Highlight the person you want to start with on either the Family View or 
Pedigree View. 

2. Choose Other Reports from the Reports tab of the Ribbon bar and then choose 
Origins Report from the dropdown list. 

3. Set the options you want to use on the Options, Format, and Privacy tabs. 
4. Click either Print or Preview to view the report. 

 

 (Help index: Origins report) 
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Chronology Comparison Report (Deluxe Edition) 
It is often very difficult to know if two people in your family file are really the same person.  
Legacy includes a great tool to help you make this determination.  The Chronology 
Comparison Report combines the names, surrounding family, and events of two people and 
displays them side-by-side in date order making it much easier to see if they are really the 
same person and should be merged together.  When matching events are lined up next to each 
other with the same date, the backgrounds are colored either green, yellow, or red.  Green 
means the events are the same.  Yellow means that they are close or that there is no matching 
event on both sides.  Red means that the events are incompatible. 

 
The Chronology Comparison screen can be reached from several places in Legacy: 

From the Chronology View:  Click the Options button in the lower-right corner and 
choose Compare Two People.  
From the Reports tab of the ribbon bar, choose Other Reports > Chronology 
Comparison Report. 
From the Merge Information Report screen, select the Chronology Comparison Report 
option before clicking the Print or Preview button.  (Tools > Merge > Find Duplicates 
or Manual Merge. Once you reach a screen suggesting two people may be duplicates, 
click Options then click Print and then choose Chronology Comparison Report before 
clicking Print or Preview on that screen.) 

   
Who Do You Want to Compare? 
When you first come into the Chronology Comparison screen you must select the two people 
to be compared.  If you entered this screen from the Chronology View, the left person will 
already be selected from the current person on that screen.  If entering from the Merge screen, 
both the left and right persons will be selected.  Entering from the Other Reports option will 
require you to select both individuals. 
  
To select a person, click the Select Left Person or Select Right Person button.  This displays 
the Name List where you can choose the desired person.  On the report, the name of each 
selected person is shown in blue (for male individuals) or red (for female individuals).  If you 
see one blue name and one red name you may have made a mistake (either in who you 
selected or in how the genders were set).  The background color for mismatched gender 
names will show as red and the genders will be appended to the names. 

  
Options 
Name Format - Given name(s), Surname or Surname, Given name(s). 
Include RINS - Show the RIN numbers after the names. 
Column Widths - Each side of the report contains four columns, date, event name, place, and 
person name (if applicable).  You can adjust the percentage of the room each column takes by 
using the up and down arrows next to the percentage numbers for each column.  The values 
automatically adjust themselves to equal 100% when all are added together.   



 Creating and Printing Reports 

Legacy User Guide 145 

 

  
Tip:  The report is set to print in landscape mode by default.  This gives the columns more 
room.  If you want to allow for even more room, use the Page Setup option to increase the 
paper size to the widest that your printer allows, even if you don't have that size paper.  This 
lets you see the most in print preview mode.  (If you plan on printing the report you will have 
to set the paper width back to the size you actually have in your printer.  Longer fields will 
automatically wrap to subsequent lines.) 
  
Print Color Legend - Includes a legend at the bottom of the first page explaining what each 
cell background color means. 
  
Display Options 
You can select and deselect the surrounding family and information that is included on the 
comparison report.  See Chronology Display Options for more information concerning these 
options. 
  

Family Tree Bingo (Deluxe Edition) 
All work and no play is a bit boring...  Legacy now includes a fun game that can be played by 
groups small and large.  It is a great activity at a family reunion get-together or on a family 
game night. 
   
To reach the Family Tree Bingo Setup screen, choose Family Tree BINGO from the Other 
Reports button on the Reports tab on the Ribbon bar. 

  
Family Tree Bingo is very similar to the classic bingo game you grew up knowing except that 
in this variation Legacy gathers pictures from your family file and you are trying to match the 
pictures and names to end up with a complete row horizontally, vertically, or diagonally.   
There are several options that you can choose to customize your game cards: 

 
  To create a Family Tree Bingo game: 

1. From the Reports 
tab of the Ribbon 
bar, click on the 
Other Reports 
button and then 
select Family Tree 
BINGO from the 
dropdown menu.  
This displays the 
Bingo Cards 
window: 
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2. On the General tab, the default setting for the game include producing two bingo 
cards and two caller cards which lets two people play two games.  You can 
change these settings to handle any number of people (the number of cards) and 
any number of games to be played (the number of caller cards). 

3. Bingo card normally include pictures of the people on the cards along with their 
names and relationship to the starting person in your family file.  These option 
too can be changed.  (The starting person for relationships can be changed from 
within the report. The Reset button opens the Set Relationships screen. Note that 
if you set relationships to a different person here, they are still set to that person 
when you close the report. You’ll need to go to Tools  > Set Relationships to set 
them back to your normal starting person.) 

4. On the Whose Pictures tab, you can choose which individuals and pictures you 
want to include on the cards.  You might want to select all your direct-line 
ancestors or all the descendants of a past ancestor, or create a custom Focus 
Group of people to include.  It’s up to you. 

5. The Picture Options tab lets you choose which pictures to include from the 
group you selected and what to do when a person doesn’t have a picture.  You 
can also choose where to print the names (under each picture or on a separate 
page) and whether or not to include the lifespan years. 

6. When you have selected all the options you want to use, you can generate the 
bingo and caller cards by clicking the Preview or Print buttons. 

Family Dictionary (Deluxe Edition) 
The Family Dictionary is a list-type report of names sorted by surname, given name.  In 
the case of females, the sorting is done by their maiden names.  Included by default are 
birth and death dates and places and spouses.  If birth or death data is missing, christening 
or burial data is used instead (if available) – this data is placed in curly brackets. The 
report can also include parents of the main people, marriage information, and children's 
information. 

  
To generate the Family Dictionary Report: 

1. Choose Other Reports from the Report tab of the Ribbon bar and then choose 
Family Dictionary from the dropdown list. 

2. Select the desired reports options (described below). 
3. Click either Print or Preview to view the report. 

  
Options 
  

Who to Print - Choose either to include only males, only females, or both males and females 
sorted by their surnames and given names. 
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Fields to Include 
Names of parents - includes the names of the parents, in parentheses, of the main 
individuals. 
Marriage date and place 
List of children - includes the name of each child, and the date and place of their birth 
and death. 
RIN numbers - adds the record identification number for each individual in the report 
after their names. 
LDS Ordinance information - includes the date and temple of any ordinances that have 
been recorded. 
  

Other Options 
Include only individuals who are married - limits the list to only people who are linked 
to a spouse or partner. 
Bold the names - prints the names of the individuals in a bold style so they are easily 
seen. 
Blank line between individuals - Adds a blank line between individuals to that the break 
between people is easier to see. 
Remove leading commas on locations - If any location have leading commas, they will 
be removed. 
  

Report Language 
You can choose from different languages when generating the Family Dictionary report.  To 
select a language, click the Report Language button and choose the language file to be used 
when generating the report.  There are many language files available.  To reset the language 
selection back to the default value, click the Reset button. 
  
Note: All the program-produced titles and subtitles and labels and all the dates will be 
translated but items such as user-enter titles and location won't be translated. 

  
Selecting the Records to Print 
You can print the Family Dictionary report for the males or female in your entire family file, 
or you can filter the report down with the following options by clicking the Record Selection 
button at the bottom of the screen.  The options are: 

  
All Families in the Entire Family File   This option includes every male or female in the 
entire Family File. 
Everyone in the current Search List   This includes only the males or females on the 
current Search List.  
Focus Group Records   Includes males or females from your family file contained in the 
current focus group.  (See Focus Groups for detailed information on how to set up a focus 
group.) 
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All Individuals with a certain Tag Level   You select the tag level and then Legacy prints a 
group sheet for all families that have either the husband or the wife (or both) tag on that level. 
All Individuals with Certain Hashtags   If you have assigned hashtags to groups of people 
in your family file, you can select one or more of them to filter the report to include just those 
who have those hashtags.  See Hashtags for more information on how to use this feature. 

Pedigree Chart 
A Pedigree Chart includes an individual and his or 
her direct ancestors (parents, grandparents, great 
grandparents, etc.). 
 
  To create a Pedigree Chart: 

1. Choose Pedigree Chart on the Reports 
tab of the Ribbon bar. 

2. Set the desired options on the screen. 
3. Click the Index Options and Report 

Options buttons to set additional options. 
4. Click either Print or Preview to view the 

report.  
 

 (Help index: Pedigree charts) 
 
You can also print blank Pedigree Charts by clicking Blank Report. 

 

Source Labels 
 

You can print source labels to place on your source document folders. The labels can include 
the actual source citation along with optional source text and comments.  This can be 
accessed from the Reports Menu > Other Reports tab where particular master sources can 
be printed onto labels.  It can also be accessed from the Assigned Sources screen for a 
particular source citation. 

 
  To print source labels: 

1. Choose Other Reports from the Report tab on the Ribbon bar and then choose 
Source Labels from the dropdown list. 

2. Choose which sources to print. 
3. Select what you want to print on the labels. 
4. Choose borders and pictures. 
5. Select the label type, or choose the specifications for a custom-size label. 
6. Make other adjustments as needed for margins, indentations, and line spacing. 
7. Click the Print or Preview button to print or preview the report. 
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 (Help index: Source Labels) 
 

Statistics Report (Deluxe Edition) 
Your family file contains lots of information. Legacy can gather it all together and show you 
many interesting statistics about your family. These include things like the number of living 
and dead people, how many of your relatives were born in each century, who lived the 
longest, their average lifespan per century, longest and earliest marriages, age at marriage, 
length of marriages, numbers of children, most popular given and surnames by century, most 
popular locations and much more. 

 
  To print the Statistics Report: 

1. Choose Statistics from the Report tab on the Ribbon bar.  After Legacy quickly 
looks through your family file, the Family File Statistics screen appears. 
 

You can now scroll through the list of statistics.  Many of the statistic groups can be displayed 
in a graph by highlighting a line within the group and then clicking the Show Graph button. 
 

 (Help index: Statistics report) 

  

Timeline Report 
The Timeline Report is designed to show an 
overview of dates and people in the family file.  
 
  To create a Timeline report: 

1. Highlight the person you want to start 
with on either the Family View or 
Pedigree View. 

2. Choose Chart Reports from the Reports 
tab of the Ribbon bar and then choose 
Timeline Chart. 

3. Set the desired options on the screen. 
4. Click the Index Options or Report 

Options buttons to set additional options. 
5. Click Preview to view the report on the 

screen before printing, or click Print to 
send the report directly to the printer. 
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 (Help index: Timeline reports) 
 
Note: Dotted lines forming the boxes on the Timeline report are placed around the name 
when there is an estimated birth or death. Legacy estimates the birth or death if one or the 
other date is missing in the individual’s data. The default number of years is 70. The 
number of years printed across the page and the average life span can be changed. If the 
individual’s name is longer than the life box (as determined by the birth date and death 
date), the name is placed to the right or left of the box. 

 

Lots of Other Reports… 
There are many other reports available in Legacy.  Most of these are reached from the 
Reports tab on the Ribbon bar.  For complete information of each of the reports listed 
below, simply choose the Help Index on the Help tab of the Ribbon bar and then type in 
the keywords within the parentheses below.  (If the keywords have a colon separating 
them, it means that the keyword after the colon is a sub-keyword of the first word.) 

 
Address Labels    (Address: Labels) 
Ages Report   (Age report) 
Calendar Creator   (Calendar: Creator) 
Calendar List    (Calendar: List-style) 
Census Forms    (Census Forms: Printing) 
Census List   (Census List) 
Chronology Report  (Chronology: Report) 
Event Report   (Event: Report) 
Family File Information  (Family file: Information) 
File IDs    (File ID Number: Report) 
Individual List Report  (Name: List report) 
Interviews    (Interview Report) 
LDS Ordinances   (LDS: Ordinance reports) 
Locations    (Location: Report) 
Marriage Report   (Marriage: Report) 
Merge Report   (Merge: Options) 
Name Tags    (Name tags) 
Picture List   (Picture: List report) 
Potential Problems   (Potential Problems Report) 
Relationships    (Relationship: Report) 
Relationship Diagram  (Relationship: Diagram) 
Scrapbook    (Picture: Scrapbook options) 
Source Citations   (Sources: Citation report) 
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Surname Summary   (Surname: Summary report) 
To-Do Research Log   (Research Log: Printing) 
Trees Report   (Print: Tree list) 
USA County Verification  (USA County: Verification) 
Wall Charts    (Wall charts) 
 

Legacy Publishing Center (Deluxe Edition) 
You can create 
professional-looking 
books by assembling the 
various reports and charts 
available in Legacy into 
one single document.  
This can include ancestor 
and descendant book 
reports, pedigree charts, 
family group records, 
picture scrapbooks and 
much more.  You can also 
add a table of contents, 
other introductory sections 
and an overall index and 
list of source citations.   

 
When you create a book, 
you select from the various items available and effectively add chapters to your new book 
arranged in the order of your choice. 

 
 

Getting Started 
 

  To create a new book: 

1. Choose Publishing Center from the Reports tab of the Ribbon bar. 
2. Click the Start a New Book button. 
3. Enter a name for the new book.  Select the file name and path to save the book files.  
4. Select the various items to include in the book on the Contents tab.   
5. Choose other sections to include in the book like Title Page, Copyright, Dedication, 

Preface, Abbreviations, Introduction, Source citation and Index options from the 
Additional tab. 

6. Set any other options you want to use. 
7. Set the Privacy options. 
8. Click Preview to generate and view the book. 
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 (Help index: Publishing Center) 
 

Blank Forms, Questionnaires, and Research Logs 
Forms Center 

 
The Forms Center is the central repository for the many blank forms that are available in 
Legacy.  These include a multitude of census forms, relationship diagrams, research 
forms, and more.  As new forms are added, they will automatically be added to the Forms 
Center as you download new updates of Legacy.  Many forms are available in several 
different languages. 

The Forms Center is reached by clicking the Forms Center button  on the Reports 
tab of the Ribbon bar. 

 

 (Help index: Forms center) 
 

Questionnaires 
The Questionnaire is used when you want to get information about your family from 
another person. It is easy for another family member to simply fill in the blanks with 
what they know. You can customize the questionnaire to include specific information 
you want and how many children to prompt for. 

 

  To print a questionnaire: 
1. From the Reports tab of the Ribbon bar, choose the Questionnaire button. 

  
2. Set the options and fonts you want. 
3. Fill in the Opening and Closing paragraphs. 
4. Click Preview or Print. 

 For complete information about Questionnaires, see the Legacy Help system 
and search the index for: Questionnaire 
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Research Log Blanks 
A Research Log is simply a form where you can organize your research efforts. Use 
it to keep track of things you want to do when you go to different places in the future. 
You can track where things were found and where you want to look in the future.  
 
Note: Legacy also has a powerful To-Do List that you can use to record and keep 
track of all the research tasks you want to do as you gather more information about 
your ancestors. See To-Do List on page 119 for more information. 

 

  To print one or more blank research logs: 
1. From the Reports tab of the Ribbon bar, choose the Research Log button. 

 
2. Click Preview or Print. 

 

 (Help index: Blank research logs) 
 

Relationship Report 
Legacy can show you how people are related to each other. The relationships are figured 
for the blood relatives of a source person. The spouses of aunts, uncles and cousins are 
also shown although they are not actually related. Once you initially build the 
relationships, Legacy tries to update new additions as you go. Before you can print a 
Relationships report, you must first make sure that the Relationships have been set: 

 

  To calculate relationships to a specific individual: 
1. From the Family View, make sure the individual you want to be the source 

person is in either the Husband or Wife box. From the Pedigree View, highlight 
the desired person. 

2. From the Tools tab on the Ribbon bar, choose Set Relationships. 

  The Set Relationships window appears. Make sure the 
correct individual is shown as the Source. 

3. Click the Set Relationships button. Legacy calculates the relationship of all 
blood relatives to the Source person (and a bit further to in-laws and spouses). 
The relationship is shown above the Husband and Wife boxes on the Family View 
and at the middle right of the Pedigree View. 

(If you import individuals, or link to a family line, you will have to rebuild the 
relationships in order for them to all be updated.) 
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  To print a Relationship report: 
1. From the Reports tab on the Ribbon bar, choose Other Reports and then 

choose Relationship Report from the dropdown list. 
2. Check the settings. 
3. Click Preview or Print. 
 

 (Help index: Report printing options) 

 (Help index: Relationship Report) 
 

Potential Problems Report 
To create a Potential Problems Report, Legacy runs through your family file and checks 
the information it contains for some common and sometimes unnoticed discrepancies. 
Some of the 
possible problems 
it finds may not 
be problems at all 
but they are not 
normally seen. If 
you are sure that a 
particular 
situation is 
correct, you can 
mark the record, 
telling Legacy to 
not report on it in 
the future. 
 
Note: Legacy also 
checks for 
common 
problems while you are entering and edit information on the Individual and Marriage 
Information screens. When a problem is found, a  icon is displayed next to it. If you 
hover your mouse over the icon, a popup box shows you what is wrong. These problem 
icons are also shown next to the names displayed on the Family and Pedigree Views on 
the main screen.  
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   To print a Potential Problems report: 
1. From the Reports tab on the Ribbon bar, choose Other Reports and then 

choose Potential Problems from the dropdown list. 
2. Check the settings on the Records, Warnings, Problems, Standardization, and 

LDS tabs. 
3. Click Preview or Print. 
 

 (Help index: Potential problems) 
 

Records to Check 
Specifies which records you want Legacy to check. See the online Help for more 
information on each option. 
 

Warnings 
These are situations that are probably problems with your dates, but in a few cases, 
may not be.  For example, having a birth records before the parents were 13 years of 
age, or recording a death after the age of 120 years of age.  Many of the warnings that 
Legacy checks for have a day or year range associated with them. You can change 

these settings by using the Up and Down  arrows to change the associated value. 
 

Problems 
Checks for situations that are wrong, like recording a birth that is after the person’s 
death date, or a burial that is before a death.  Checking invalid dates is also done in 
this section. 

 
Standardization 

These are checks to ensure that you are not entering your information in non-standard 
ways.  These include illegal characters in names, incorrectly formatted names, and 
other incorrect entries. 

  
Gaps  

These are checks for unusually short or long periods of time between certain events, 
like the time between the birth of subsequent children or the time between the 
marriage date and the birth of the first child.  Note: There are options you can set so 
that gaps for living people, or after a certain year, are not reported as problems. 
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LDS  
If you are keeping track of LDS information, these checks verify temple operational 
dates, and ordinance completion order. 

 
Creating the List 

When you have set all the options, click either Preview to see an on-screen view of 
the report before it is actually printed, or Print to have the report sent directly to the 
printer. 

Print the Report 
When you have set all the options, click either Preview to see an on-screen view of 
the report before it is actually printed, or Print to have the report sent directly to the 
printer. 
 

 (Help index: Problems report) 
 

Creating a Problems List (Deluxe Edition) 
Instead of printing the Potential Problems report, you can also create an interactive 
list of the problems found.  This is done by clicking the Create Problems List button 
which displays the Potential Problems List.   
 
This list shows the 
names and 
abbreviated 
descriptions for all 
of the problems 
found in the last 
problems search.  
As each 
name/problem is 
highlighted, the 
full problem 
description and 
suggested action is 
shown under the 
list at the bottom 
of the window.  
The list is 
interactive in that you can edit the individuals and marriages right from the list to 
correct the problems or exclude them from future checking. 
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If a problem involves individual information for a person and you would like to edit 
that information, highlight the person’s name and problem in the list and then click 
the Edit Individual button.  The person’s Individual Information screen appears 
where you can make changes.  If the problem has to do with marriage information, 
click the Edit Marriage button to display the Marriage Information screen. 
 
If you find that a reported problem is not really a problem, you can mark it as "Not a 
Problem" and have it excluded from lists generated in the future.  Make sure the 
desire problem is highlighted in the list and then click Mark as Not a Problem.  The 
marked and removed from the list. 
 

Printing a Report  
Three report formats are available when printing the problems list: 
 
Detailed – Includes the name, description, dates, and suggested action for each 

problem. 
Abbreviated – Includes only the name and description (on two lines) for each 

problem. 
Summary – Includes only the name and short description (on one line) for each 

problem. 
 
After you have select the desired report format, click either the Preview button to see 
an on-screen view of the report before it is actually printed, or click Print to have the 
report sent directly to the printer.  (See Printing the Report on page 131 for more 
output options.)  
 

Formatting Options  
You can customize the look of the report by setting the format options.  Click Page 
Setup... to change the margins, page orientation, line spacing and print size.  (See 
Page Setup for more information.)   Click Change Fonts to select the font size and 
style for the report.   
 

Saving the List 
The Potential Problems List is kept from session to session so that it doesn’t have to 
be generated each time you want to view it.  To display the list, click the View 
Existing Problems List button on the previous Potential Problems Report screen.  
 

Creating a New List 
If you want to create a new problems list, either for a different set of individuals or 
with different options selected, click the Create Problems List button on the 
previous Potential Problems Report screen.  Any previous list is erased and the new 
list takes its place. 
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LDS Ordinance Report 

The LDS Ordinance reports show each selected individual along with each individual’s 
ordinance information. This includes the individual ordinances of baptism and 
endowments, as well as all sealing information for spouses, children, and parents. 
 
  To print an LDS Ordinances report: 

1. From the Reports tab on the Ribbon bar, choose the Other Reports button and 
then choose LDS Ordinance from the dropdown list 

2. Select the Records to Include. 
3. Set any other desired options. 
4. Click Preview or Print. 

 (Help index: LDS ordinance reports) 
 

Calendar Creator (Deluxe Edition) 
Create your own calendars, complete with 
pictures, birthdays, and anniversaries.  There 
are options to include a cover picture (front 
and back), picture pages above each calendar 
month, and complete control over color, 
layout, shadows, fonts, page size, etc.  Create 
complete yearly calendars suitable for gifts.  
The calendars can be blank or include the 
birthdates and anniversaries of your family 
file members. 

 
  To print a Calendar report: 

1. From the Reports tab of the Ribbon 
bar, choose Other Reports and then 
choose Calendar Creator from the 
dropdown list. 

2. Select the records you wish to 
include. 

3. Set any other desired options. 
4. Choose the year to print. 
5. Choose the months to print. 
6. Select the type of calendar to print, 

and which fields to include. 
7. Click Preview or Print. 
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 (Help index: Calendar Creator) 

Calendar List 
A Calendar List report can be 
printed to show selected birth 
dates and anniversaries. 
 
  To print a Calendar List 
report: 

1. From the Reports 
tab of the Ribbon 
bar, choose Other 
Reports and then 
choose Calendar 
List from the 
dropdown list. 

2. Select the records 
you wish to include. 

3. Set any other 
desired options. 

4. Choose the year to print. 
5. Choose the months to print. 
6. Select the type of calendar to print, and which fields to include. 
7. Click Preview or Print. 

 

 (Help index: Calendar List report options) 

 

Interview Report (Deluxe 
Edition) 
 
The Interview Report contains over 1200 
questions in thirteen different categories 
that can be used when you interview a 
family remember.  They are great at jogging 
the memory of the person being interviewed 
and elicit more in-depth responses. 
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  To print an Interview report: 
 

1. From the Reports tab of the Ribbon bar, choose Other Reports and then choose 
Interview Questions from the dropdown list. 

2. Select the Type of interview you want to do. 
3. Select the Topics you want to cover. 
4. Select the Questions you want to ask. 
5. Design the Cover Page. 
6. Check over the Permission page. 
7. Set any other desired options. 
8. Click Preview or Print. 

 

Surname Summary Report 
A Surname Summary report summarizes all the surnames in the current family file, 
showing how many times each name is used and what date range it spans. 
  To print a Surname Summary report: 

1. From the Reports tab of the Ribbon bar, choose Other Reports and then choose 
Surname Summary from the dropdown list. 

2. Set the Soundex Code option if desired. 
3. Click Preview or Print. 

 (Help index: Report printing options) 
 

Source Citation Report 
The Source Citation report displays each master source, followed optionally by the 
individuals who have cited them. The specific events that use each source can also be 
included in this report, along with the citation detail, surety level, and source quality 
analysis. You can print all master sources or just those that are tagged or untagged. 
 
  To print a Source Citation report: 

1. From the Reports tab of the Ribbon bar, choose Other Reports and then choose 
Source Citation from the dropdown list. 

2. Choose which sources to include. 
3. Set any desired options. 
4. Click Preview or Print. 
 

 (Help index: Source citation report) 
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Age Report 
The Ages report shows how old 
individuals are at certain events in 
their lives. The display shows three 
columns: Date, Day of Week, and 
Age. The Date column shows the 
date of the event, the Day of Week 
column shows what day of the week 
the event occurred, and the Age 
column shows how old the person 
was when the event occurred. The 
Marriage box at the bottom shows 
how long the couple was married. 
The earthly marriage is considered 
at an end when either of the persons 
has died, or on the date entered in 
the Marriage Status Date, if any. This is usually due to either a divorce or annulment. 
 
  To view the Ages window: 

From the View tab of the Ribbon 

bar, choose Ages.  
 

  To print the Ages report: 
1.  Click Print Report at the 

bottom of the Ages window. 
2. Set any desired options. 
3. Click either Preview or Print. 
 

 (Help index: Ages) 
 

Address Labels 
 
You can print address labels in Legacy. The 
mailing labels are handy for holiday mailings and 
research contacts at archives and libraries. 
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  To print address labels: 
1. From the Reports tab of the Ribbon bar, choose Other Reports and then choose 

Address Labels from the dropdown menu. 
2. Choose which records to print. 
3. Choose which fields to print on the labels. 
4. Select borders and pictures, if desired. 
5. Select a label type, or set the specifications for a custom-size label. 
6. Make other adjustments as needed for margins, indentations, and line spacing. 
7. Click Print or Preview. 
 

 (Help index: Name tags and address labels) 

 
Name Tags 
 

You can print name tags in Legacy for family 
reunions and clan gatherings. The labels can 
include the name of the event, a picture of 
each individual (or a common picture), the 
date, and the guest’s name with a miniature 
pedigree chart to help others see how they 
are related. 

 
  To print name tags: 

1. From the Reports tab of the Ribbon 
bar, choose Other Reports and then 
choose Name Tags from the 
dropdown list. 

2. Choose which records to print. 
3. Select which fields you want to print 

on the tags. 
4. Select borders and pictures, if desired. 
5. Select a name tag type, or choose the specifications for a custom-size name tag. 
6. Make other adjustments as needed for margins, indentations, and line spacing. 
7. Click Print or Preview. 
 

 (Help index: Name tags and address labels) 
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To-Do Report 

  To view the To-Do Report 
window: 
1. From the View tab of the 

Ribbon bar, choose To-Do 
List. This displays the To-Do 
List window. 

2. Choose whose To-Do list to 
print. 

3. Click Print. The Print To-
Do List Report Options 
window appears. 

4. On the Record Selection tab, 
choose the type of To-Do 
items you want to print. 

5. On the What to Include tab, 
choose the pieces of information you want to include on the report. 

6. On the Filter Options tab, choose the types of To-Do items you want to limit the 
report to. 

7. On the Sort Order tab, choose how you would like the report arranged. 
8. To print the report, click Preview or Print. 

 
The To-Do Report can also be reached from the Ribbon bar.  From the Reports tab, 
choose Other Reports and then choose To-Do Report from the dropdown list. 

 

 (Help index: Print To-Do list) 
 

Event Report (Deluxe Edition) 
  To Print the Events Report: 

1. From the Reports tab of the Ribbon bar, choose Other Reports and then choose 
Event Report from the dropdown list. 

2. On the Include tab, choose who and what you want to print.  
3. On the Options tab, select from the various formatting styles. 
4. On the Filter tab, choose any options you want in order to narrow down the 

events printed.  
5. To print the report, click Preview or Print. 

 

 (Help index: Event report) 
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File IDs Report 
There are four types of records in Legacy that accept a File ID#.  These are Master 
Sources, Source Citation Details, To-Do items, and Multimedia items (picture, sound, 
and video files).  You can use these fields to create a filing system linking your family 
file records with printed source documentation, printed pictures, and other physical items 
that you want to store for the future. 
 
The File ID Number Report lists all the numbers that you have in your family file and 
shows where they were used.  
 
  To generate the File ID Number Report: 

1. From the Reports tab of the Ribbon bar, choose Other Reports and then choose 
File ID from the dropdown list. 

2. Select the desired reports options (described below). 
3. Click either Print or Preview to view the report. 

 

 (Help index: File ID Number Report) 
 

Location Report 
The Location report displays each master location, followed by the individuals and 
marriages that use them.   
 
  To print the Location Report:  

1. From the Reports tab of the Ribbon bar, choose Other Reports and then choose 
Location Report from the dropdown list. 

2. Select locations to print and who uses them from the Include tab 
3. Check the pieces of information to be added to the report on the Options tab. 
4. Click either Print or Preview to view the report. 

 
 



Chapter 8 

Wall Charts 
Full-Color Masterpieces that you can be proud of 

 
Legacy Charting Overview 
 
You have spent many long hours collecting and entering your family history.  A feat that few 
other people even attempt, let alone accomplish in their lifetimes.  Now you can experience the 
enjoyment of showing off your family tree by producing stunning full-color wall charts.  Use 
them for your next family reunion or for a deserving wall in your home.  Wall charts make great 
gifts for any holiday, birthday, or anniversary.  They also make your own continuing genealogy 
research easier by having a large, easily readable working chart nearby to refer to. 
 
Wall charts tell a story that can be seen at a glance.  They are a graphical representation of your 
family that can extend forward or backward for many generations.  Large charts are often a 
gathering place for conversations that bond your family together.  They become family heirlooms 
of great importance that will be passed on into the future.  So, show off all your hard work – print 
some wall charts! 

 
Starting the Wall Chart  

 
The easiest way to start a Wall Chart is to open Charting from within Legacy. 
1. In Legacy open the file you want to use to make a Chart 
2. Navigate to the starting person for your Chart. 
3. On the Report Ribbon Tab choose Legacy Charting 
4. Choose the type of Chart you want to create. (Step 2 of 3 after an incredibly long Step 1) then 

skip step 3 of 3 as it also has been done before clicking Legacy Charting. 
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5. Edit the chart. 
You can also start Legacy Charting from outside the Legacy program.  When Legacy is 

installed, a shortcut  is placed on your Desktop to make it easy to start the program.  
Simply double-click the Charting icon to open the program.  You can also click on the 
Start button on your desktop and then choose Legacy Charting from the menu to start 
the program. 

  
When you first start Legacy Charting, the Welcome to Legacy Charting window appears 
where you can open an existing chart or start a new one. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
Opening a Saved Chart 

If you have previously saved some chart files, a list of up to the last ten charts are 
displayed on the right side of the Welcome screen.  To open one, click on the 
name of the file.  Legacy Charting opens the chart file and displays it on the 
screen. 

   
 Starting a New Chart 

To start a new chart, click the Create New Chart button.  This starts the Chart 
Creation Wizard.   
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Chart Creation Wizard 
 

The Chart Creation Wizard consists of two or three easy steps: If you are starting 
Charting by using the desktop icon (as opposed to starting it from within Legacy), the 
first step is to select the family file or GEDCOM file from which you want to create the 
chart.  Second, (or first if you have started from within Legacy), choose the type of chart 
you want to create. And third, choose the individual from that file to start the chart from.  

 
Step 1 of 3: Select a genealogy file to chart 
  

 
 

 
You can either have Legacy Charting scan your entire computer to find files to load, or 
you can browse for them yourself.   

  
 Scanning Your Computer 

Legacy Charting can create charts from several different types of files.  These include 
Legacy Family Tree, Personal Ancestral File, Family Tree Maker, RootsMagic and 
GEDCOM files.  To begin, click Scan Computer for New Files.  The scanning process 
can take several minutes to search your entire computer.  The time involved depends on 
the speed of your computer, the size of your hard drives, and how many qualifying files 
are found.  When the process is complete, a list of the files found is displayed in the grid.  
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While scanning, Legacy Charting collects all the file names for all the supported file 
types.  When the resulting list is displayed, the file types shown depend on the filtering 
options you have selected.  Please see Filtering the List below to see how this works. 

   
The file list includes the name of the file, the path where it is located on your computer, 
how many individuals are contained in the file, and the date the file was last accessed. 

   
The list of files is retained even when you quit Legacy Charting.  When you start again, 
the list is still there.  If you create additional family files or receive new GEDCOM files, 
you can have them added to the list by clicking Scan Computer for New Files again. 

   
 Sorting the List 

You can sort the file list by any of the four columns by clicking on the desired column 
heading.  The first time you click the column, the list is sorted in ascending order as 
indicated by a small up-pointing triangle next to the column name.  If you click the 
column heading a second time, the sort order is changed to descending, as shown by a 
down-pointing triangle. 

   
 Filtering the List 

Use the checkbox options in the Genealogy File Types box to include specific types of 
chartable files in the file list.  To just display Legacy files, select the Legacy option and 
clear the rest.  To include Legacy and GEDCOM files, put checkmarks in both options.  
To show all possible files, select all the types. 

   
In the upper-right corner of the window there are two indicators.  The top line shows how 
many files are currently being shown in the list (with the current filters) and the lower 
line shows how many files Legacy Charting found when it did its last scan.  As you 
change filter options you can quickly see how many files are in the list. 

   
There is another filter that can be used to narrow the list down further and help you to 
find specific file names.  You can type characters into the Filter for file name text box to 
limit the list to file names containing those characters.  There are two options below the 
text box, Starts With and Include Path in Filter.  If neither of these options is selected, 
the file names included in the list will have the filter characters located anywhere within 
the names of the files.  For example, if you enter "er" then files with names like Ernhart, 
Rymer, and Fern are included.  If you select the Starts With box, only Ernhart is 
displayed.  Selecting the Include Path in Filter option expands the search to include the 
Path column as well as the Name column. 

   
 Update File List    

When Legacy Charting scans your computer for chartable files, it looks at each file to see 
how many individuals it contains.  If you later add new individuals, or delete some, you 
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can have Legacy Charting recheck the files in the list to update the numbers by clicking 
the Update File List button. 

   
 Clearing the List 

If you would like to clear the file list, click Clear List. 
  
 Selecting a File to Chart  

To select one of the files in the list to chart, click on the name to highlight the line and 
then click the Next button.  You can also double-click the file to choose it and 
automatically move to the next step. 

     
 Browsing for a File Yourself  

If you don't want to use the scanning feature of Legacy Charting, or if you don't want to 
wait for a new scan to pick up a new file (on a flash drive for example), you can find the 
file manually by clicking Browse for File.  This opens a standard Open dialog box 
where you can select the drive, folder, and file you want to chart.  When you select a file 
in this manner, you are then taken to step two. 

   
Step 2 of 3: Select the type 
of chart to create 
   

Legacy Charting offers 
several different styles 
of charts to choose 
from.  These include 
Ancestor, Descendant, 
DNA, Fan, Hour Glass, 
and Bow Tie charts.  
Many of these charts 
have variations in 
spacing and layout 
giving you 30 distinct 
charts.   

  
 

 
To select a chart type, 
click on the desired format and then click the Select button.  You can also just double-
click on a chart button to select it. 

  
After selecting a chart, Legacy Charting generates the chart, starting with the person you 
selected and automatically selecting 5 generations.  From here you can change many 
aspects of the chart, including size, color, spacing, content, and much more.   
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Step 3 of 3: Select an individual 

The third step of the 
Chart Creation Wizard 
is to select the starting 
individual for the chart.  
A list of all the 
individuals in the file is 
displayed. 
 

 
 

 What is Shown 
The name list shows 
the record 
identification number 
(RIN), the name, and 
the gender of each 
individual in the file.  
To the right, on the 
Detail tab, dates and 
location are displayed for the individual along with the names of the parents and spouse.  
Below this information is a three-generation pedigree chart that begins with the current 
person and includes his or her parents and grandparents (if they are in the file). 

   
 Navigating the Pedigree Chart 

The pedigree chart can be navigated up and down.  Clicking on any name moves that 
person to the starting position in the middle.   You can navigate down by clicking the left-
arrow to the left of the starting person.  The first child of that person is displayed.  You 
can also move to the right (to older generations) by clicking the right-arrows to the right 
of the four grandparents. 

  
 Sorting the Name List 

The name list can be sorted into RIN, Given Name, or Surname ascending order by 
clicking the #, Given, and Surname buttons at the top. 

   
 Searching for a Name 

You can search for a name in the list by entering a RIN, Given Name, or Surname into 
the appropriate text box at the top.  As you type, the highlight in the list jumps to the 
nearest matching name. 

  
 Selecting the Starting Individual 
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To select a person as the starting individual for the chart, click on the desired name to 
highlight it, and then click Next to move to the final step.  You can also double-click on 
the name to select it and automatically move to the last step. 

  

The Legacy Charting Screen 
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The main charting screen displays the chart you are working on.  It is shown in the central portion 
of the window.  Besides showing the current chart, the Legacy Charting screen offers many tools, 
options and commands that you can use to change and enhance the chart you are creating.  You 
can change the starting person of your chart as well as the chart type.  Charting has built-in 
themes that you can use to quickly change the look and feel of your chart.  Many pre-defined 
color schemes are also available along with various borders and shadow effects.  Pictures can be 
placed within the individual boxes as well as on the background of the chart.  You can print your 
chart on your own printer or export a file that can be printed on a large-format plotter to create 
professional wall charts.  
 
The Charting Ribbon 

 
The Charting Ribbon is designed to help you quickly find the commands that you need to 
complete a task. Commands are organized in logical groups, which are collected together 
under tabs. Each tab relates to a type of activity, such as chart appearance or publishing. 
To reduce clutter, some tabs are shown only when needed.  For example, the Picture 
Settings tab is only displayed when you have a picture selected.   

   
 How it Works 
  Quick Overview 

Clicking on a tab heading (Home, Appearance, Insert, Publish, or Help & 
Options) displays the gallery of options for that tab.  To select an option, click on 
it.  Most options then display a dialog box where you can choose what you want.  
For example, a color, a box item, the box sizes, the title of the chart, and many 
more. 
 
Always keep the Ribbon minimized 
To minimize the Ribbon, right-click on any option on it and then choose 
Minimize the Ribbon.   
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The Ribbon will remain minimized with only the tabs showing.  When you click 
on a tab, the Ribbon opens and shows the options associated with that tab.  After 
selecting an option, the Ribbon closes again, only showing the tabs headings.  
Another way to quickly minimize the Ribbon is to double-click the name of any 
of the tabs.  

    
  Restore the Ribbon 

Click Customize Quick Access Toolbar  and then click Minimize the 
Ribbon in the list.  Or, double-click a tab again to restore the Ribbon. 

    
Other Toolbars and Buttons 

 

 The File Button  
The File Button provides access to all of the document and system-level functionality in 
the program. These include starting a new chart, opening an existing chart, saving and 
printing charts, and exiting the program. The File Button is located in the upper-left 
corner of the window. 

   

 Quick Access Toolbar  
The Quick Access Toolbar, located to the right of the File Button, is another 
place where you can access the options of the File Button.  See The Quick 
Access Toolbar on page 192. 

   
 Side Toolbar 

The toolbar on the left side of the screen controls the mouse’s actions on the 
chart.  See The Side Toolbar on page 193. 

   
 Status Bar 
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The Home Tab of the Ribbon 

 
Home Tab 
The Home tab is part of the main Ribbon of Legacy Charting.  (See The Ribbon for more 
information on how to use this main toolbar.) 
 

File 
Starting a New Chart 
Click New Chart to create a new chart.  This starts the three-step 
Chart Creation Wizard taking you through the process of selecting a 
file, starting individual, and chart type.  If you have been working on 
a chart, you are prompted to save it before the new chart is created.   
(See Chart Creation Wizard for complete instructions on using the 
wizard.) 
 

Current Person 
 

Selecting the Starting Person 
 
If you want to change the starting person of your 
chart, click Select Individual in the Current 
Person section.  This is the button on the left side 

of the section with the  icon.  This opens the 
Chart Creation Wizard where you can change to any person in the family file you are 
working with.  When you return, the chart is redrawn with the new starting person.  
Note that if you have customized the chart by moving boxes around and resizing 
them, the new chart will revert to the default layout.  Any color changes that you 
have made will remain in effect. 
 
Changing the Starting Person by Navigating 
You can change the starting person of your chart to the father, mother, spouse, or 
child of the current starting person by clicking on Father, Mother, or Marriage.  
Clicking Marriage displays the spouses and children of the current person where you 
can select who you would like to change to. 
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Changing the Chart Type 
The current chart type is shown above the Chart Type label.  To 
select a different type, click the current chart type button.  You can 
choose from the eighteen chart types available.  When you choose a 
new type, the chart is redrawn. 
 

Changing the Generations 
When first displayed, your chart is built out to five generations.  If 
you want more or fewer generations, you can change the setting 
by using the up and down arrows or by typing the desired number 
of generations and pressing Enter. 

  
Privacy 

Suppress private individuals 
Selecting this option removes any person who is marked as 
Private from the chart.  Any line of people extending from the 
Private person is also removed. 

Suppress invisible individuals 
Anyone who is marked as invisible will be excluded from the 
chart as if the person did not exist.  Thus any ancestor or descendant lines that 
would have continued from this person are also excluded. 

Suppress private information [[Private]] 
Any information that is marked as Private, using the [[ and ]] markers, is 
removed from the boxes. 

Suppress details for living people 
If a person is marked as being alive, only their name is shown in the box.  If you 
would like to have the name changed to “Living,” select the Use “Living” 
instead of their name option. 

 
The Appearance Tab of the Ribbon 

 
The Appearance tab is part of the main Ribbon of Legacy Charting.  (See The Ribbon for 
more information on how to use this main toolbar.) 
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Themes 
Themes 
Legacy Charting has many pre-defined themes that you can use to format your chart.  
A theme includes a coordinated combination of fonts, colors, and borders to achieve 
a certain look.  You can load a theme, alter it to your liking and then save it as a new 
theme.  Themes include box colors, box gradients, box spacing, line colors, box 
content, borders, and fonts.  Box sizes, generation settings, rearrangement of boxes or 
generations, and starting individuals are not included in a theme.  
 
Because of the different layouts of each kind of chart, themes are specific to each 
chart type.  A theme from one type of chart cannot be applied to a different chart 
type. 
 

To select a theme, click the 
Themes option to open the Chart 
Themes box.  You can select any 
existing theme by either clicking 
on the theme name to highlight it 

and then clicking on Apply Theme to Chart 
in the Actions section below the theme list, or 
by double-clicking the theme name.  When 
you select a new theme, the chart is 
immediately redrawn with the new options. 
 

Actions 
Apply Theme to Chart – Applies the 
currently selected theme to the current 
chart. 
Create New Theme – Prompts you for a 
theme name and then creates a new theme 
with the current chart layout and settings. 
Edit Theme Name – Prompts you for a new name for the currently selected 
theme. 
Save to Theme [theme name] – Saves all the currently settings to the current 
theme.  This is how you change the setting for a theme in the list – Select the 
theme, make any desired changes, and then Save the theme again. 
Delete Theme [theme name] – Deletes the current theme (after prompting for 
confirmation). 

 
Colors 
Legacy Charting has many pre-defined color themes you can choose from while 
formatting your chart.  These include themes for coloring by generation, ancestral 
line, and by gender.   
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To select a color theme, click the Color option to open the Color Themes box.  Click 
the type of color formatting you want to use – either By Generation, 4 Colors, DNA 
X Chromosome, or Gender.  Click the specific color theme you want to use and 
then click Apply Color Theme to Chart in the Actions section.  (You can also just 
double-click the desired color theme.)  The selected theme is then instantly applied to 
your chart. 
 

Actions 
Apply Color Theme to 
Chart – Applies the 
currently selected color 
theme to your chart. 
Edit Color Theme Name – Prompts 
for a new name for the currently 
selected color theme. 
Save to Color Theme [theme 
name] – Saves all the current color 
settings to the current color theme.  
This is how you change the colors 
for a theme in the list – Select the 
theme, make any desired changes, 
and then Save the theme again. 
Delete Color Theme – Deletes the 
current theme (after prompting for 
confirmation). 
 
 
 
 
Gradient Fill 
You can change the solid colors to 
gradient filled colors by selecting the 
Use Gradient Fill option.  This fills 
the boxes with the color fading from 
left to right. 
 

Box Items 
The default information to be included in a chart box is the name, birth date 
and place, marriage date and place, and death date and place.  In addition to 
these fields, you can also include the christening and burial information as 
well as the lifespan of the individuals. 
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Adding an Item 
To include a new item of information in the chart boxes, highlight the desired 

item in the Available Items list and then click the  button to copy it to the 
Items to Display list.  
 
Deleting An Item 

To remove an item, highlight it and then click the  button.  You can also 

delete all the items at once by clicking the  button. 
 
Moving an Item in the List 
You can move an item up or down in the list to rearrange the order of the items in 
the chart boxes.  To do this, highlight the item you want to move and then use the 

up  and down  arrows to move it. 
 
Formatting the Items 
Each item that you include in boxes can be customized using the Item Options to 
the right of the Items to Display list.  Names can be formatted in several different 
orders; birth, christening, death, and burial information can exclude the locations; 
items can be preceded by labels; and the fonts and font sizes can be changed. 
 
Settings 
Each item can be placed in one of three columns within a box.  If everything is 
placed within one column, that column will expand to occupy the entire width of 
the box.  If items are placed in the left column and right column with nothing in 
the center column, the two used columns will expand to each occupy half of the 
width of the box.  If items are placed in the left and middle columns, the middle 
column will expand to occupy two-thirds of the box.  And finally, if only the 
middle and right columns have items, the middle column will expand to take up 
the left two-thirds. 
 
Duplicate Options 
Allows you to select the font attributes for duplicate line boxes. 
 
 

  



 Wall Charts 

Legacy User Guide 179 

 

Borders 
 
 
 
 
 
Page Borders 
 
Select from five chart borders by clicking on the desired style.  
(If you don’t want a border, select the No page border 
checkbox.)  The borders are fancy lines that encircle the entire 
chart.  The borders can either be out at the page edges (select 
the Align to the page checkbox) or held in close to the actual 
chart itself.  When held close to the chart, you can choose the 
margin distance.  You can also select the line color of the 
border by clicking the color box below Line Color. 
 
 
 
 
 
Box Borders 
 
The lines surrounding each person’s box can be selected from 
the four available styles (or turned off).  You can select 
different box styles for males, females, and people of 
unknown gender.  Box shadows can be added. 
 
 
 
 
 
 
 
 
 
 

Lines 
The width and color of the lines that connect the boxes 
together can be changed. 
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Sizing 
 
 
Box Width 
You can change the width of all the boxes by dragging the slider 
control to the left or right.  This changes all the boxes on the chart.  
Boxes can be sized from 1/2 of an inch up to six inches wide which is 
desirable when creating large wall charts. 
 
Sibling Spacing 
If you are creating a descendant chart, you can 
adjust the spacing between adjacent siblings. 
  
Generation Width 
The horizontal spacing between the generation 
columns can be increased or decreased, varying 
from 1/8 of an inch up to six inches. 
 
Box Spacing 
The vertical spacing between the boxes can be increased or decreased from 1/16 of 
an inch up to six inches. 

 
Background 
You can select a solid-color to fill the background of the chart or any image can be used.  
When using an image, you can adjust the transparency to fade the picture lighter. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
When adding an image to the background, you have several options as to its placement: 
 
Tile – The image is repeated at its full size until the entire background if filled.  This best 
used with a background image that was meant to fit together as a continuous pattern. 
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Center with no stretching – The picture is placed at its full image size once in the 
middle on the chart. 
 
Center and stretch – The picture is enlarged proportionally until it is either the same 
width or same height as the chart. 
 
Stretch to Frame – The picture is stretched both ways until it fills the entire chart 
background area.  This option is used the most when placing a background image.  You 
should take into account the shape of the picture so that you don’t place a tall, narrow 
picture on a short, wide chart, as the stretching effect will be very noticeable.  In most 
cased, however, the stretching is visually acceptable. 
 
Picture Resolution 
Keep in mind that pictures used on a wall chart are generally larger than those you might 
see in a book or other page-sized report.  If your pictures are low-resolution, they will 
probably look very grainy and jagged when enlarged on your wall chart.  You should use 
the highest resolution you can when selecting pictures.  This is especially important for 
pictures that are being enlarged for use as the background of the chart. 
 
You can also use both a color and an image.  The color will colorize the image more and 
more as you adjust the transparency more to the right. 
 
Title & Legend 
You can add, change, or remove a title and legend to the chart. 

 
The Insert Tab of the Ribbon 

 
Insert Tab 
The Insert tab is part of the main Ribbon of Legacy 
Charting.  (See The Ribbon for more information 
on how to use this main toolbar.) 
 

Picture 
One or more pictures can be placed in the 
background of the chart.  These pictures lie in a 
layer that is behind the chart boxes.  You can 
stretch these pictures to any size, even filling 
the entire background area of the chart.  
Pictures can be cropped, rotated, converted to 
black and white, and faded.  Adjustments can 
be made to the brightness, contrast and 
saturation of the pictures.  Drop shadows can 
also be added.  (When you make these types of 
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changes, you are working with a copy of the picture.  The original is not changed.) 
 
Picture Resolution 
Keep in mind that pictures used on a wall chart are generally larger than those you might 
see in a book or other page-sized report.  If your pictures are low-resolution, they will 
probably look very grainy and jagged when enlarged on your wall chart.  You should use 
the highest resolution you can when selecting pictures.  This is especially important for 
pictures that are being enlarged for use as the background of the chart. 
 
Stretching a Picture 
When you click on a picture, eight handles appear around the edge of the image that you 
can use to change its size.  The handles in the corners, when dragged, increase or 
decrease the picture size while maintaining the current aspect ratio (width and height 
proportions).  The handles on the middle of each side are used to stretch the image 
vertically or horizontally.  In other words, it will pull the picture out of its original 
proportions, making the picture, and the things or people within it, fatter or taller. 
 
Text 
One or more text boxes can be placed and moved to any 
position to enhance and describe the various parts of your 
chart.  The fill and text color can be changed and the box 
border lines can be adjusted or removed.  Drop shadows can 
also be added. 
 

 

 
 
 
The Publish Tab of the Ribbon 

 
Publish Tab 
The Publish tab is part of the main 
Ribbon of Legacy Charting.  (See The 
Ribbon for more information on how to 
use this main toolbar.) 
 
The ultimate goal of creating a large chart 
is to print it and hang it up for all to see 
and enjoy.  Charts can range from a single 
letter-sized page to a hundred square feet or more.  Simple charts with only a few generations 
can often be sized and positioned so as to only take one small sheet of paper and be easily 
printed on your personal printer.  Large charts can oftentimes require dozens or even 
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hundreds of letter-sized pages to print.  These are better reserved for output on a plotter where 
they can be printed on a single sheet of paper that can generally be up to 42 inches wide and 
twelve feet long.  Plotters are often found at larger copy centers.  Charting also has a built-in 
and affordable chart printing service. 
 

Your chart can be printed on your personal printer at any time.  Depending upon the size 
of your chart, it might span many pages that you would have to cut and tape together.  
The total number of pages that your chart will print upon is shown in the Status bar along 
the bottom of the window.   Sometimes it is more efficient, taking fewer pages, to orient 
your paper to landscape rather than portrait mode before printing.  (To make this change, 
go to the File button and choose Printer Setup.)   
 
Printing Your Chart On Your Own Printer 
To print your chart, click Print on the Publish tab (or on the Quick Access 
Toolbar).  From the Print dialog box, make sure the correct printer is 
selected.  If you only want to print a range of pages, set the from and to 
values accordingly.  (The pages of the chart, as shown by the dashed red lines, are 
numbered left to right, and top to bottom.)  When you are ready to print, click OK. 
 
Exporting to a File 
You can export your chart to a graphic file in several different formats.  These include 
PDF, Bitmap, Jpeg, PNG, Tiff, and PSD.  PDF files are a great way to send charts to 
people by way of email.  The other formats are useful when including charts in books and 
other publications. 
 
To export your chart, click the Export to File button on the Publish tab.  
Choose the desired format, select the export folder and file name, and then 
click OK. 

 
Email 
When you have produced a nice chart and you want to share it with another family 
member or friend, it is convenient to be able to email it to him or her.  You can attach a 
PDF version of the chart or convert the chart to one of the other available file formats and 
send that.  
 
To send a chart by email, click the Email button on the Publish tab.  Choose the 
file format (PDF File is usually the best) 
 
Printing a Chart at Your Local Printer 
You can create a PDF file of your chart (Publish > Export to File > PDF) that you can 
take to your local printer to be printed as a wall chart.  Check with your printer to see 
what paper sizes and paper qualify are available.  

 



Wall Charts 

184 Legacy User Guide 

 

Ordering a Printed Wall Chart 
There are two modes for laying out charts in the program.  The first one is used for charts 
that you will be printing on your own printer.  The second is for layout charts that will be 
printed on a plotter.  Charting has a built-in professional chart printing service that make 
it very easy to visualize what your wall chart will look like when it is printed and how 
much it will cost to order it from us. 
 
To start the professional layout process, click 
Order Chart on the Publish tab.  When you 
do, the Order Option panel is displayed along 
the right side of the Charting window.  You 
will also notice that the chart area changes to 
the paper size currently shown in the Order Option 
panel.  Plotter paper only comes in three widths, 24”, 
36”, and 42” wide.  You can print your chart on one of 
these paper widths.  The length of the chart can be up to 
12 feet long.  If your chart is wider than 42”, you can 
have it printed in two or more strips. 
 
Orientation of the Paper 

Portrait – When you have portrait mode selected,  
the paper roll on the screen goes from the top down.  As 
you increase the height of your chart, the roll will extend 
in one-foot increments.  If your chart extends off to the 
right of the current paper roll, another strip is added.  If 
you have selected 24” paper, another 24” strip is added.  
If your chart only needs 36” or 42” in width, you should 
change to that width of paper, thus using only one strip 
instead of two or more. 
Landscape – When you have landscape mode selected, 

 the paper goes from left to right.  As you increase 
the width of your chart, the roll will extend in one-foot increments.  If your chart extends 
off the bottom of the current paper roll, another strip is added.  Again, if you have 
selected 24” paper, another 24” strip is added.  If your chart only needs 36” or 42” in 
height, you should change to the appropriate width of paper so that you minimize the use 
of additional strips. 
 
The charting service offers four different types of paper upon which you can have your 
chart printed.  These include: 
 
20lb Bond Paper – Bond paper is about as heavy as typing paper.  It is not archival but is 
perfect for research charts that are going to be written on and added to.  It is not heavy 
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enough for good picture quality however.  Cost: $15 plus $1, $2 or $3 per linear foot (for 
24”, 36”, and 42” respectively). 
 
24lb Presentation Paper – This is a quality presentation paper that is about as heavy as 
typing paper.  It is archival, bright white, UV coated, and is perfect for charts with 
decorative elements.  Cost: $15 plus $2, $3 or $4 per linear foot. 
 
Glossy Photo Paper – This is an archival 80lb heavy glossy photo paper.  The 
gloss makes photos appear crisp and clear.  Cost: $15 plus $6, $9 or $12 per linear foot. 
 
Artist Grade Matte Canvas – This is a heavy matte archival artist's canvas.  The 
canvas giclée printing process is the same archival quality as a fine 
art reproduction from an art gallery.  It is a rich, beautiful medium for a 
classic looking genealogy chart.  The light texture helps lower-quality antique pictures 
look cleaner.  Cost: $15 plus $20, $28 or $35 per linear foot. 
 
Pricing 
As you select the paper size and type, the printing cost for your chart is displayed. 
 
Purchasing a Chart 
When you are ready to place an order for a printed chart, click the Purchase Chart 
button.  Charting takes you through a 3-step review of your order to double-check the 
size, orientation, paper type, quantity, cost, and shipping information.  Finally, you 
indicate your desire to place the order by clicking the Order Chart button on Step 3 and 
then you are taken through the payment and shipping steps, and find out what the 
shipping cost will be to your location from our Utah-based printer.  (Other printers at 
other location may be added in the future.)  Sales tax is also added for Arizona, Utah, and 
Washington State orders.  At the end of this process you then do a final confirm of the 
order, upload your chart file and then sit back and wait for your beautiful charts to arrive 
at your doorstep.  (You should allow up to two weeks for chart delivery.  Rush delivery is 
available for an extra charge, cutting the normal delivery time in half.) 
 

The Help & Options Tab of the Ribbon 
 

 
 
The Help and Options tab is part of the main Ribbon of Legacy Charting.  (See The Ribbon 
for more information on how to use this main toolbar.) 
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Options 
General 
Clicking on the Chart Options button displays the Chart Options 
window. 
 
View Tab 

Appearance 
Show page boundaries – Shows the page boundaries with 
dashed red lines.  This is determined by the current printer and page size 
selected in the Printer Setup. 
Use short locations – Uses the short version of the location names.  (Note:  
You must reapply the current theme when you change this option.) 

 
Default Privacy Options when a chart is created 

Suppress private individuals – If, by default, you don’t want to include the 
private individuals from your charts, select this option. 
Suppress private information – If, by default, you want to suppress 
information that is marked as [[private]], select this option. 
Suppress details for living people – If, by default, you want to not include 
the detail information for individuals that are still alive, select this option. 
Use “Living” instead of their name – If you would like to set as a default to 
use the word “Living” instead of displaying a living person’s name, select 
this option. 

 
Default Box Item Settings 

Font – Select the default font for the text items in a box. 
Size – Select the default font size for text items in a box. 

 
Measurements 
Choose between inch or metric measurements to be shown in the program. 
 

User Information Tab 
Enter your name and contact information here.  You can include this information 
in the chart Legend if desired. 

 
Folder Locations Tab 

Chart File Folder – Specify the default folder in which to store your chart file. 
Genealogy File Folder – Specify the default folder to display when you are 
browsing for a genealogy family file to load for charting. 
Image Folder – Specify the default folder to display when you are selecting an 
image to display on the chart. 
Export Folder – Specify the default folder to display when you are choosing 
where to export a chart file. 
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Date Options Tab 

Date Format 
 Select from six date display formats: 
 

 mmm dd, yyyy Nov 30, 1854 
 dd mmm yyyy 30 Nov 1854 
 mm-dd-yyyy 11-30-1854 
 dd-mm-yyyy 30-11-1854 
 yyyy mmm dd 1854 Nov 30 
 yyyy-mm-dd 1854-11-30 

 
 

Separators for numeric dates 
If you are using either the dd-mm-yyyy or mm-dd-yyyy format, you can specify 
the separator character to place between the date parts.  Click the option button 
for the appropriate symbol. 
 
If you are using a date format that doesn't include separator characters, such as 21 
Apr 1900, then Charting uses the selected date separator character between any 
year ranges.  For example, 21 Apr 1953-1958 would appear as 21 Apr 1953/1958 
if the slash was chosen as the separator character. 

 
Month Format 
You can further alter the way dates are formatted by selecting abbreviated or full 
month names and initial or all uppercase month names.  Click the option buttons 
corresponding to the desired format. 
Character format 
You can display the months with Initial Caps, all uppercase, or all lowercase. 
 

 
Help System 

Online Help 
To open the help system for Legacy Charting, click the Help System 
option.  From the help system you can search by topic or use the 
Contents tab to answer your questions. 
 
If you want context-sensitive help (help on what you are currently doing), press the 
F1 function key on your keyboard. 
 
About Charting 
Legacy Charting is developed and distributed by Millennia Corporation, 
Surprise, Arizona.  Copyright 2017, Millennia Corporation.  All rights 
reserved. 
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Support Links 
Get information concerning customer support, reporting a bug, 
suggesting new features, or going to the Charting web site, you will find 
it here. 

 
The Tips & Updates Tab of the Ribbon 

 

 
Updates 

The current version number of Legacy Charting that you have installed is displayed 
on this tab.  If you do not have the latest charting update, then you should update 
your Legacy program. 

 
Messages 

If you have Internet access, the Message Center is the place to go to get the latest tips 
and tricks concerning your charting experience.  Check here often for helpful articles 
and announcements.   

 
The Picture Settings Tab of the Ribbon 

 

 
Picture Settings Tab 
The Picture Settings tab is part of the main Ribbon of Legacy Charting.  It only appears 
when you have a picture selected within your chart.  (See The Ribbon for more information 
on how to use this main toolbar.) 
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Rotating 
You can rotate a picture right or left in 90 degree increments.  
This may be necessary if a picture was taken by rotating the 
camera to fit a person or scene better.  You can also flip a 
picture top-to-bottom or left-to-right.  Flipping a picture top-to-
bottom is not the same as flipping the picture 180 degrees.  
When flipping top-to-bottom or left-to-right, the picture is 
actually reversed.  If there is any writing on the picture or 
anything that would look “wrong,” like a clock, or two people shaking right hands, the 
viewer will notice… so be careful. 
 
Bring to Front & Send to Back 
By default, text boxes are cover pictures.  This means that if you drag a text box over a 
picture, the picture will appear behind the text box.  To change this, click on the picture 
and choose Bring to Front in the Arrange section of the Picture Settings tab.  (Or you 
can click on the text box and then click Send to Back in the Text Appearance section of 
the Text Settings tab.) 
 
Pictures and text boxes cannot be brought in front of individual chart boxes.  The chart 
boxes are always on the top layer. 

 
Image Adjustments 

Brightness – You can adjust the image brightness from -
40% (darker) to +40% (lighter) to make your pictures 
look better. 
Contrast – You can change the contrast from -40% 
(blurrier) to +40% (sharper). 
Re-color – Charting supports the displaying and printing 
of both color and black and white pictures.  Color 
pictures can be converted to gray scale (black and white) 
by clicking To Gray Scale.  This is often necessary if 
you are printing charts on a non-color printer or plotter.  
Color pictures sent to a black and white printer often 
come out looking muddy and washed out. 
Reset Picture – To revert back to the original picture, abandoning any changes you 
have made to it, click Reset Picture.   (When Charting places a picture on your chart, 
a copy is made of the original.  As you make changes to the chart picture, you are 
working with the copy, not the original.) 
100% Size – If you have stretched a picture smaller or larger, you can revert back to 
its original full size. 
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Image Settings 
Aspect Ratio 
The aspect ratio of a picture is the original width to height ratio.  If you stretch a 
picture wider or taller, the aspect ratio changes and the picture can look strange 
(although a small amount of tweaking can make a person look better in many 
cases…). 
 
To restore a picture that has been stretched, to its original 
proportions, click Reset Picture.   
 
To restore a picture to its full size, click 100% size.   
 
Picture Borders  
To place a border around your 
picture, click Border Settings and 
then select the border style you would like.  You can also 
have a drop shadow placed behind the picture. 
 
Deleting a Picture 
To delete the current picture from the chart, click

.  Note, the picture file its self is not 
actually deleted from your computer, it is just removed from 
the chart. 
  
 

The Text Settings Tab of the Ribbon 
 

 
 
Text Settings Tab 
The Text Settings tab is part of the main Ribbon of Legacy Charting.  It only appears when 
you have a text box selected on your chart.  (See The Ribbon for more information on how to 
use this main toolbar.) 
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Edit 
To add or edit the text in the text box, click Edit Text.  When you have made 
the desired changes, click OK. 
 
 
 
 
Text Settings 
The font used for the text is 
selected from the Text Font 
option and the text size from the Font Size option.  
To change the color of the text, make the change 
from the Font Color option.  You can change the 
background fill color of the text box by selecting a 
color from the Background Color option.   
 
 
 
 
Styles & Alignment 
The text within a text box can be bolded, italicized, and underlined by 
clicking on the desired style.  The text alignment can also be set to left-, 
right-, or center-justified. 
 
Border Settings 

Displaying a Frame 
To display a lined frame 
around a text box, click on the Border Settings 
option.   Choose the desired border style.  You can 
also choose to have a drop shadow displayed behind 
the text box. 
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The File Button 
 

 
The File Button 
The nice looking round button in the upper-
left corner of the main screen is called the 
File Button.  It lets you start a new chart, 
open an existing chart, save a chart, and 
change the name of a chart.  You can also 
print your chart on your local printer from 
here, as well as change the settings on your 
printer.  And last, but not least, you can close 
Legacy Charting. 
 
 
 
 
 
 
The Quick Access Toolbar 
 

 
The Quick Access Toolbar  
The small toolbar along the top side in the upper-left corner is called the Quick Access Toolbar.  
It is always visible and gives you some commonly needed options.  These include starting a new 

chart , opening an existing chart , saving a chart 
, saving a chart under a new name , printing a 

chart , selecting a new starting individual , 

selecting a new chart type , and changing the 

number of generations for a chart .  Just to the 
right of the toolbar is a button that lets you customize it 

.   
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The Side Toolbar 
 

 
The Side Toolbar  
The Side Toolbar consists of tools that affect the layout and viewing of your chart.  
You can use these tools to move your chart around the page (or pages), move individual 
boxes, generations of boxes, or specific ancestor or descendant lines of boxes. 
 

The Selection Arrow - Used to select one or more boxes and then move them 
around on the chart.  When you select a box, the box’s background turns black.  

 To move a selected box, drag it with the mouse cursor.  The number of 
boxes that actually move when you drag a selected box depends on the setting of the 
Drag button lower in the toolbar.  You can select more than one box by holding down 
the Shift key while you click on additional boxes.  You can also select multiple boxes 
by drawing a box that touches or encloses the desired boxes.  (With your mouse, point 
to a place on the background that is above and to the left of the upper-left box you want 
to select and then press down and hold the left mouse button while you then drag a 

rectangular box around the boxes you want to select on the chart.  When you release the mouse 
button, all the boxes enclosed or touched by the rectangle are selected.) 
 
When you move any of the selected boxes, all the other selected boxes move with it (along with 
the other line or generation boxes specified by the current Drag button).  If you drag a box off the 
right or bottom edge of your chart area, additional pages are automatically added to accommodate 
them.  Likewise, if you drag all the boxes off of a page along the right or bottom side, the unused 
pages are removed for you. 
 

The Drag Hand – When the chart is zoomed in to be larger than the main chart window, 
you can drag it around using the Drag Hand in order to view other parts of the chart.   Just hold 
the left mouse button down while you drag the chart in any direction. 

 
Zooming In and Out – You can zoom your chart in and out, from 3 percent to 200 
percent - to get the big picture or to see fine detail.  (You can also zoom in and out using 
the center wheel on your mouse, if you have one.) 
 

Center Chart – Re-centers the chart within the least number of pages needed to hold it.  
Only the chart boxes and lines are repositioned.  All pictures or text boxes that you have added 
are left alone. 
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Zoom to Chart – Sets the zoom level so that the chart fills the main chart window, if 
possible.  (If the chart is very large, the zoom level is set to a minimum of 3 percent.  You will 
then have to use the Drag Hand or the Navigator Square to move around the chart.) 
 

 The Drag Buttons – These determine which boxes are moved when 
you drag a selected box. 
 

 Drag only one Individual – Only the selected box (or boxes, if more than one has been 
highlighted) moves when dragged with the mouse. 
 

 Drag Lines of Individuals – The selected box and all connected ancestor boxes (for an 
ancestor chart), or descendant boxes (for a descendant chart) move when dragged with the mouse. 
 

 Drag all Individuals of the same Generation – All the boxes in the same generation as 
the selected box are moved. 
 

 Drag All Individuals – All the boxes on the chart are moved when the selected box is 
moved.  This includes any text or picture boxes on the chart. 
 

 The Reformat Chart button – Resets the current chart to the default layout (after asking 
for permission to do so).  If you have moved boxes around on an ancestor or descendant style 
chart, the boxes will be moved back to their default locations.  So, if you have spent a long time 
rearranging your chart boxes, don’t use this feature unless you want to start all over again.   
 
Note:  The Reformat Chart button doesn’t have any effect on Fan charts. 

The Navigator Square 
 
The Navigator Square, in the lower-right corner of the main chart 
window, gives you an overall view of your chart, no matter how big it is.  
If your chart is one page or 4000 pages, the entire chart is always shown.  
The red rectangle shows the current portion of the chart that is being 
shown on the screen.  As you move around your chart, the red rectangle always shows where you 



 Wall Charts 

Legacy User Guide 195 

 

are.  This is especially nice when you have a very large chart.  You can also drag the red rectangle 
in the Navigator Square to a new position on the small chart to change the portion showing on the 
main screen.  This is often the best way to quickly zoom into a specific portion of a large chart.  
The Arrow in the lower-right  minimizes the navigation square. To restore the Navigation 
Square, click the arrow again . 
 
The Status Bar 
 

 
The Status Bar, along the bottom of the main chart window, displays how many individuals are 
included on the chart, how many pages the chart would require to be printed on your local printer, 
the resulting overall size of the chart, and what the current zoom level is. 





Chapter 9 

Map My Family 
Where did they live and where did they travel? 

 
The Map My Family window plots all the locations associated with a person allowing you to see 
where he spent his life. (Deluxe Edition only) This often shows a path or migration pattern for the 
individual and may offer additional clues as to where other events happened during his life.  
Along with the locations belonging to the individual, you can also include the locations 
associated with the birth and death of the spouse, children, and parents.  Marriage locations can 
also be included. 
 

To display the map, choose Map Family from the View tab of the Ribbon bar, or click the  
button if you have placed it on the toolbar.  When the map is initially displayed, it is broad 
enough to encompass all the locations that have been selected to include. 
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As you place the mouse pointer over each pin, 
a text balloon appears showing the name of 
the location and a list of the events that 
happened there. 
 
 
Initially, the pushpins might be stacked one 
atop another making them difficult to tell 
apart.  To move the pins apart, use the Zoom 
In  button.  As you enlarge the map area, 
the pushpins move apart and are easily 
differentiated. 
 

 
 
 
 
 
 
 

Working With the Map 
In the upper-left corner of the map is the View Control.  The View Control lets you zoom in  

and out , pan the map up and down and 

sideways , switch from Road (drawn 
map) to Aerial (satellite view) to Hybrid (a 
combination of Road and Aerial) and Bird’s 
eye (an angled airplane view). 
 
You can hide the View Control by clicking the 

 button at the upper-right corner.  To display the View Control again, click . 
 



 Map My Family 

Legacy User Guide 199 

 

If you double-click anywhere on the map, the point where you clicked will move to the center of 
the map and the map will zoom in one setting.  You can also drag the map in any direction with 
the mouse. 
 

Pedigree Navigator 
A small, three-generation pedigree is shown in the upper-left corner of the window.  The current 
individual is at the starting position in generation one.  This is a live chart that you can use to 
move up to ancestors and down to descendant.  To move to a parent, or a grandparent, simply 
click on their name.  This moves that person into the starting position of the chart and redraws the 
map using location connected to him or her.  To move down to a descendant (or to move to a 
spouse), click the small blue button to the left of the main person.  This displays a popup list of 
the spouses and children where you can select the desired person to become the focus of the map. 
 

List of Locations 
All the locations that are associated with the current person are displayed in the Location List.  
Each place name is only shown once, even if more than one event happened at that place.  The 
Lat column at the right side of the Location List shows an L for each location that has been geo-
coded and therefore has a latitude and longitude recorded for it.  When the Location List is first 
filled with all the locations for a person, Legacy runs down the list to try to geo-code any places 
that have not been done.  (This requires that you have an active Internet connection.)  Any 
locations that can’t be automatically geo-coded are shown with a ? in the Lat column.  If you 
want to manually try to resolve these locations using the tools from the Master Location List, you 
can highlight the location and click the Resolve button under the list. 
 

Options 
Click the Options button under the map to access the following features: 
 

Items to Include on the Map 
Select the event locations you would like to include on the map.  These include locations 
for the main person’s birth, christening, death, burial, and events.  You can also choose 
marriage and marriage event locations along with the birth and death locations of any 
spouses.  Birth and Death locations for parents and children can also be included. 
 
Zooming the List 
You can choose the font size used in the Location List. 
 

Printing the Map 
If you would like to print the map, click the Print button under the map.  If you would like to print the map 
in landscape mode, click Preferences from the Print dialog box and change the Orientation to Landscape 
and then click OK.  Click Print to send the map to your printer. 
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How to Make a Graphic File from the Map 
To capture the map on the screen and create a graphic file that can be attached to many events in Legacy, 
see How to Make a Graphic File from the Map on page 117. 
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Research Guidance 
Where to Look for More Information 

 

Legacy’s Research Guidance icon  on the personal toolbar of the Husband or Wife on the 
Family View on the main screen of Legacy is your starting point for getting help finding more 
information about your ancestors.  This fantastic resource points you to specific suggested 
sources from the tens of thousands contained in the research guidance system.  And more are 
being added all the time. 

 
To start the Research Guidance process for someone, make sure that person is in one of the two 

main positions on the Family View and then click on the Research Guidance icon  on their 
personal toolbar.  The system then accesses the extensive source database and calculates and 
displays the number of Preliminary Survey sources and Suggested Sources for further research.  
The Research Guidance Results screen is then shown.  You can also access Research Guidance 
tool for anyone showing on any of the main Legacy views by right-clicking on the person’s name 
and then choosing Research Guidance from the popup menu. 
 

Research Guidance Results 
 
Legacy’s Research Guidance helps you locate records that may contain information about your 
ancestors. It does this in four steps.  
 

 Legacy helps you review the ancestor’s timeline, to be certain that you’ve 
already recorded everything you know about the ancestor.  

 Legacy suggests preliminary survey sources to help you learn if the research is 
already in progress by another researcher.  

 Select your goal, and Legacy provides a list of prioritized suggestions to help you 
accomplish your goal.  

 Finally, Legacy organizes the sources into a To-Do List.  
 
The Research Guidance Results screen shows the current person at the top of the window along 
with his or her birth and death information.  If any piece of information has been estimated by 
Legacy, it is surrounded by angle brackets, and highlighted in red.   
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Options 
Clicking the Options button near the upper-right corner of the screen lets you print the current 
person’s research suggestions, or change the font sizes of various portions of the screen so that 
you can see them better or display more information. 
 
Below the personal information are four tabs corresponding to the four general areas of Research 
Guidance.  Each is described below: 
 

 Review Timeline Tab 
 

 
 
On the right is a list of the timeline events that make up the person's profile.  This is the 
information used to display suggested sources that you should look at to find additional 
information for the individual. Some of these events are drawn from existing information 
and others are estimated by Legacy and shown in red with angle brackets around them.  
In general, the more timeline events that are known, the better Research Guidance can 
suggest helpful sources to research.   
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What Information to Use 
By default, all the timeline events in the list are used to generate research suggestions by 
Legacy.  If you would like to turn off the inclusion of any particular event, click the 
checkbox in the Use column on the left to remove the checkmark.  Subsequent clicking of 
the checkbox toggles the checkmark on and off. 
 
 

 Preliminary Survey Tab 
 

Before starting original research on an ancestor, you should learn if that ancestor has 

already been researched and documented by another fellow genealogist. In Step  of 
Legacy’s Research Guidance, Legacy suggests various sources and Internet sites where 
you can see if anything has already been published concerning your ancestor. 
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The Preliminary Survey tab contains five sub-tabs: 
Lineage-Linked Databases 
Surname MB / ML  (Message Boards and Mailing Lists) 
Locality MB /ML 
Genealogies 
Local Histories 
 

Each tab indicates in its caption how many suggested sources are included.  The five tab 
areas are described below: 
 
Lineage-Linked Databases 

A Lineage-Linked database is what is created as you enter information into your 
Legacy Family File. Many researchers choose to publish their linage-linked 
databases to the Internet. The sites listed here are major repositories for these 
electronic databases. Some can be searched freely, others require a nominal 
subscription fee. 
 
The top portion of the tab area contains a list of the online databases containing 
lineage-linked pedigrees where you may find the current person.  The bottom of 
the area is a web browser.  (To use the web browser, you must be connected to 
the Internet and have Internet Explorer installed on your computer.) 
 
To search any of the lineage-linked preliminary survey databases, highlight the 
desired source in the upper list and then click the Search button below the list.  
The search page for the appropriate web site is loaded and displayed in the web 
browser.   

 

Surname MB / ML  (Message Boards and Mailing Lists) 
Message Boards and Mailing Lists assist researchers in communication with each 
other. These should be searched before beginning original research to learn if 
others have already researched your same family lines. These Message Boards 
and Mailing Lists are also places where you can submit queries about your 
research. 
 
Like the Lineage-linked tab, the top portion of this tab area contains a list of the 
online message boards and mailing lists that match the current person.  For 
females, message boards are suggested that include each of their married names 
and their maiden name. The bottom of the area is a web browser.   
 
To search any of the resources, highlight the desired message board or mailing 
list and then click the Search button.  The search page for the appropriate web 
site is loaded and displayed in the web browser. 
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Locality MB /ML 
Like the Surname Message Boards and Mailing Lists, locality Message Boards 
and Mailing Lists are places where you can submit queries or search the archived 
queries relating to a certain locality. 
 
This tab shows any locality message boards or mailing lists that might be useful 
in researching your ancestors.  It works the same way as the Surname MB/ML 
tab.  

 
Genealogies 

Millions of books have been published over time. It is possible that one of those 
books contains genealogical information about your ancestor. The sources listed 
here assist you in locating a genealogy about your ancestor. Indexes and even 
some of the actual genealogies can be searched online. 
 
If there is a suggested source in the list that you would like to search, you can 
either click on the Plan to Search button, to add that source to the To-Do List, 
or, if the source is marked as online, click on the Online button to search the 
source online.  If you want to ignore the suggested source, click on the Ignore 
button. 
 
Below the suggested sources is a list of repositories. These are places where the 
suggested source can be researched. 
 
The Reason section of the screen displays the reasons for which the source was 
suggested. 
 
The Source Tip section may include additional helpful information about the 
suggested source. 
 

Local Histories 
Learning about the history of the cities, towns, counties, and other regions helps 
you learn about your ancestors. The suggested sources in the Local Histories tab 
are sources that help you learn about this history. Many of these histories contain 
biographical information about the people who lived in the area. They may also 
provide information about where the people came from who settled the area. 
Finding your ancestor’s name in print may not only help you solve your research 
problem, but it helps them come alive! 
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 Suggested Sources Tab 
 

Once steps  and  have been completed, the Suggested Sources tab, step , 
provides you with the best sources to learn about your ancestor. 
 

 
 
The Suggested Sources tab contains seven sub-tabs corresponding to the seven possible 
goals available in the Research Guidance system.  These are: 

 Birth 
 Death 
 Marriage 
 Parents 
 Siblings 
 History 
 Maiden Name 
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Each tab area has the same layout as described below: 
 
Suggested Sources 
In the upper-left part of the tab area is the list of suggested sources for the current goal.  
This list is ranked in order of importance, which means that the researcher is more likely 
to find information relating to their goal in the sources that are ranked higher (1 is the 
highest). However, do not neglect the sources that are ranked closer to the bottom of the 
list, because one never knows all of the hidden information in various sources. If you 
would like to see more detail for a particular source, double-clicking it displays all the 
information. 
 
The Suggested Sources list also indicates if the source is available online 
 
Source Output 
Below the Suggested Sources list is a source citation for the highlighted source in the 
list.  This can be used later, if you find information from this source, as the source 
documentation in Legacy.   
 
Source Repositories 
The repository list shows one or more places where the source (highlighted in the 
Suggested Sources list) can be found.  Each repository line also indicates if there is an e-
mail link or a web site address available by showing icons in the Email and Online 
columns.  To view complete address and contact information for any repository, click the 
Repository Details button below the list.  (You can also double-click any repository for 
the details.  To send an email to a repository (with an Email icon), click the Email button 
below the list.  To launch your web browser and display the web site for the repository, 
click Online. 
 
Source Tip 
As you highlight each source in the Suggested Sources window on the left, the reason for 
suggesting that source is displayed in the window to the right. For example, if the 
Barbour Collection: Connecticut Birth Records… source is suggested, the reason section 
explains that this source was suggested because the individual lived in Connecticut 
during the same time period that the source covers. 
 
Along with the reason is more information about the source. In some cases, it lists the 
information that you might find in the source. It may suggest to you how to best utilize 
and/or analyze the information you might find. 
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How to Use the Suggested Sources 
 
If you would like to search the source, click on the Plan to Search button to add it to 
your To-Do List. This is an important step – adding the source to your To-Do List helps 
you keep a log, or a history, of the sources that you have searched. 
 
Some of the sources listed in the list can be searched online. If this is true, an Internet 
icon appears in the Online column. Just click the Online button, and select the site that 
you wish to search.  
 
If there is a source listed that you want to ignore, you can click on the Ignore button. 
This pops up a menu where you can selected to: 
 

 Hide/Show ignored sources 
 Ignore the highlighted source for the current individual. 
 Ignore the highlighted source for everyone 

 

 To-Do List Tab 
 
The final step in Research Guidance is to utilize the To-Do list that you have generated.  
 

 
 
As you search the sources, even the online sources, be sure to update the To-Do Item by 
clicking on the Edit button. Here you can record your results. 
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For example, if you searched the International Genealogical Index, and you did not find 
anything for your ancestor, be sure to record this. Record all variations of the 
name/surname that was searched, the time periods you searched, and any pertinent 
information so that you, or a fellow researcher, can understand exactly what you 
searched. 
 

Check Back Often 
Legacy’s Research Guidance system is updated often, so check back frequently for great 
new sources to search. 
 
As you add new information to your Legacy Family File, the list of suggested sources 
may change. New sources may appear as you find more exact information. 
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Other Features 
Where to Get Help 

 
There are a multitude of features in Legacy that are covered in great detail in the help 
system built into the program itself. Below, and on subsequent pages, is an alphabetized 
list of features and options with a summary of each one along with where to look in the 
Legacy Help file for more information. 
 

Focus Groups 
A Focus Group is a subset of 
records and includes selected 
individuals, families, ancestors 
and/or descendants. The contents 
of a Focus Group determine who 
will be exported to a file or printed 
on a report.  
 
A Focus Group can contain as few 
as one individual, or as many as 
the entire contents of the family 
file. An individual and all his or 
her ancestors can be added to the 
group with a single selection. 

 

 For complete information about creating Focus Groups, see the Legacy Help 
system and search the index for: Focus groups 

 

Ancestor Coloring Options 
Ancestor and Descendant type reports and many screens can now show colors associated 
with one of the four grandparents lines or one of the eight great-grandparents. There is 
also an option to color males and females differently on reports.  

 (Help index: Ancestor colors) 
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Calculators 
Bearing and Distance Calculator 

You can now use latitude and longitude values for something useful. This new 
calculator tells you the distance in miles (or kilometers) between any two points on 
earth. It also tells you which direction to travel from one point to the other. You can 
also convert decimal bearing values to needed degrees, minutes, and seconds. It even 
ties into the Master Location List where you can select any two cities (with latitude 
and longitude values) and quickly figure out how far apart they are and in which 
direction. 

 (Help index: Bearing calculator) 
 

Date Calculator 
The date calculator figures the time span between two dates, or calculates the 
beginning or ending date if you know one or the other along with an age.  

 (Help index: Date calculator) 
Relationship Calculator 

You can quickly figure out all the different ways that any two people in your family 
file are related.  

 (Help index: Relationship calculator) 
 
Soundex Calculator 

Soundex codes are used to group similar sounding last names together. These are 
often used when searching census records. Census takers often misspell names when 
writing them on the census forms. Searching for surnames using the Soundex code 
finds all similar sounding names.  

 (Help index: Soundex calculator) 
 

Customizing Legacy 
Customizable Family View Information Fields  

There are up to five lines on both the Husband and Wife boxes of the Family View 
that can display information. Each of these information lines can be changed to other 



 Other Features 

Legacy User Guide 213 

 

pieces of information you might want to view instead. To change the lines, click any 
of the descriptive labels to the left of the lines.  

 (Help index: Customize - Family View information) 
 

Customizable Toolbars  
My Toolbar   

 
 
You can customize the My Toolbar tab of the Ribbon bar by clicking on the small 

icon  in the lower-right corner of the Shortcut Toolbar group.   

 (Help index: Ribbon Bar: My Toolbar tab) 
 
You can now choose which toolbar buttons to include at the top of Legacy. Select 
from nearly 40 options that are only a click away. Place your most-used options right 
on the toolbar, for the full width of your screen in any order you want!  

 (Help index: Customize - main toolbar) 
 

Family View and Pedigree View Toolbars   The picture toolbars on the Family 
View and Pedigree View can be customized to show only the tools you want to use. 
You can also change their order.  

 (Help index: Customize Family View toolbars or Customize 
Pedigree View toolbar) 

 

Customizable Options 
The Options menu in Legacy is provided to allow the user to customize the program 
to personal preferences. The Customize screen is reached by choosing Customize 
from the Options tab of the Ribbon bar. 

 
Following is a brief description of each tab and where to find complete information 
in the Legacy Help system.  
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General Settings  
Set certain parameters so Legacy shows you the information you require most.  For 
instance: How would you like the program to look when started? Should the main 
window be maximized? Which view would you like to see? Which family file should 
open? Who should be displayed? How would you like the surnames formatted? Do 
you want birth-death years added to names? How many columns of children should 
appear? What kind of pop-up help do you want to see?  

 (Help index: Customize - general settings) 
 
Data Entry  

Control how you enter information. This includes verification of new names and 
locations, jumping directly to notes after entering information, letter case formatting 
of names and locations, the age at which people are presumed dead, default married 
name rules and the behavior of the Enter key.  

 (Help index: Customize – data entry) 
 

Data Format  
Control how your information looks on the screen. This includes letter case 
formatting of names and locations, child list and living indicators, christening term, 
and potential problems indicator.  

 (Help index: Customize – data format) 
 

Data Defaults  
Set how you want things to normally work while you are entering information.  
Options include living indicators, note types, cursor behavior, reuse of deleted 
records, default latitude and longitude directions, and units of measure. 

 (Help index: Customize – data entry/edit) 
 

Dates  
Legacy supports many different formats for both inputting and displaying dates in the 
program. You can enter dates in almost any conceivable format and they are 
reformatted to a consistent format per your selection. You can also include several 
prefix modifiers including Before, After, About, Between, Circa, B.C., and A.D. 
Legacy also recognizes several abbreviations of these modifiers.  
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 (Help index: Customize - dates) 
 
 

File Locations  
Set or change the default locations of your family files, multimedia files, and 
temporary files.  

 (Help index: Customize - file locations) 
 

Sources  
Choose settings for AutoSource, Source Surety, and whether or not to print Master 
Source and Detail Source text and comments on reports.  

 (Help index: Customize - sources) 
 

View  
Choose options for how things look on the screen. These include showing the birth-
death range at the end of names; RINs, AFNs, FSIDs, Find A Grave IDs, 
BillionGraves IDs, or User IDs at the end of names; the displaying of the built-in 
ancestor coloring system; the use of short location name; choosing how many 
columns of children to display; three-dimentional borders; choosing which headings 
to use on the Family View; using the Master Location List with or without maps; 
showing thumbnail pictures on the Family View; showing status terms on the Family 
View; showing Potential Problems icons; the term to use for aunts and uncles; 
performing background Hint searching and displaying the results; and which style of 
labels and prompts to use in Legacy (Traditional or Gender-Neutral).  

 (Help index: Customize - view) 
Colors  

You can change the background color of some of the main input forms.  

 (Help index: Customize - Customize colors) 
Fonts  

You can change the fonts used for screen forms and printed reports.  

 (Help index: Customize - fonts) 
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Launch  
Legacy offers to start your web browser, word processor, or text editor to view web 
pages or reports that you have generated. Normally, the default program for your 
computer is used. You can override these settings and use different programs to view 
the results by filling in one or more of the program fields.  

 (Help index: Customize - launch) 
 
Other Settings  

Miscellaneous settings concerning message boxes, report credits, RIN number 
warnings, automatic backup at program exit, at what age people should be presumed 
dead, toolbar location, custom ID # setting, and toolbar picture size.  

 (Help index: Customize - other settings) 
 
 

Fixing Mistakes 
Removing an Individual 

 (Help index: Remove an individual) 

Unlinking a Child From Parents 

 (Help index: Unlink child from parents) 

Unlinking a Spouse 

 (Help index: Unlink spouse) 

Attaching a Child to Parents 

 (Help index: Attach child to parents) 

Attaching a Spouse 

 (Help index: Attach spouse) 

Swapping Husband and Wife 



 Other Features 

Legacy User Guide 217 

 

 (Help index: Swap husband and wife) 

Married to the Same Spouse More Than Once 

 (Help Index: Married to the same spouse more than once) 
 

Global Spell Checking 
You can have Legacy run through your entire family file and check the spelling on any 
note-type field. You can even stop and resume at will.  

 (Help index: Global spell checking) 
 

Master Lists 
Legacy keeps several master lists of commonly used information in a family file. For 
example, the Master Location List contains all the location names that are being used in 
the current family file. Legacy only records one copy of each location and points any use 
of it to its entry in the list. This saves a lot of disk storage space by eliminating 
duplications. 
 
To view a master list, choose Master Lists from the View tab of the Ribbon bar. 
 
Master lists have many great options that let you maintain the information in your file. 
See the following Help topics for more information: 
 
Master Address Lists   contains the records used for addresses in the family file. 

(Includes mailing addresses, event addresses, and repository addresses.)  

 (Help index: Master address list) 
 

Master Child-Parent Relationship List   contains the child-parent relationships in 
the family file. 

 (Help index: Master child-parent relationship list) 
Master Child Status List   contains the child status names in the family file. 

 (Help index: Master child status list) 
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Master Event Name Maintenance   contains the event names in the family file. 

 (Help index: Master Event Name Maintenance) 
 

Master Location List   contains the names of all the locations in the family file. Each 
location also has a Short Location Name, Location Notes, Pictures, Latitude and 
Longitude values, and a Verified tag. 

 (Help index: Master locations list) 
 

Master Marriage Status List   Contains the marriage status names in the family file. 

 (Help index: Master marriage status list) 
 

Master Media Folder List   Contains the drive and folder locations for all the picture, 
sound, and video files in the family file. 

 (Help index: Media: Locations) 
  

Master Source List   Contains the main source definitions that are cited from any 
piece of information in the family file. 

 (Help index: Master source list) 
 

Master Source Type List   Contains the names of all the source types (book, bible, 
newspaper, etc.) in the family file. 

 (Help index: Master source type list) 
 

Master Surname List   Contains all the surnames in the family file. 

 (Help index: Master surname list) 
 

Master Temple Name List   Contains the names of all the LDS temples in the family 
file. 

 (Help index: Master temple list) 
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Master To Do Category List   Contains the names of all the categories used in the To-
Do items in the family file. 

 (Help index: Master To-Do category list) 
 

Master To-Do Locality List   Contains the names of all the localities used in the To-
Do items in the family file. 

 (Help index: Master To-Do Locality List) 
 

Set Living Status 
There are several Legacy reports, plus web pages, where the privacy of anyone whose 
Living status is set to Yes is protected by suppressing all personal details. When creating 
these reports, no information is included for ancestors born centuries ago if they are 
inadvertently left set as Living. 
 
Normally, an individual’s Living status is set at the time the record is manually entered. 
The process is automatic if that person’s death or burial information is entered or that 
person’s birth or christening date is more than 120 years ago. If no birth, christening, 
death, or burial information is entered, that person’s status remains at the default Yes, 
unless manually changed to No. 
 
It is an easy task to set the Living status of a few individuals manually, but the task can 
become formidable when adding hundreds or thousands of new names to your family file 
with a GEDCOM import. This is where the Set Living and Advanced Set Living 
utilities come in handy. 

 (Help index: Set living) 

 (Help index: Advanced set living) 
 





Chapter 12 

Importing and Exporting Data 
Transferring Information To and From Other Programs 

 
 

What Is a GEDCOM File 
GEDCOM files are used to transfer genealogical information from one program to 
another. (See GEDCOM Files in the Help menu for more information.) Legacy imports 
and exports many different versions of GEDCOM files, recognizing nearly every 
variation from other programs. 

 

Tip: The Import Wizard makes importing GEDCOM, Legacy, and PAF files a 
snap. Just choose Import from the File tab of the Ribbon bar and then choose Use 
Import Wizard to help with any import from the dropdown menu. Legacy then 
searches all available drives for the file type you select and displays them in a list. 
Highlight the file you want to import and click Next. The rest is easy. 
 

 Importing GEDCOM Files 
To import a GEDCOM file into 
Legacy, choose Import from the 
File tab of the Ribbon bar and 
then choose GEDCOM File… 
from the dropdown menu. The 
first thing to appear is the Open 
File window.  You can either click 
the top button, Select the file 
using the Windows dialog box, 
and navigate to the GEDCOM file 
you want to import, or you can 
Have Legacy create a list of files 
to choose from, in which case Legacy will gather all the GEDCOM file names from your 
computer, show you a list, and allow you to 
choose which one to import.  If you know 
where the GEDCOM file is located, the first 
option is probably the quickest… 
 
 
After choosing the desired file to import, if 
the current family file contains existing 
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records, the Import a GEDCOM File dialog box appears and you can choose to either 
Create a NEW Family File and add the GEDCOM information to it (recommended) 
or Add the GEDCOM information to the EXISTING Family File.  Then click 
Proceed. 

 

If you are adding to your existing family file, Legacy prompts you to make a backup 
copy of it before starting the import. This is a wise practice and is recommended. If you 
are creating a new family file, you are prompted for a new filename.  The GEDCOM 
Import window now appears: 
 

 
 
Legacy first analyzes the GEDCOM file you selected to make sure it is valid and 
recognizable. This analysis pass also shows you how many individuals and families are 
contained in the file. If Legacy finds information that it does not know what to do with, a 
message is displayed. You can then tell Legacy where to put the information. (See 
Importing GEDCOM Files in the Help index for more information.) The submitter’s 
name, address, and comments are also displayed along with the name of the program that 
created the file. 
 
After the analysis pass, click Start the Import. Legacy reads the information from the 
GEDCOM file and places it in the appropriate family file. Anything that is not 
recognized is placed in an error file so you can see it later and decide what to do. 
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There are many options that can be used when importing a GEDCOM file.  See the help 
topic for complete information. 

 

 (Help index: Import, GEDCOM file) 
 

 

Importing Legacy Files 
You can import one Legacy family file into another or into a new, empty file. When 
importing a Legacy family file, incoming records can be filtered, limiting them to focus 
group entries or tagged records only. 
 
  To import a Legacy file: 

1. From the File tab on the Ribbon bar, choose Import and then choose Legacy 
family file... from the dropdown menu. 

2. Select the name of the Legacy file you want to import. 
3. Click OK. 
4. Decide if you want to import the Legacy file into the current family file or into a 

new family file, and click the appropriate button. If creating a new family file, 
Legacy prompts you for a filename before proceeding. Importing into a new file 
also allows Legacy to use the same ID numbers that were assigned to the 
individuals and marriages. If you import the records into an existing family file 
with existing individuals, Legacy may not be able to retain the incoming ID 
numbers because they might already be in use. 

5. Set or change any of the options. 
6. When you are ready to import, click Start the Import. Legacy imports the file 

while displaying a progress bar. 
7. When the import is complete, Legacy asks if you would like to go through the 

Merge process. This procedure compares all the individuals in the combined 
family file to see if any of them are really the same person. This can easily 
happen when you import additional names into your family file.  

 
Importing Options 

There are many options that can be used when importing a Legacy file.  See the help 
topic for complete information. 

 

 (Help index: Import, Legacy file, Importing a Legacy file) 
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Importing PAF Files 
Personal Ancestral File (PAF) is a popular genealogy program that used to be published 
by The Church of Jesus Christ of Latter-day Saints. Legacy directly imports PAF 2.31, 
3.0, 4.0, and 5.x files. 

 

  To import a PAF file into Legacy: 
1. From the File tab on the Ribbon bar, choose Import and then select the type 

of PAF file you would like to read. The File dialog box opens where you 
then select the PAF file you want to import. 

2. Specify the drive and path of the PAF file. PAF 2.31 only stores one family 
file in any particular folder. You will be looking for INDIV2.DAT. PAF 3.0 
and 4.0 store their information in files ending with a .paf extension. 

3. Decide if you want to import the PAF file into the current family file or into 
a new family file, and click the appropriate button. If creating a new family 
file, Legacy prompts you for a filename before proceeding. Importing into a 
new file also allows Legacy to use the same ID numbers that were assigned 
to the individuals and marriages. If you import the records into an existing 
family file with existing individuals, Legacy may not be able to retain the 
incoming ID numbers because they might already be in use. 

4. Set or change any of the options.  
5. When you are ready to import, click Start the Import. Legacy imports the 

file while displaying a progress bar. 
 

Importing Options 
There are many options that can be used when importing a PAF file.  See the help topic 
for complete information. 

 (Help index: Import, PAF file, How to import a PAF file) 
 

Import Wizard 
Use the Import Wizard to help with any import. 
1. From the File tab of the Ribbon bar, choose Import and then choose Use Import 

Wizard to help with any import. 
2.  From the Import Wizard dialog box indicate the type of file to import from the 

following items: 
a. PAF 2.31 or Ancestral Quest 2.x file 
b. PAF 3, 4, 5 or Ancestral Quest 3.x file 
c. Any GEDCOM file. 
d. Another Legacy family file 

3. Click the Next button 
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4. Legacy automatically searches your drives for all files of the selected type and return 
a list. 

5. Click once on the file you want to highlight it and then click the Next button. 
6. You are then prompted to either create a new file and add the information to it or add 

the information to an existing Legacy file. 
 

Merging Event Definitions 
The Merge Event Definition window appears when you are: 

 

 Importing the Master Event Definition List from another family file 
 Importing a GEDCOM file with event definition records 
 Combining duplicate location in the Master Event Definition List. 

 
And the information items are not all identical. 
 
This screen allows you to select or combine the differing information into each merged 
event definition record.   

 
To merge an event definition: 

1. Choose the desired fields to show.  (Choose from Description, Date and Place.) 
2. Edit the event sentence definitions.  If you want to copy the right definitions to 

the left, replacing them, click the  button. 

3. If you want to copy all the fields from the right record to the left, click . 
4. Click Save to save the merged event definition on the left. 

 

Automating the Merge 

 To always keep the existing definition information no matter what the other event 
shows, choose the Always keep the existing event definition option before saving 
the current record. 

 To always accept the incoming definition information, including its blank fields, if 
any, choose the Always overwrite the existing event with the incoming event 
option. 

 To copy information from the incoming event that is missing from the current event, 
choose the Always copy the incoming event items that are missing from the 
existing event option. 

 
Choosing one of these options effectively turns off the displaying of the Merge Event 
Definition window for the remainder of the current operation. 
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Exporting GEDCOM Files 
 If you want to send part or all of the information in your family file to someone who is 
not using Legacy, you can do so by exporting a GEDCOM file. (If you are sending all 
your information to someone using Legacy, the easiest way is to just send them a backup 
copy of the family file. If you want to send just part of the file, such as a particular person 
and their ancestors, you can tag those people and export a GEDCOM from them.) 

 

  To export a GEDCOM file from Legacy: 
1. From the File tab of the Ribbon bar, choose Export and then choose GEDCOM 

file from the dropdown menu. 
2. Select the type of GEDCOM file to produce. 
3. Click Record Selection to change the records you want to include in the file. 
4. Click Compiler to make sure the information about you - the submitter or creator 

of the GEDCOM file - is correct. 
5. If you want to change the default list of field information to be included in the 

GEDCOM file, click Customize. 
6. When you have made all the desired settings, choose Select File Name and 

START EXPORT. 
7. Select the folder where you want the file to be created and type a name into the 

File Name box in the upper-left corner of the window. Often, an appropriate 
surname or abbreviation makes a good file name. 

 

Producing a GEDCOM File 
For Legacy   GEDCOM files destined for Legacy contain ALL the information that 
can be entered into a Legacy family file. This includes all individual field 
information; all notes; all sources; all events; LDS ordinance dates and temple 
names; pictures; sound; video; list ordering and tags; as well as preferred children; 
spouses; and parents. This GEDCOM file conforms to the GEDCOM 5.5 
specification (with some extensions) and contains the most information. If you are 
exporting a GEDCOM file to be imported into Legacy or most other genealogy 
programs, with the exception of Personal Ancestral File (PAF), you should probably 
choose this option. 

For GEDCOM 5.5.1 Only   Many other programs do not have a place to put all the 
information that Legacy handles, and an error file is generated. If you would like to 
limit the export fields to mostly those accepted by other programs, choose this option. 

PAF 2.31 and PAF 3.0 / 4.0 / 5.0   Since Personal Ancestral File is now used in 
four different versions, 2.x, 3.x, 4.x, and 5.x, and since they each handle notes, 
sources, and repositories in radically different ways, it is necessary for Legacy to 
produce four special GEDCOM formats to satisfy the special needs of these 
programs. Select the desired format. 
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Pedigree Resource File   This format is used when contributing your information 
for inclusion in the LDS Church’s new Pedigree Resource File. This file is similar to 
the Ancestral File but the contributed files are left as received, and no attempt is 
made to link multiple files together. Submission can only be done through the 
Internet.   

 (Help index: Pedigree Resource File) 

Basic   This GEDCOM file contains only the vital statistics. This type of GEDCOM 
file contains name, sex, birth, christened, death, buried, and marriage information. 

Generic   This GEDCOM file contains name, sex, birth, christened, death, buried, 
marriage, user ID number, notes, sources, events, baptism, and marriage status. 

Ancestry Online Family Tree  This file contains individuals and marriages to be 
exported for uploading to Ancestry Online Family Tree. 

MyTrees.com  This file contains individuals to be exported for uploading to 
MyTrees.com. 

OneGreatFamily.com  This file contains individuals to be exported for uploading 
to OneGreatFamily.com. 

 
Exporting Options 

There are many options that can be used when exporting a GEDCOM file.  See the help 
topic for complete information. 

 

 (Help index: Export, GEDCOM files) 
 

Exporting to a Legacy File 
You can export a Legacy family file to create another Legacy family file or to append to 
another, existing family file. When exporting a Legacy family file, you can filter the 
outgoing records, limiting them to focus group entries or tagged records only. Since you 
can tag an individual and all his/her ancestors or descendants, this is a good way to break 
a large family file into smaller, more manageable pieces. 
 
  To export a Legacy file: 

1. From the File tab of the Ribbon bar, choose Export and then choose Legacy file 
from the dropdown menu. 

2. Select a name for the Legacy file you want to create or the Legacy file you want 
to append to. 
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3. Click OK. 
4. Set or change any of the options. (Each is described below.) 
5. When you are ready to export, click Start the Export. Legacy exports the file 

while displaying a progress bar. 
 

Exporting Options 
There are many options that can be used when exporting a Legacy file.  See the help topic 
for complete information. 

 

 (Help index: Export, Legacy files) 
 

 
 



Chapter 13 

Merging Duplicates 
Combining Two or More People Who Are Really the Same Person 

 
Introduction to Merging 

Legacy is unique from all other genealogy programs in the strength and flexibility of its 
merge program. Legacy offers the user complete control while combining records. We 
call it IntelliMerge™. 
 
As your family file grows larger, either by entering new individuals and families, or by 
importing other family files and GEDCOM files, you may find that you have some 
people in your file more than once. You can either edit the two individuals manually, 
trying to also take into account any children, spouses, and parents, or you can use 
Legacy’s powerful merge capabilities. In fact, it is suggested that you do not try to 
manually combine individuals who are linked to other relatives. It can be very frustrating 
and can lead to a jumbled mess. 
 
The whole concept underlying the merge capability in Legacy is the process of 
integrating duplicate records as a result of importing records from another GEDCOM or 
PAF file with the existing records in the current family file. (Or from entering a person 
more than once.) This process is a very sensitive one because it ultimately means that the 
current family file, when the merge is complete, is changed to reflect the combination of 
the new information. 
 
In many instances, one record will contain duplicate—and possibly enhanced—
information on an individual or marriage in the current family file. Because of this, it is 
essential for the user to have the option to review both the current data and the imported 
data on a screen where both can be observed at the same time.  
 
All of the above must be addressed, and decisions must be made and plans implemented 
in order to achieve a successful merge of data. By letting Legacy help you do these tasks, 
hundreds of hours can be saved over inputting the data manually.  
 
Sound judgment suggests that the user make a backup of existing data before 
implementing any merge. This can be accomplished by using the Backup File option on 
the File tab of the Ribbon bar. 
 
Legacy offers several methods to merge records in a family file. These include Manual 
Merge, where you initiate the process by selecting two individuals; Find Duplicates, 
where Legacy starts the process by comparing all the individuals in the entire family file 
and creating a list of possible duplicates; and IntelliShare™, which lets you share your 
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family file with others and then integrate all the changes made by the various people back 
into the master file. 
 
The merge process is exactly that—a PROCESS. Rarely do you just combine two people 
together. Most often it involves connections to other individuals such as children, 
spouses, siblings, and parents. It is important to properly handle the surrounding links, 
and the links surrounding the links, and so on.… Legacy is an expert at the merge 
process. When you tell the program to combine two people, Legacy looks around to see 
who else should be considered for a merge. It then automatically adds them into the 
process. This goes on until all the associated links have been handled. You may begin by 
thinking that you are going to merge only two individuals, but you end up merging an 
entire family line. This is the only way to do it correctly.  
 
For example: Let’s say you notice two men in your family file who you think are the 
same person, William Johnson and Will Johnson. You start a merge process by clicking 
Merge. Legacy compares the two individuals and shows you the differences, if any, 
between the information contained in the two records. After looking the information over, 
you decide that they are indeed the same person and click Merge Right Individual Into 
Left Individual to combine them. Legacy takes a look around and notices that William 
has two parents linked to him, named Daniel Johnson and Mary Anderson. Will Johnson 
has two parents, named D. Johnson and Mrs. Johnson. These two sets of names look like 
they could be the same parents, so Legacy adds them into the merge process. The next 
two people to be displayed are Daniel Johnson and D. Johnson, and then Mary Anderson 
and Mrs. Johnson. The process is continued until all possible duplicates in that line are 
presented. This goes also for ancestors, siblings, spouses, and children. The end result is a 
combination of names, information, and links for everyone in the line who is related. 

 

Manual Merge 
If you have come to the Merge Two Individuals window by clicking the Merge 
Duplicates button on the Tools tab of the Ribbon bar and then choosing Manual Merge 
from the dropdown menu, the current individual is automatically loaded on the left side. 
You must now select the second individual by clicking the Select Right button and 
choosing the name from the Name List. After selecting the right individual, the merge 
procedure can progress as outlined in the Merging Two Individuals section on page 232. 

 

Finding Duplicates 
Click the Merge Duplicates button on the Tools tab of the Ribbon bar and then 
choosing Find Duplicates from the dropdown menu. 
  



 Merging Duplicates 

Legacy User Guide 231 

 

Merge Options 
There are many options that can be used when merging.  See the help topic for complete 
information. 

 

 (Help index: Merge, Options) 
 

Special Searches  
The Special Searches screen allows for specific matching on Ancestral File Numbers, 
User Reference Numbers, and IntelliShare numbers. 

 

Three special-case searches are provided by Legacy. The first two processes only look at 
the Ancestral File Number or the User Reference Number when determining matching 
individuals. No other information is used. If you are not using either of these number 
fields, these special searches won't be of any use. 

 

Ancestral File Numbers   are assigned by The Church of Jesus Christ of Latter-
day Saints (Mormon) to all records submitted to them. When this data is compiled it 
is provided on CD-ROM to the Family History Centers located throughout the world. 
Data acquired from these locations or from the Church Family History Center in Salt 
Lake City, Utah all contain an Ancestral File Number.  

User Reference Numbers   can be assigned by the individual within the program 
for accommodating special needs. 

IntelliShare Numbers  are unique numbers assigned to each individual in your 
family file as you enter and import records.  When merging, any two records with the 
same IntelliShare numbers are considered the same person. 
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Merging Two Individuals 
From the Merge Options window, click Continue. The Merging Two Individuals window 
appears. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

What Does This Window Show? 
The Merging Two Individuals window shows two individuals side-by-side who could 
be the same person. There are nine tabs across the top, corresponding to the various 
pieces of information both individuals have. When a pair is first displayed, the 
General tab is selected automatically.  

 
The record of the individual shown at the left of the screen is the one that will 
ultimately remain in the current family file. The individual on the right, if the two are 
merged, will be combined with the left.  

 

Below the tab pages are several command buttons and a checkbox: 
 

Edit Left   displays the Information window for the individual on the left, allowing 
you to edit his or her information. 

These ten tab pages show you all the 
information you need in order to decide if the 

two people are really the same person. 

This box shows the information 
that is different between the two 
individuals. 

Use these 
buttons to copy 

the other 
information you 
want to keep to 

either Notes, 
Alternate 

Names, or 
Events. 
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Select Left   lets you change the left person to someone else if you are in manual 
merge mode. (This button is not visible if you are doing automatic duplicate 
searching.) 

Swap Left / Right   trades the positions of the two individuals. The person on the 
right moves to the left side and the person on the left moves to the right. (The person 
on the left is always the individual who is retained. The information and links from 
the person on the right are merged into the left.) 

Edit Right   displays the Information window for the individual on the right, 
allowing you to edit that information. 

Select Right   lets you change the right person to someone else if you are in manual 
merge mode. (This button is not visible if you are doing automatic duplicate 
searching.) 

Merge Right Individual into Left Individual   performs the actual merge 
operation. The information that has been selected from the person on the right is 
moved into the record of the person on the left. The relationship links from the 
person on the right are also moved to the person on the left. The person on the right is 
then deleted from the family file. This button should only be clicked after you are 
sure you want to merge the two individuals. If there are any questions as to whether 
these are indeed the same person, you should do more research before merging them. 

Skip to Next   skips the current pair of individuals and moves to the next pair of 
possible duplicates. (This button is only visible if you are doing automatic duplicate 
searching.) 

Back   displays the most recently skipped pair of individuals. Successive clicking of 
this button moves back through all the skipped pairs. (This button is only visible if 
you are doing automatic duplicate searching.) 

Not Duplicates   indicates that the two individuals are not the same person.  
They are added to the Not Duplicates list and are not shown in subsequent merge 
sessions. 

Options 

Print:  You can print a Family Group Record or Individual Report for the current 
pair of individuals.  This may help you decide if they are the same person.  (See 
Merge Information Report for more details.) 

Mark this pair as ‘Not Duplicates:  There always seems to be some pairs of 
individuals in your family file that have similar names and vital information.  
When merging duplicates these pairs get displayed every time.  You know they 
are different people and just wish they could be marked as such and left out of 
the merge process.  This option lets you mark the currently displayed pair of 
individuals as not being duplicates.  After doing so they will not be displayed in 
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the future when you are merging duplicates.  (You can remove pairs from the Not 
Duplicates list whenever you want.) Alt -X is also available as a shortcut key for 
this feature.   (Deluxe Edition only.) 

Display the ‘Not Duplicates’ List…  shows the list of people currently marked 
as not being duplicates.  (See Not Duplicates List for more information.)  
(Deluxe Edition only.) 

Zoom  lets you change the font size in the list windows. 

Close   stops the merge process and returns to the Family/Pedigree screen. Your 
location in the merge process is saved to disk so that you can resume the process at a 
later time. Remember, merging records is a process that must be completed from 
beginning to end in order for the operation to be successful. If you Close in the 
middle of a merge, Legacy asks if you would like to continue at a later time. 
Answering Yes causes Legacy to save the current location. Later, when you choose 
Merge Duplicates > Find Duplicates from the Tools tab of the Ribbon bar again, 
Legacy shows the following message: 

 

Print  prints a Family Group Sheet or Individual Report for the current pair of 
individuals. This may help you decide if they are the same person. 

Help   displays the Help system, which shows information regarding the topic on the 
screen. 

AutoMerge   automatically merges when the information for two individuals is 
complete enough and matches exactly. If this option is checked, Legacy will ask you 
if you would like to use the AutoMerge option when the first pair that is eligible for 
auto-merging appears. 
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General Tab 

 
 
This tab shows two individuals from your file including names, and when they were 
born, christened, died, and buried. It also shows the preferred spouse’s name and the 
preferred parents. Below this information is the Fields that are different box. This 
section shows a list of all the information that is different between the two 
individuals. Each piece of information has an option button to the left of it. The 
option button shows which piece will be kept. You can change the settings by 
clicking on the option button next to the information you want to keep. If the list is 
taller than the box, a scroll bar appears to the right, which can be used to display 
subsequent information. 

 

Preserving Information 
When you are merging duplicate individuals, you will often want to save some of the 
information from the person you are deleting. Legacy allows you to copy this 
information to several different places, depending on what kind it is. This is done by 
clicking the small black button to the left of the desired field in the Fields that are 
different window. This opens a shortcut menu asking where you would like to copy 
the information. 

 
Names   You can either create an entry in the Alternate Names list or copy the name 
to the General Notes field. 
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Birth, Christening, Death, and Burial Information   You can create an Event 
entry made up of the date and place, or you can copy the information to the General 
Notes field. 

 

 To copy a piece of information: 
 
 
 
 
 
 
 
 
 

1. Click the small black buttons to the left of the information in the Fields that 
are different box. Only lines that can be copied will have the button.  

 
A shortcut menu appears with the 
appropriate choices. 

 
2. Select the destination field for the 

information. Only the allowable 
destination fields will appear on the shortcut menu. The information that is 
not marked to be kept (the empty option button) is then copied to the selected 
destination. 
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Family Tab 
This screen shows all the surrounding relationship connections to each person. It 
includes the parents, siblings, spouses, and children. This information is often very 
helpful when trying to determine if the two individuals are the same person. The 
birth, christened, death, and buried information for the currently highlighted person is 
displayed below the list.  
 
 

 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If the highlighted line is a marriage with two names on it, one of the option buttons below 
the list indicates whether the mom’s or dad’s information is shown. Click the other option 
button to switch to the other person. Other buttons let you edit the Marriage, Dad, Mom, 
Children, Siblings, or Self. 
 
Note:  Sometimes you will notice duplicate parents, spouses, or children in the Family 
List. Don’t be alarmed; this is common while you are in the middle of a merge process. 
These duplicates will be reconciled later as you continue on. 

Click to show the 
Father’ information 
below. 

Use these buttons to 
edit the Mother’s or 
Father’s information. 

Click to edit the marriage 
information for the highlighted 
person. 
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Events Tab 
This screen shows a list of all additional events recorded in each person’s record. As 
you click each event line, the details of that event are displayed below the list. Using 
the buttons at the bottom of the screen you can perform the following functions: 

 
Edit Left   allows you to edit the left, highlighted event. (Any event can be 
highlighted by clicking it.) 

Delete Left   deletes the highlighted event in the left window. 

Delete All Left   deletes all the events in the left window. 

Copy   copies the highlighted event from the right window to the left window, 
adding it to the end of the list. 

Copy All   copies all the events from the right window to the left window, adding 
them to the end of the list. 

Edit Right   allows you to edit the right, highlighted event. 
 

Event Sources 
You can view, add, edit, or delete the source citations connected to the events on 

the left or right side by clicking the corresponding Source  button. 
  

Pictures Tab 
This screen shows any pictures that have been attached to each individual, along with 
their captions, dates, and descriptions. If a sound file is connected to a picture, it is 
shown also.  

 
Using the buttons at the bottom of the tab you can: 

 

Edit Left   allows you to edit the left, highlighted picture. (Any picture can be 
highlighted by clicking it.) 

Delete Left   deletes the highlighted picture in the left window. 

Delete All Left   deletes all the pictures in the left window. 

Copy   copies the highlighted picture from the right window to the left window, 
adding it to the end of the list. 

Copy All   copies all the pictures from the right window to the left window, adding 
them to the end of the list. 

Edit Right   allows you to edit the right, highlighted picture. 
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Notes Tab, Research Tab, Medical Tab 
The Notes, Research, and Medical tabs display the various Note fields associated 
with each individual. Using the buttons at the bottom of the tabs you can: 

Delete Left   deletes the contents of  the Notes field on the left. 

Replace   copies the note from the right window to the left window, replacing the 
contents of the left note. 

Append   copies the note from the right window to the left window, adding it to the 
end of whatever is in the left window. 

The Research tab has a To-Do button for each individual allowing you to add to-
do items for further research. 

The Medical tab also shows the Cause of Death field. There is a Copy button 
between the two individuals that allows you to copy the contents in the right field to 
the left field, replacing whatever is in the left field, if anything. 

 

Addr/Ref # Tab 
The Address / Reference tab shows the Ancestral File Number, User Reference  

Number, and the address entry for each individual.  
 

Using the buttons at the bottom of the tab you can perform the following functions: 
 

Edit Address   allows you to edit the address entries above the button. 

Delete Left   clears the contents of all the address and phone fields on the left. 

Copy Addr   copies the contents of  all the address and phone number fields from 
the right window to the left window, replacing the contents of the left address. 

 

Between the individuals shown on this tab is a  button that can be used to copy 
the contents of the corresponding right field to the left, replacing it with the contents 
of the right field, if anything. 

 

LDS Tab 
This tab shows the LDS ordinance date and temple fields for each individual, if used.  

 
Using the buttons at the bottom of the tab you can perform the following functions: 

 

Edit Left   allows you to edit the LDS ordinance fields on the left. 
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Delete Left   clears the contents in the current, highlighted ordinance field on the 
left. 

Copy All   copies all the ordinance information from the right window to the left 
window, replacing the contents of the left fields. 

Edit Right   allows you to edit the LDS ordinance fields on the right. 
 

IntelliShare 
Legacy has a great feature called IntelliShare. It is used when you want to share your 
family file with another person or group of people, and lets you quickly combine the 
changes made by anyone in the group without having to stare at endless duplicates on the 
screen as you merge. 
  
Here is how IntelliShare works:  

One person in the group is designated as the “keeper of the records” (keeper, for 
short).  
 

1. The keeper, sends a copy of the family file to all the other members of the 
group participating in the process.  

2. Any or all members of the group can make changes to existing records and 
add new records to the family file.  The keeper can also make changes and 
additions to the master file.  

3. At an agreed upon interval, all members of the group return their copies of 
the family file to the keeper, who will merge and reconcile.  

 
The keeper then follows this procedure: 

  To merge and reconcile: 
1. Import all copies of the family file into the master copy. 
2. Click Merge and choose Find Duplicates. 
3. From the Merge Options window, click the Special Searches tab and choose the 

IntelliShare option. 
4. Click Continue in the upper-right corner of the Merge Options window. Legacy 

searches for all records with matching IntelliShare values and then automatically 
merges those that have exactly the same information. At the end of this process 
Legacy displays the records in which changes have been made by one or more 
persons. 

5. Merge the records.  (See page 232.) 
6. After the merge is complete, send the family file back to the other group 

members for future changes and additions. 
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Undoing a Merge 
There may be times when you want to start all over again. Either you merged two people 
who were not really the same person, or you want to go through it all again to make sure 
you saved the correct information in the correct places. Either way, if you stop in the 
middle of a merge and don’t ever intend to complete it, you should restore from the 
automatic backup that was made when you started. This option is available by choosing 
Undo Merge from the Edit tab of the Ribbon bar. Legacy asks you to confirm the 
restoration from backup and then returns the family file to its condition before the merge 
process started.  
 
 





Chapter 14 

Pictures, Sounds, Videos & More 
A Picture Is Worth a Thousand Words, Especially if it Can Talk 

 
You can attach any number of pictures, sound files, video files, web sites, and other types 
of files to any individual, marriage, event, source, location, or address repository in your 
family file. Legacy reads all popular file formats. These can then be displayed at any time 
and the pictures can also be included in many printed reports. 
 
When Legacy is installed, a folder called Media is created within the Legacy Family 
Tree folder in your My Documents folder. It is strongly recommended that this folder be 
used to store the pictures, sounds, videos, and other documents. 
  
It should be noted that Legacy does not create pictures. Pictures must be scanned by 
using a quality scanner, or supplied from another source such as a digital camera, or 
downloaded from a web site or sent to you by e-mail, etc. 
 
It should also be noted that in order to add and edit sounds, the computer must be 
equipped with a sound card. A microphone must be plugged into the sound card or USB 
port in order to record sound files. 

 

Adding Pictures 
You can add links to picture files for each individual or marriage, to events, sources, and 
addresses. There are two processes you can use to add pictures. The first is to use the 
Media Gallery, the second is to use the Picture Center. The Media Gallery method is 
done from a specific individual, marriage, or event and involves selecting pictures (or 
sounds, videos, documents, or web links) that you want to link to that particular person, 
marriage, or event. The second method, using the Picture Center, involves viewing a list 
of all the individuals and all the pictures, and indicating which pictures go where. The 
Picture Center lets you easily attach a lot of pictures to a lot of people, marriages, and 
events in a short amount of time. 

 

Media Gallery 
Adding Pictures (or other media files) 
  To add a picture to an individual: 

1. From the Family View, make sure the individual is in either the Husband or Wife 

box and then click the Media  icon on their individual toolbar. (That is the 
button with the picture of two people.) The Media Gallery appears. 
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The Media Gallery displays from one to nine pictures or other types of media 
files at a time, although you can have an unlimited number of media files 
attached to each individual.  

2. Click the Add Media… button and choose Picture (or Sound, Video, 
Document, Web Link). This opens the Load Picture window. Locate and select 
the name of the picture you want to add and then click OK. Legacy now asks if 
you would like to copy the file to the Media Folder.  (This is a way to keep all the 
media associated with your family file in one place, making it much easier to 
share your family file with others or to copy everything to a different computer.)  
After answering the question, the picture is loaded and appears in the Display 
Picture window. 

 

The Display Picture window lets you view an enlarged picture and allows you to 
add a caption, date, and description. You can also attach sound files, change the 
picture attributes, and convert the picture file to a different format.  

3. Click Close to return to the Media Gallery.  
 
You can continue adding new pictures or other media files using the procedure 
above. 
 
As mentioned, you can also add sound files, video clips, documents, and web links.  
These, of course, do not print on reports but they are invaluable additions to the items 
they are linked to.  Sound and video clips can be subsequently played by your default 
media player.  Documents are opened in the program associated with the file type of 
the document (word processor, spreadsheet, PDF viewer, etc.).  Web links are opened 
in your default browser. 

 
Deleting Pictures 

  To remove a picture from the Media Gallery: 
1. Highlight the picture by clicking in the Caption area below the picture. 
2. Click Remove. Legacy prompts for confirmation and then unlinks the picture 

from the individual. The media file itself is not deleted ... only the reference 
link is erased. 

 
Reordering Pictures 

You can move pictures from one position to another by dragging them with the 
mouse. With the cursor over a picture, hold down the left mouse button  and drag it to 
a new location.  Releasing the mouse button puts the dragged picture in its new 
location and moves the other pictures one place over to make room. 
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Setting the Preferred Picture 
When you first begin adding pictures, the picture in the first position is considered 
the preferred picture. This picture is displayed on the Family View and Pedigree 
View whenever the individual is current. The preferred picture is also printed on 
reports that include pictures. To mark a different picture as preferred, right-click on it 
and then choose Set as Preferred from the popup menu. An asterisk appears in front 
of the picture number.  

 
Displaying and Editing a Picture 

To see an enlarged view of a picture, right-click on it and choose Edit from the 
popup menu. The picture is loaded into the Display Picture window. From there you 
can add a caption, date, and description to the picture. You can also change picture 
attributes such as brightness, sharpness, and contrast as well as rotate, zoom and crop 
the picture. 

 
Adding Sound to a Picture 

Legacy supports sound files in two ways. First, a picture can have a sound file linked 
to it. Second, sound files can be added to an individual without tying them to 
pictures.  
 
  To add a stand-alone sound file to an individual: 

1. Click the Add Media button and choose Sound. 
2. Specify the location of the sound file.  

 
  To link a sound file to a particular picture: 

1. Right-click on the picture and choose Edit from the popup menu. 
2. From the Display Picture screen, click the Sound button. (See Adding and 

Recording Sounds on page 282 for more information.) 
 

If you have a sound file attached to a picture, you can play it by highlighting the 
picture and then clicking the Options button and then choosing Play.  

 
Adding Video to an Individual 

  To add a video file to an individual: 
1. Click the Add Media button and choose Video. 
2. Specify the location of the file.  

 
To play a video file once it has been added, highlight it and then click the Options 
button and then choose Play. 
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Adding Other Documents to an Individual 
  To add a document or other type of file to an individual: 

1. Click the Add Media button and choose Document. 
2. Specify the location of the file.  

 
Note that documents and other types of files that are attached in this manner will not 
be included on report or web sites.  They are simply for documentation purposes.  To 

open a document, double-click on the  graphic representing it. 
 
Adding Web Site Addresses to an Individual 

  To add a web site URL to an individual: 
1. Click the Add Media button and choose Internet Website. 
2. Fill in the website URL, date, and description fields and then click OK. 

 
Note that website documents and other types of files that are attached in this manner 
will not be included on report or web sites.  They are simply for documentation 

purposes.  To display a linked web page, double-click on the  graphic 
representing it. 

 
Zooming In and Out 

To take a closer look at a picture, highlight it and click Zoom.  
 

Showing More Pictures 

The Media Gallery can display from 1 to 9 pictures at a time. Use the  
slider control to display more or fewer pictures. 

 
Creating a Slider Show 

To start a sliding picture show that contains all the pictures in the Gallery, click the 
Options button and then choose Slider Show. 

 (Help index: Picture: Scrapbook options) 
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Creating a Slide Show 
To view a sequential slide show of all the pictures in the Media Gallery, along with 
their sound files, click the Options button and then choose Slide Show.  (See Slide 
Shows on page 284 for more information.) 

 (Help index: Picture: Scrapbook options) 
 
Printing a Photo Album 

To print all the pictures in the Media Gallery, click the Options button and then 
choose Photo Album. The Photo Album Options window appears, where you can 
select the type of photo album layout you want to print. (See Photo Album on page 
284 for more information.) 

 (Help index: Picture: Scrapbook options) 
 

Tagging Pictures 
The checkbox above the upper-right corner of each picture is used to tag or untag the 
picture. Tagging is useful when you want to select specific pictures to be printed on 
reports or displayed in screen shows or slide shows. 

 
Resizing the Window 

You can stretch the Media Gallery window by dragging its edges and corners. The 
picture boxes automatically resize when you do this. Legacy remembers the size and 
location of the window from session to session. 

 

The Display Picture Window 
Adding a new picture or editing an existing picture is done from the Display Picture 
screen. 

 
Loading a Picture 

  To load a picture into the main window: 
1. Click Load New. The Load Picture dialog box appears where you can 

specify the picture file you want to view. As you scroll through the available 
picture files, they are displayed in the window to the right so you can make 
sure you are selecting the correct one.  

2. Click OK when you have found the desired picture. 
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Color Versus Black and White 
Legacy supports the displaying and printing of both color and black and white 
pictures. Color pictures can be converted to gray scale (black and white) by clicking 
To Gray Scale. This is often necessary if you are printing reports with pictures on a 
non-color printer. Color pictures sent to a black and white printer often come out 
looking muddy and washed out. 
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Supported Formats 
Legacy supports the loading, displaying, and converting of the following common 
picture file formats, as well as about 30 others: 

 
 Bitmap (.bmp) 
 PCX (.pcx) 
 Tiff (.tif)  (without LZW compression) 
 PICT (.pct) 
 JPEG (.jpg) 

 
Zooming In and Out 

Use the Zoom In and Zoom Out buttons to vary the magnification of the picture. To 
adjust the size to exactly fit in the window, click Fit in Window. To view the picture 
at 100% of its actual size, click 100%. To zoom in to a particular area of a picture, 
click Zoom Area and then drag the mouse cursor over the area you want to magnify. 
When you release the button, the area within the drag rectangle is enlarged to fit the 
window. 

 
Printing the Picture 

Click Print to print the picture on your printer. A Print Size dialog box appears, 
where you can select the size you want to print the picture. This can be from full page 
to 1/8th page. When printing a picture, be patient. Some high resolution pictures can 
take a few minutes to print. 

 
Converting to a Different Format 

After loading a picture, you can save it again in a different format. Click Save As. 
The Save Picture dialog box appears. Click the Down arrow on the Save File as Type 
combo box. Select the file format you want to convert to and then enter a file name. 
Click OK to complete the conversion. 

 
Editing a Picture 

There are several attributes of a picture that can be permanently changed. These 
include brightness, sharpness, contrast, rotation, and color. 

 
Brightness, Sharpness, and Contrast 
Pictures that look blurry, dull, or washed out can be touched up to improve their 
appearance. Click Picture Attributes to see the Adjust Display Attributes window. 
Adjust the brightness, sharpness, and contrast controls and click Apply to see the 
effect on the picture. When you are happy with the changes, click OK. For the 
changes to be permanent, you must resave the picture by clicking Save As. 
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Rotating, Flipping, and Flopping 
You can rotate a picture in 90-degree increments by clicking Rotate 90 Deg. This 
may be necessary if a picture was scanned sideways or upside down. 

 
Click Flip to reverse a picture from left to right. Click Flop to reverse from top to 
bottom. For the changes to be permanent, you must resave the picture by clicking 
Save As. 

 
Changing a Picture to Black and White 

To convert a color picture to grayscale (shades of black and white), click To 
Grayscale.  To retain the grayscaling, you must save the picture. 
 

Reloading a Picture 
Sometimes the changes you make to a picture make it look worse rather than better. 
If you make changes that you don’t want to keep, click Reload Original to reload the 
original picture from disk. 

 
Adding Sound Files 

You can add a sound file to the current picture by clicking Sound. (See Adding and 
Recording Sounds on page 282.) After a sound file is attached to a picture, you can 
play it by clicking Play. 

 

 (Help index: Recording sounds) 
 

Cropping Pictures 
If you want to select a portion of a picture and then crop it to show only that area, 
click Crop. The mouse cursor changes to a crosshair. Select the desired portion of 
the picture by dragging the cursor over it. As soon as you release the mouse button, 
the rest of the picture outside the rectangle disappears, leaving only the selected 
portion of the picture. If you want to change the position or size of the selection, click 
Fit to restore the original picture and try again. When you are satisfied that the 
selected portion is the only part you want to keep, click Trim. The picture then grows 
to fill the screen. It has been cropped and trimmed but it has not yet been saved. If 
you want to start over again, click Reload Original. If you want to keep the cropped 
picture you must save it; click Save As and choose a name and location. Don’t save it 
over the original picture unless you don’t want the original anymore. 
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Saving the Changes 
When you have made changes that you want to keep, you must save the picture to 
disk. Click Save As and save the picture to whatever format you desire. This can be 
to the same format and filename as the original, or to either a different name, or 
format, or both. 

 
Saving a Picture to a New Format 
You can convert any picture into another format by selecting the format from the 
Save as type drop-down box on the Save File dialog box. The list includes Bitmap 
(.bmp), PCX (.pcx), Tiff (.tif) and JPEG (.jpg). After selecting the format type, click 
Save.  

 
When you are through making changes to the picture, click Close to return to the 
Media Gallery. 

 

Picture Center 
The Picture Center in Legacy is a very easy way to link many pictures to many 
individuals from one place. You will often come upon pictures in groups that you want to 
link to the people in your family file. For example, you might have a box or picture 
album of many pictures that you then scan into your computer. The pictures are 
associated with several different individuals. The Picture Center lets you link each 
picture to as many people in your file as your picture relates to—from one convenient 
place within the program. 
 

To reach the Picture Center, choose Picture Center  from the Tools tab of the 
Ribbon bar. 
 
In its simplest form, there are three main sections to the Picture Center screen. On the 
left is a list of all the individuals in your family file. In the middle is a list of the pictures 
on your computer. On the right is a preview window showing the highlighted picture.  
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  To assign a particular picture to a specific individual: 
1. In the left window, highlight the individual. 
2. In the upper-center window, find and highlight the desired picture. 
3. Click Attach near the lower-right corner. This adds the picture to the individual’s 

picture list. 
 
There are many options associated with this process. These are described below: 
 

The Name List 
By default, the Name list shows everyone in your family file. You can choose to 
show just the names that are in the current Search List by selecting the Search List 
option above the list.  
 
The Find box above the list lets you quickly jump to anyone in the list by typing part 
or all of their name. Enter the name with the surname first, followed by a comma and 
then the given name(s). The highlight line jumps to the nearest match as you are 
typing. 

 

Active Pedigree Chart 
Below the Name list is a two-generation pedigree chart showing the currently 
highlighted person and his or her parents. You can jump to either parent by clicking 
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their names. There is also a button to the left of the main person. If the button is blue 
then it means that person has children and clicking the button takes you to the 
preferred child. 

 

The Picture List 
The Picture Filename list shows all the supported picture, sound, and video file 
formats supported by Legacy. The current folder name is shown in the title bar of the 
window. You can change to a different folder by clicking Browse above the list. To 
choose a particular picture, sound, or video, highlight the name by clicking on it. If it 
is a picture file, the picture will display in the preview window to the right (if you 
have the Picture List tab selected). 

 
The U column to the left of the picture filenames indicates whether or not each 
picture has been assigned to someone in your family file already. The + means that 
picture in that folder has been assigned to someone. The – means that file name has 
been assigned to someone but from a different picture folder. For example, you may 
be looking at grandpa.bmp in the Legacy\Pictures folder but another file called 
grandpa.bmp in the Legacy\Reunion\Pictures folder is currently being used 
somewhere in your file. (You should be careful not to have different picture files with 
the same name located in different folders. It will surely confuse you at some point… 

 

Assigned Pictures 
Below the Picture Filename list is the Assigned Pictures list. It shows a list of all 
the events for the currently highlighted person and any pictures that have been 
assigned to those events. You can view the pictures from this list by first clicking the 
Assigned tab in the upper-right corner of the window, and then clicking on the 
desired picture name in the list. The complete filename for the highlighted picture, 
including the folder where it is stored, is displayed along the bottom of the window. 

 

Previewing the Pictures 
 

The Picture List Tab 
When the Picture List tab is selected, you can preview the pictures that are 
highlighted in the Picture Filename list to the left. When a picture is displayed, 
there are several options available: 

 

Zoom   opens a QuickLook window showing a larger view of the current picture. 
This window can be stretched to the full size of your monitor if desired. Click the 
X in the upper-right corner to close the QuickLook window. 

Rename   allows you to change the name of the currently highlighted file in the 
Picture Filename list. The file is then renamed on disk. If the file has a + in the U 
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column, any links to this picture within your family file are also renamed to 
match the change you made. 

Delete   erases the currently highlighted picture file in the Picture Filename list. 
After confirmation, Legacy erases the file from the current folder. If any links to 
this file exist in your family file, they are removed. (If the picture is linked to 
anyone in a different family file, deleting the file will cause a “picture file not 
found” error when trying to access it from there.) 

Caption, Date, Description, User File Number   displays a window where 
you can enter caption, date, and description information before assigning a 
picture to an individual. There is also a field for a User File # if you are assigning 
these numbers to your pictures. These entries are remembered by Legacy for 
future use even if the picture has not yet been assigned to anyone. 
 

The Assigned Tab 
Clicking on the Assigned tab lets you view pictures that have already been linked 
to the current individual. 
 

Zoom   (Same as Zoom on the Picture List tab.) 

Rename   (Same as Rename on the Picture List tab.) 

Remove   unlinks the currently highlighted picture in the Assigned Pictures 
list from the current event in the list. It does not delete the file from the disk. 

Caption, Date, Description, User File Number   allows you to view 
and edit the caption, date, description, and user file number entries for the 
current picture. 

Set Preferred   lets you change the preferred picture setting for any event 
that has more than one picture assigned to it. (The preferred picture is the one 
that prints on reports.) 

Changing the Order   lets you change the picture order by using the up 
and down Order arrow buttons. Highlight the filename you want to move and 
click the appropriate arrow to change its position up or down. You can also 
move a picture from one event to another using these buttons. If a filename is 
at the bottom of the event section, clicking the down arrow moves the picture 
down to the first position in the next event. The up arrow moves a picture to 
previous events in the same manner. 

 
 

Attach 
Clicking Attach links the highlighted current picture in the Picture Filename list to 
the highlighted current individual in the Name list under the event that is highlighted 
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in the Assigned Pictures list. The caption, date, description, and user file number 
from the Picture List tab go along with the assignment. 

 
  To assign a picture to more than one individual, for example to each person in a 

family reunion photo: 
1. Highlight the desired picture in the Picture Filename list. 
2. In the Picture List tab, fill in the caption, date, description, and user file number 

as desired. 
3. In the Assigned Pictures list, highlight the event where you want to place the 

picture. 
4. Click Assign. 
5. Highlight the next person. 
6. Click Assign again. 
7. Repeat steps 5 and 6 until the picture has been assigned to the desired group. 

(You can change the caption, date, and description fields between each 
attachment if needed, for instance, to say “Martha is the first person on the left” 
in Martha’s description and “Ted is the second person from the left” in Ted’s 
description, and so on.) 
 

Zoom 
The Zoom button to the right of the Attach button is used to select the font size used 
in the various lists of the screen.  

 

Close 
To close the Picture Center, click Close. All captions, date, descriptions, and user 
file numbers that you filled in while in the center are remembered and will appear the 
next time you open the center. 
 





Chapter 15 

Searching for People 
How to Locate Individuals and Families 

 
Overview of Searching 

Legacy includes powerful search capabilities. You can find anyone in the family file 
using any type of information. This includes names, dates, locations, and notes, as well as 
information in many other fields. You can look for field contents that begin with certain 
text or field contents that contain a word or phrase anywhere in that field. You can also 
create groups of information through the search option, such as a list of all people who 
were born in London, England, or a list of all people who died of cancer. Once a search 
group is found, you can quickly move from person to person, viewing or editing. Search 
groups are even remembered between sessions. 
 
The search feature can be reached by either choosing Find from the Search tab of the 

Ribbon bar, or by clicking the Search  button on the My Toolbar tab of the Ribbon 
bar. The Search window contains six tabs, Query by Example, Detailed Search, 
Miscellaneous Searches, Missing Sources, Missing Information, and Census List. 

 

Query by Example Tab 
Query by Example is an easy fill-in-the-blanks type of search. 
 
  To query for information: 

1. Fill in one or more fields with the information you want to find. 
2. Select Male, Female, or Either. 
3. Select one of the How to Find options. Exact looks for only what you typed 

(searching for a last name of Roberts will find only Roberts, not Robertson). 
Starts With finds records where the information starts with what you typed 
(searching for a given name of “B” will find all names that begin with B). 
Anywhere in field looks for what you typed at any position within the field 
(searching for “abe” would find Abe, Abel, Mabel, Faber, etc). 

4. Click Find First to look for the first matching record, or Create List to generate 
a Name List of all the records that match the search criteria. 

 

If you clicked Find First, the record is immediately shown in the Family View or 
Pedigree View. If you clicked Create List, you can display any of the resulting records 
by highlighting a name and clicking Select, or by double-clicking a name. With the 
record displayed, you can display the next record by clicking F3, or the previous record 
by clicking Shift-F3.  
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More Detail 
If you click More Detail, the How to Find box disappears and a set of option buttons 
appears next to each field on the search screen. These are labeled Equal, Starts, and 
In. This lets you specify the type of search you want to perform for each field, instead 
of all the fields as a whole. For example, you could search for records with a last 
name equal to “Jones” and given names starting with “A.” 

 

Detailed Search Tab 
 
The Detailed Search tab allows you to search for individuals using much stricter criteria. 
You can use AND and OR modifiers to look for specific types of individuals in specific 
places. 

 

Who to Look For 
Select the type of person you want to find. You can search for a male, a female, an 
individual (who can either be a male or female), or a marriage. 

 

Where to Look 
Select the field you want to look in. 
What you are allowed to enter into the What to Look For field is controlled by the 
field selected in the Where to Look field to the left. Depending on what you 
selected, the What to Look For field may be empty, in which case you will have to 
type in the needed criteria, or the field will contain preset options to choose from. 

 

How to Look 
You can search by using Equal To, Not Equal To, Before, After, Contains, Starts 
With, Sounds Like, and Wildcard. (Some types of searches do not include all these 
search methods.) None of the searches are case sensitive; uppercase and lowercase 
letters always match. 

 

Equal To   finds whatever you enter, matched letter-for-letter. 

Not Equal To   matches will be found for everything except what you enter. 

Before and After   is used for finding dates. 

Greater Than or Equal to  matches anything from a given number and higher. 

Less Than or Equal to  matches anything from a given number and lower. 

Contains   looks through the entire field contents to see if what you typed is found 
anywhere within it. 
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Starts With   matches field contents that begin with what you entered. 

Sounds Like   finds surnames that sound like the name you entered. Everything is 
converted to standard Soundex codes before comparing.   

 (Help index: Soundex) 

Wildcard   provides pattern matching, like Dav* (Dave, Davis, Davidson, 
Davenport, etc.) or Berd?n (Berdan, Berden, Berdin, Berdon, Berdun).   

 (Help index: Wildcard search) 
 

What to Look For 
Type in the information you want to find, or select the item from the drop-down list 
box. 

 
Adding Search Criteria 

You can specify up to three different conditions to search for. To enable the next 
condition, select Second Condition then Third Condition, choose AND or OR, and 
fill in the search fields. 

 

Using AND and OR 
If you select the AND option for a search condition, both of the search comparisons 
must be true in order for the individual to be selected. For example: 

Male, Last Name, Equal To, Johnson 
AND 
Male, Age, Greater Than, 50 

 

displays all individuals who are male, with a last name of Johnson, and were born 
more than 50 years ago. 

 

When you select the OR option, only one or the other (or both) of the search 
comparisons need be true to select the individual. For example: 

 

Individual, Title, Equal To, Duke 
OR 
Individual, Title, Equal To, Duchess 

 
will display all individuals, either male or female, who have either a title of Duke or 
Duchess. 
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If you use three search conditions, any search conditions using AND are done before 
any using OR. If the final result is true, the individual is displayed.  
 
Here are some examples of single and combined search conditions: 

True Displayed 
False Not Displayed 
True AND True Displayed 
True AND False Not Displayed 
True OR True Displayed 
True OR False Displayed 
False OR True Displayed 
False OR False Not Displayed 
True AND True AND True  Displayed 
True AND True AND False Not Displayed 
True AND True OR False Displayed 
False OR True AND True Displayed 
False OR True AND False Not Displayed 
False OR False OR True Displayed 
 

Starting the Search 
After specifying a search criteria using one of the three search methods, you can 
either display the individuals found one at a time or in a list format.  

 
One at a Time 

To display the records one at a time, click Find First. Legacy finds the first person 
matching the search criteria and displays that individual on the screen in the current 
Family View or Pedigree View. You can then press F3 to move to the next person 
matching the search criteria. Shift+F3 moves backward through the group. 

 
Creating a Search List 

To create a list containing all the individuals who match the search criteria, click 
Create List. If you are creating a list, you can either begin a new list, add to an 
existing list, or search a previously created search result group.  

 
Clear List before this search   clears any existing search list before doing the 
current search. The resulting search list will contain only the people from the current 
search. 

Add results to existing Search List   retains any previous search list and adds 
the current search results to it. This way you can combine two or more subsets of 
people into one list. 
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Only search the Search List   causes Legacy to restrict its search to the existing 
search list. For example, if the previous search list contains all the people born in 
Boston and you are now searching for all people who died of cancer, the result will 
be all the people who were born in Boston and died of cancer. 

 

Search List Window 
 The Search List window is the same window that appears from the Name List command. 
Through this window any person in the Legacy family file can be quickly and easily 
found. When the Search List has been created through a search command, it can be 

closed and called up again later by clicking on the Search List  icon (Deluxe 
Edition only) on the 
toolbar or by choosing 
View Search List 
under the Search 
menu. 

 
Notice that the details 
for each individual in 
the name list are 
shown on the right 
side of the screen. This 
data changes as each 
individual is selected. 
The field name titles 
such as Born, Chr., 
Death, etc., can be 
changed by clicking 
on a line label and 
selecting from the list 
of available options. 
 

 

Once a Search List has been created, additional individuals can be found and added to the 
list by selecting the Add results to existing List option on the Search window, before 
clicking Create List. The search results remain active and available until they are 
replaced by another search. You can even quit Legacy, come back later, and use the old 
search list.  It is automatically saved. 
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Miscellaneous Searches Tab 
The following searches are also available: 

 

Searches Dealing With the Current Individual 

Focus Group   finds all the members of the current focus group. (See Focus 
Groups on page 211 for more information on setting up these groups.) 

Oldest Direct-Line Generation   finds all the individuals who are in the oldest 
ancestor generation. This could be one person or many. For example, if the ancestors 
go back 10 generations and there are five individuals in that 10th generation, those 
five will be found. If it goes back 11 generations and there is only one person, that 
individual will be the only person found. 

Youngest Direct-Line Generation   finds all the individuals who are in the 
youngest descendant generation. 

Direct-Line Ancestors With no Parents   finds all the ancestors of the current 
individual who have no mother and father linked to them. In other words, the ends of 
all the ancestor lines. 

Direct-Line Descendants With no Children   finds all the descendants of the 
current individual who do not have any children. In other words, the ends of all the 
descendant lines. 

 

Searches Dealing with the Entire Family File 

Linked Individuals With no Children   finds all individuals who are linked to 
either a spouse or a parent, but have no children linked to them. 

Linked Individuals With no Parents   finds all individuals who are linked to 
either a spouse or a child, but have no parent linked to them. 

Unlinked Individuals   finds all individuals who are not linked to anyone. 

All Records With an Individual Tag # of x   finds all the records that have been 
tagged with the specified tag number. 

All Records With Bad Dates   finds all individuals who have an unrecognized 
date anywhere in their information. (This can happen because of ignored warnings 
when editing and importing.) 

Individuals who are Married   finds all the people who have one or more spouses 
linked to them. 

Individuals With an Unknown Spouse   finds all the people with some marriage 
information but no actual spouse linked to them. 
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Individuals With Multiple Spouses   finds all the people who have two or more 
spouses linked to them. 

Individuals With Multiple Parents   finds all the people who have two or more 
parents linked to them. 
 

Missing Sources Search 
You can search for individuals who are missing a source citation on various pieces of 
information that has been entered.  This will give you a list that you can use to go back 
and figure out where the information came from. 
 
Select the checkboxes for the items to search on.  You can select as many as you want to.  
In the How to combine the selected fields box in the lower-right corner you can indicate 
how to handle multiple selections.  Either ALL of the selected fields must be missing 
information for a match or Only ONE or more of the selected fields must be missing 
information for a match. 
 
When you have selected the desired field and set the combine option, select one of the 
options below to begin the search: 

 

Missing Information Search 
You can search for individuals who are missing various pieces of information.  This will 
give you a list that you can use to go back and try to fill in the blanks. 
 
Select the checkboxes for the items to search on.  You can select as many as you want to.  
In the How to combine the selected fields box in the lower-right corner you can indicate 
how to handle multiple selections.  Either ALL of the selected fields must be missing 
information for a match or Only ONE or more of the selected fields must be missing 
information for a match. 
 
When you have selected the desired field and set the combine option, select one of the 
options below to begin the search: 
 

Census List 
Inspired by the release of the 1940 U.S. Census, the Create a List of Potential Individuals 
feature was added to Legacy to help generate a list of people who can probably be found 
in a particular census for a particular location. 

 
The Census List screen is reached by clicking the Search icon on the main view or the 
Search icon on the Name List and then clicking on the Census List tab.  You can also 
choose Find… from the Search menu.  Another convenient way to reach the Census List 
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screen is to click on the Census button on the main toolbar.  (If the Census List button is 
not included on your toolbar, you can add it by right-clicking on any tool in the main 
toolbar to bring up the Customize Main Toolbar screen and then dragging the Census 
button up to the Main Toolbar from the Available Toolbar Buttons list.   

 
Generating a Search List or printing a Census List report is done in three steps: 

 
1)  Choose a Country: 

The Country combo box can be used to automatically fill in the Place field below it 
with the country you want to select.  The combo box contains a list of many countries 
that have census information available.  When you select a country, it is filled into 
the Place field for you. (Legacy uses whatever is in the Place field when doing the 
search, not what is in the Country combo box. The combo box is just a convenient 
way to fill in the Place field.)  
 
If you want to manually enter a location, you can type it directly into the Place field.  
You might want to do this if you are interested in a country that is not in the combo 
box.  For example, Albania, or Madagascar.   You can also include state names in 
the Place field.  For example, Maine, United States or British Columbia, Canada.  
For the best results, you should always spell out fully each part of the location in the 
Place field.  Use Maine, United States instead of ME, US, use British Columbia, 
Canada instead of BC, Can. 
 
You can even enter a city name as part of the location.  When doing this be sure to 
enter the rest of the location, such as Las Vegas, Nevada, United States or London, 
England.  You should not enter the county portion of a location unless you really 
want to filter your list down to include only locations that include the county name. 
 
Remember, it is the entry in the Place field that is used when creating the Potential 
List, not the country that is showing in the Country drop down list.  The drop down 
list is only used to help you fill in the Place field. 

 
2)  Choose the census year 

The Date combo box contains the years of all the available censuses for the country 
that is selected in the Country combo box.  When you select a year from the combo 
box, the actual census date (if known) is automatically filled into the Date field.  
(Legacy uses whatever is in the Date field when doing the search, not what is in the 
Date drop down list.  The combo box is just a way to help you fill in the Date field.) 
 
You can also skip using the Date drop down list and just manually enter a date into 
the Date field.  It can be just a year or a full single date.  Do not enter date ranges or 
modifiers like, About, From, Before, After, etc..  Legacy won't know what to do 
with these. 



 Searching 

Legacy User Guide 265 

 

 
Average Life Span - If a birth or christening date can't be found, the life span entry 
is used to estimate when a person was born by subtracting the value from the death or 
burial date.  Or, if there is no death information, the death can be estimated by adding 
the life span value to the birth or christening date. The average life span you select 
should be tempered by the census date time period.  Here is a partial list from 
Wikipedia: 
 

Classical Greece and Rome:  28 
Pre-Columbian North America: 25-30 
Medieval Islamic Caliphate: 35+ 
Medieval Britain: 30 
Early Modern Britain: 25-40 
Early 20th Century: 31 
Current world average: 67.2 (2010 est.)  

 
Age Filter - If you want to limit the results to individuals of a certain age or age 
range, select this option and fill in the lower and upper ages of the range. 
 
Gender Filter - You can limit the results to either Male or Female by selecting this 
option and setting the gender desired. 
 

Search List Options Tab 
 
The options on the Search List Options tab apply only to creating a search list. 
 

Exclude individuals from the Search List who appear to have already 
been found in this census - Legacy looks in several places to see if the 
current census has already been referenced for a particular person.  These include 
event names and descriptions, individual and event source citations, and 
individual notes.  If the current census is mentioned in any of these places, you 
can have the person excluded from the search list. 
 
Exclude individuals from the Search List with location percentages 
less than X % - Each location Legacy finds is given an estimated location 
percentage dependent upon the location's date and how close it was to the census 
date.  Locations with low percentages can be excluded from the search list by 
selecting a percentage value as the minimum acceptable.  

 



Searching 

266 Legacy User Guide 

 

Report Options Tab 
 
When generating the report, there are several options that can be selected. (These 
options do not apply when creating a search list): 
 

Include married names for wives - Married names for wives will be 
included under the maiden names.  This is important because married individuals 
are shown using their married names on a census list. 
 
Include alternate names - Alternate spellings and nicknames will be included 
under the main names.  These too are often given to census takers. 
 
Include surrounding relatives - The parents, spouses, and children of each 
main individual are listed below the main individual's name so you will have an 
idea of who else to be looking for on a census list. 
 
Italicize individuals who appear to have already been found in this 
census - If the census has already been used for a particular person, his or her 
name is printed in italics.  (If this option is selected, the option to Exclude 
individuals who appear to have already been found in this census is 
automatically turned off.) 
 
Exclude individuals from the Report who appear to have already 
been found in this census - Legacy looks in several places to see if the 
current census has already been referenced for a particular person.  These include 
event names and descriptions, individual and event source citations, and 
individual notes.  If the current census is mentioned in any of these places, you 
can have the person excluded from the census report. 
 
Exclude individuals from the Report with location percentages less 
than  X % - Each location Legacy finds is given an estimated location 
percentage dependent upon the location's date and how close it was to the census 
date.  Locations with low percentages can be excluded from the census report by 
selecting a percentage value as the minimum acceptable.  

 
Include calculated dates (underlined) - If a person is missing birth or death 
date information, the Average Life Span value is used to approximate the missing 
date.  If this occurs, the calculated date is shown with a leading "Cal:" and is 
underlined. 
 
Horizontal lines between rows - Includes a horizontal line at the top of each 
person's information block.  This makes it easier to see where each person 
begins. 
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Include RINs & MRINs - Includes the record ID numbers at the end of names. 
 
Color Text and Boxes - (Deluxe Edition only)  Three different color options 
are available when printing the Census List report.  These include coloring the 
names on the report with either Ancestor Colors, Gender Colors, a color of 
your choice, (or no coloring at all).  To select the desired coloring option, click 
the Color Text and Boxes button and make your choice.  See Custom Box 
Colors for more information. 
 
Page Setup 
Click the Page Setup button to change page margins, print orientation, paper 
size, heading and page numbering options, and footer options.  See Page Setup 
for more information. 

 
Font Size 
Click the Change Fonts button to select a different font or font size for the 
report.  See Report Fonts for more information. 

 
3)  Create the List or Report 

You can either generate a Search List or print a pre-designed Census List Report. 
 
Search List 
The Search List for the potential individuals is just like any other search list created 
by Legacy.  It results in a name list containing only the matching individuals.  To 
generate a search list, click the Create a Search List button.  See Something Else to 
Consider below for other options when creating a search list. 
 
Census List Report 
Clicking the Print a Census List Report button generates a pre-designed report 
showing each matching individual with their name, birth and death dates, the age 
they were at the census date, and the probable location that qualifies them for the list.  
An estimated match percentage is also shown as an indication of how likely it is that 
the person will be found at that location.  The further away the location date is from 
the census date, the lower the percentage.  Also, if there are non-qualifying locations 
between the matching location and the census date, the percentage goes down.  For 
example, if a person has a Residence event with a qualifying location followed by 
one or more Residence or other events with non-qualifying locations, the estimated 
match percentage goes down substantially. 
 
Note: Before clicking the Print a Census List Report button, look at the Search 
List Creation Options in the Something Else to Consider section below. 
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Something Else to Consider 
 
Stepping Through Records One at a Time 
If you want to step through all the records one at a time, click Find First in the lower-left 
corner of the Search screen.  Legacy will find the first person matching the search criteria 
and display that individual in the current Family or Pedigree view.  You can then press 
F3 to move to the next person matching the search.  Shift-F3 moves backwards though 
the group. 
 
Search List Creation Options 
 
In the lower-left corner of the Search screen there are three options that will control who 
ends up in the resulting search list or report: 
 
Clear List before this search:  This option clears any existing search list before 
doing the current search.  The resulting search list will only contain the people from the 
current search. 
 
Add results to existing List: Any previous search list is kept and the current search 
results are added to it.  This way you can combine two or more subsets of people into one 
list. 
 
Only search the Search List:  This option causes Legacy to restrict its search to the 
existing search list.  For example, if the previous search list contains all the people who 
were Male, the resulting Census List will only include people who were living in the 
specified place on the specified Date - who were Male.  This is a very powerful option. 

 
 

Search the Internet 
The Internet is a great place to search for your family members. Billions of people are 
documented in thousand and thousands of genealogical sites across the World Wide Web. 
From Legacy you can search the Internet for information about people in your family file. 
This is often a good way to extend your family lines and find other living relatives 
working on the same things. 
 
To start a search on the Internet, choose Search Internet from the Search tab of the 
Ribbon bar. 
 
There are many, many places on the Internet where you can search for information about 
your ancestors. Legacy comes preloaded with eight sites to begin your searching. Any 
number of additional sites can be added at any time. 
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The Search the Internet screen, has several fields that are preloaded with information 
concerning the current individual. Below the fields is a list of up to eight Internet search 
sites where you can look for additional information and about this person and their 
surrounding family. Each Internet site requires some or all of the information shown in 
the top half of the screen. The fields that are not needed for the currently selected site are 
disabled (grayed out). The remaining “live” fields can be changed before initiating the 
search. As you select different search sites, the appropriate fields are made available. 
 
  To start an Internet search: 

1. Click on the desired search site. 
2. Make sure the information in the fields reflects the person you are looking for. 
3. Click Search. 

 
If you would like the Search the Internet window to remain displayed after you search for 
a person, make sure the Close this window after each search option is cleared. Selecting 
this option will cause the window to close when a search is done. 
 
To customize the list of eight Internet search sites, click Customize Searches. (This is a 
Deluxe Edition only feature.) The Customize Internet Searches window appears with the 
eight currently selected sites showing. You can then change any of the sites to something 
different.  
 
When you are done searching, click Close. 
 

Customize Internet Searches 
The Customize Internet Searches window is reached by clicking Customize Searches on 
the Search the Internet window. 
 
To add or change one of the eight Internet search sites, click Select to the left of the site 
you want to change. The Select an Internet Search screen appears where you can choose 
a site to search, or add a new one. (See Select an Internet Search below for more 
information.) 
 
To reset the current list of eight site to the defaults that came with Legacy, click Defaults. 
 
When you have a group of searches set up the way you like them, you can save them for 
future use. Any number of search sets can be saved and reloaded at any time. To save a 
search set, click Save and then specify the name and location where you would like them 
saved. To reload a set, click Load and specify the set you would like to pull in. 
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Select an Internet Search 
The Select an Internet Search screen is reached by clicking one of the Select buttons on 
the Customize Internet Searches screen. 
 
Legacy comes with several Internet search sites ready for you to use. The Available 
Internet Searches list includes these and any others you have defined.  As you highlight 
each line, the search string is displayed below the list. The character sequence that is used 
to replace a space in the search string is also displayed. (Internet search strings do not 
have any blank spaces in them. So, to pass information that contains a space, like a 
givenname-middlename combination (John Francis), the space is replaced by one or more 
other characters. These are usually a plus sign (+) or the hexadecimal version of the 
character like %20.) 
 
To select a site from the list, highlight the desired line and then click Select. 
 
To make changes to an entry in the list, highlight the entry and then click Edit. The 
Create Custom Internet Search screen appears where you can make any needed changes. 
 
To add a new Internet search to the list, click Add. The Create Custom Internet Search 
screen appears where you can enter the search string to be used. 
 
You can also delete any search entries you no longer want to keep in the list. To do this, 
highlight the line you want to remove and then click Delete. 
 

Creating Custom Internet Searches 
The Create Custom Internet Search screen is reached by clicking Add or Edit on the 
Select an Internet Search screen. 
 
This screen is used to add a new Internet search string or to edit an existing string. 

 (Help index: Define:Internet Search) 
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Search and Replace 
Search and Replace helps you globally search through your entire family file to make 
changes. You can search for and replace the contents of Given Names, Surnames, Titles, 
Alternate Names, Notes, Dates, Lists, Sources, Multimedia, Addresses, Events, 
Repositories, To-Do items, and more. Over 100 fields can be changed. 
 
 To use Search and Replace: 

1. From the Search tab of the Ribbon bar, choose . 
2. From the Find Where list, select the field in which you want to perform the 

search and replace. 
3. In the Find What field, fill in the contents you want to search for. 
4. In the Replacement Text field, enter the text you want to change it to. 
5. Under How to Find and How to Replace, set any desired options. 
6. Click Start. 

 
When Legacy finds the first matching search text, the Replacement screen is 
displayed. If you want to make the replacement, click Replace. Click Skip if you 
would like to move on to the next match. If you are confident that you want to 
automatically make the change on all the remaining matches, click Replace All. 
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Web Page Creation 
How to Create Web Pages for the Internet 

 
 

Publishing your genealogy on the Internet can be a highly effective way of sharing 
information with others. Legacy’s comprehensive Web Page Creation utility generates 
five styles of Web pages including Ancestor Book, Descendant Book, Pedigree, Family 
Group, and Individual. All styles are easy to navigate and each includes a table of 
contents, name index, customizable content, and extensively cross-linked pages. 

 
Legacy also allows custom HTML codes to be embedded by advanced users who want to 
add buttons and other features. Web pages can include links to other sites and 
downloadable GEDCOM files. 

 

Planning a Web Page 
Before you begin creating your own web site, take some time to plan it. There are three 
basic things to determine before you can begin: 

 Where and how will you upload your pages to the Internet? Contact your Internet 
service provider (ISP) for details. 

 Decide on a Web page style that best presents your genealogical information on 
the Internet. 

 Decide whom you want to include (and exclude) in the web pages.  
 

Creating a Web Page 
 
  To make a Web page: 

1. From the Internet tab of the Ribbon bar, choose the style of Web page you want 
to create by selecting a style from the Create Web Pages section.  

 
You can choose from: Ancestor, Descendant, Pedigree, Family Group, or 
Individual.  

2. Select the options you want to use from the ten tabs (described below). 
3. Click Create Web Pages. 
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Web Page Options 
There are many options that can be used when exporting a Legacy file.  These 
include where to generate the web pages, contents, and index, who to include, what 
to include, formatting, suppressing of information for living individuals, privacy 
issues, what graphics to use, pictures to use, and many others.  See the help topic for 
complete information on all of the options. 

  

 (Help index: Web page creation) 
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Legacy FamilySearch 
How to Syncronize with FamilySearch Family Tree 

 
Legacy FamilySearch 

Legacy is fully integrated with the FamilySearch family tree website provided by the Family 
History department of the Church of Jesus Christ of Latter-day Saints.  It is one of the most 
heavily visited genealogy sites on the Internet.  Millions of people use FamilySearch 
resources to learn about their family history. FamilySearch access is free. 
 
The FamilySearch integration feature in Legacy can be turned on or off.  This setting is 
reached by choosing Customize from the Options tab of the Ribbon bar and then going to 
the General section.  The Integrate with FamilySearch option is near the bottom of the 
section. 
 

When FamilySearch integration is turned on, small icons  appear at the end of the 
names on the Family and Pedigree Views to show if that person's information is synchronized 
with the information in FamilySearch. These icons change to indicate the status of 
synchronization and temple work completion.   
 

The FamilySearch search icon  on the My Toolbar tab of the Ribbon bar can also be 
used to open the FamilySearch screen with the current person in your family file as the focus 
person. 
 
A complete, up-to-date description of the synchronization process with family tree is 
available in the online help system of Legacy: 

 

 (Help index: FamilySearch, Overview) 
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Miscellaneous Tools and Utilities 
Handy Utilities to Make Life Easier 

 
 

File ID Number Assistant 
Many users create a filing system for the documents they collect during their research.  
Filing numbers are part of this system and are used to organize the documents.  File 
number fields are available on Master Source documents, source citation documents, To-
Do items and Pictures.  The File ID Number Assistant is used to help you figure out what 
the next available ID number is for any of the different categories.  If you are using a 
system of filing numbers that contains letters and numbers and you need to be reminded 
of the next available increment of the number portion, the Assistant can help.  The 

Assistant is reached by clicking the  button to the right of any File ID field.   

 (Help index: File ID Number Assistant) 
 

File Maintenance 
File maintenance in Legacy (reached by clicking the File Maintenance button on the 
File tab of the ribbon bar) consists of four options:  Check/Repair Family File, Master 
Lists Cleanup, Compact Family File, and Set File Sorting Order.  These options do some 
checking to make sure the integrity of your family file is correct. 

 
Check/Repair   

The solution to many family file problems can be found by performing the 
Check/Repair option in File Maintenance. This option rebuilds indexes, performs 
over 100 integrity checks of all information, and repairs errors that it finds. Anything 
that appears to be wrong is reported to you. 

 (Help index: Check and Repair Family File) 
 

Master Lists Cleanup    

Remove Abandoned Information   You can have unused entries removed from 
any or all of the master lists maintained by Legacy.  For example, abandoned entries 
can happen in the Surname List if you were to delete all the people with a certain 
surname from the family file. That surname would still remain in the master list as an 
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unreferenced name. You can have Legacy run through the Surname List to remove 
any names that are not being pointed to. This is most often the case if you entered a 
misspelled name and then later corrected it. “Smiht” could end up in the list, taking 
up room, and never be referenced. 

 (Help index: Master Lists Cleanup) 
 

Compact Family File   

When individuals are deleted from the family file, all references to them are 
removed, but the record is still taking up space in the file. To remove the unused 
records, select this option. Legacy goes through the file and deletes all records that 
are not referenced, making your family file smaller.  

 
Set File Sorting Order 

The sorting order of a family file determines the order that the various letters of the 
alphabet are displayed in lists and on reports.  You can choose from the following 
sorting orders: 

1. English, French, German, Portuguese, Italian, and Modern Spanish 
2. Dutch 
3. Norwegian and Danish 
4. Spanish 
5. Swedish and Finnish 

When you change the sorting order of a family file, all the internal indexes must be 
rebuilt.  (Since this is a change to the family file, it is a good idea to make a backup 
before proceeding.)  Depending on the size of your family file and the speed of your 
computer, this operation may take a while. 

 (Help index: Set File Sorting Order) 
 

Backing Up Your Family File 
Making regular backup copies of your family file information is essential, yet is often 
taken for granted or ignored by many. Backups are a fundamental part of using a 
computer. If you don’t make backups, there will come a day that you will be sorry.  

 (Help index: Backing Up a Family File) 
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Deleting a Family File 
If you want to erase a family file, choose Delete File from the File tab of the Ribbon bar. 
After confirming your intention, Legacy deletes the currently opened family file. 
 

Setting Direct-Line Preferences 
As you move from younger generations to older ones in both the Family View and the 
Pedigree View, Legacy automatically chooses the preferred parents of the current 
individual. (You can change the preferred parents, if there is more than one set, by right-
clicking on an individual and choosing View / Parents List.) As you move back down to 
younger generations, you will oftentimes get “lost” because you can’t remember which 
child to select. 
 
You can have Legacy automatically reset all the direct-line ancestors of a specified 
individual to preferred. This way, as you navigate up and down through the generations, 
you can find your way back down the same way as you went up.  

 (Help index: Direct Line) 
 

Testing Picture and Sound Locations 
When you import information from a GEDCOM file that contains references to picture, 
sound, and other files, Legacy needs to know where they are located on the new 
computer. Most of the time, when you receive a GEDCOM file from another person, it is 
not accompanied by the multimedia files. To reconcile the file links, have Legacy search 
for them. 

 (Help index: Checking Multimedia Locations) 

Clearing Import Tags 
Whenever you import records into your family file, Legacy marks them as “Imported.” 
You can see if a record was imported by popping up the Last Modified window by 
clicking on the Modified Date box at the right end of the status bar at the bottom of the 
main window. If you want to clear all the “Imported” marks, choose Other Tools > 
Clear Imported Tags from the Tools tab of the Ribbon bar. 
 

Trees in This Family File 
What Are Trees? 
A tree is a group of individuals who are all linked together in some way. Ideally, there 
should be only one tree in a family file. But, in the process of deleting or unlinking 



Miscellaneous Tools and Utilities 

280 Legacy User Guide 

 

individuals, unintentional trees of unlinked lines or individuals may result in a family file. 
Or, you may add unlinked individuals or groups, hoping to find where they fit into your 
family in the future. To find the various trees in a family file, use the Tree utility in 
Legacy. 

 (Help index: Counting Trees) 
 

Global Sorting 
Children, Marriages, and Events 
The Sort Children, Marriages, and Events screen is reached by clicking the Other Tools 
button on the Tools tab of the Ribbon bar and then choosing Sort Children, Marriage, 
and Event Lists from the submenu.  
 
By default, Legacy tries to place new children, marriages, and events into chronological 
order as you enter them. If what you are entering has a date, Legacy will do its best to 
place the item into the correct position - otherwise it will be placed at the end of the list. 
If you know where the item really goes, you can manually move it into position.  
 
You may have a group of children where some have birth dates and others do not. 
Sometimes you know what order a child should be placed even though you don't know 
the date. "William and Mary's second child was Martha..." In Legacy you can manually 
move that child into whatever position you want to. If you blindly sort the birth order 
later, all the children with the blank dates will be moved to the top. "Nothing" sorts 
before "Something." 
 
Sorting things that might or might not have a date is a bit tricky and you need to 
understand the rules Legacy follows when doing this. 

 If all the items in a group have a date associated with them, Legacy will sort the 
group into chronological order with the earliest date at the top. 

 If some items have dates and others do not, Legacy will sort the items (children 
or marriages or events) with no dates to the top of the list. This will often be 
incorrect. There is an option to not sort a particular list if there is one or more 
blank date in the group. 

 
Place a checkmark on the groups of items that you want to sort. If you don't want to sort 
groups with one or more missing dates, select the sub-option for that group that will tell 
Legacy to skip those lists. 
 
When you are ready, click Sort the Selected Lists.
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What’s New in Version 9.0 
The Best Just Keeps Getting Better 

 

Legacy Family Tree 9.0 adds the following features:   
 

 
Hinting (Standard 
Edition) 
Legacy 9 sifts through billions of 
records from key websites –  
MyHeritage, FindMyPast, 
FamilySearch, and 
GenealogyBank – for new 
information, pictures, and stories 
of your ancestors. As you add to 
your tree, Legacy 9 begins the 
search – automatically!  

 
 
 
 
 
 
Reports and Charts 
See trends in your ancestors’ medical history with the 
new Cause of Death charts. (Deluxe Edition Only) 
 
Expand your genetic genealogy tools with the new X-
DNA color schemes. (Deluxe Edition Only) 
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Get everyone involved at your next reunion or family 
gathering with Family Tree BINGO – play with cards 
of your ancestors, descendants, or a mixture. (Deluxe 
Edition) 
 
You can also now see your tree at a glance in the 
Family Dictionary.  (Standard Edition) 
 
Online Backup   (Standard Edition) 
You’ll never worry about losing your data again. In 
addition to backing up to your hard drive, a thumb 
drive, or a DVD, you can now backup your Legacy to 
the Legacy Cloud. It also makes transferring to a new 
computer a breeze. 
 

FindAGrave.com Searching (Deluxe Edition Only) 
One-click access to your ancestor’s Find A Grave 
memorial. Create a list of people in your tree with or 
without Find A Grave IDs. 

 
 
 
 
 
 
 
Stories (Deluxe Edition Only) 
Preserve the stories of your ancestors or stories of your 
own. The new Stories tool lets you record, organize and 
print multiple stories for any of your ancestors. 
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Hashtags (Deluxe 
Edition Only) 
Create unlimited 
hashtags to describe your 
ancestors. Then search 
for or print a report of 
everyone who shares that 
hashtag. You’re no 
longer limited to 9 tags. 
Call them anything you 
want – #civilwar  
#DNAtested  #farmer  
#ProvenAncestor  
#BrownHair   
 
Compare Two People  
(Deluxe Edition Only) 
Researching two same-named 
individuals? Having difficulty 
differentiating two John Smiths in the 
same place? The new Chronology 
Comparison report puts them side-by-
side, color codes their similarities and 
differences, and helps you determine if 
they could be the same person. 
 
Color Coding 
Legacy’s popular color-coding system 
has been expanded. Now enjoy the 
ancestor color coding in both the Index 
View and Name List, making it simple to 
know what part of your tree you are looking at. 
 
Geneanet.org 

You can now search for people on Geneanet.org, a database that contains over 1 billion 
names.  This site is very useful if you have ancestors in Europe.  There are a lot of family 
trees published on the site as well as databases and BMD data.  Geneanet allows free and 
payed searches.  Both can be used through Legacy.  Searching on a person by Surname, 
First Name, and a date range can be done without a Geneanet.org account.  With a 
Premium account more fields are available to be taken into account.  (See Geneanet.org 
Searching.) 
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Global Sorting of Media Lists 
You can now have Legacy go through your entire family file and sort all the media you 
have added to individuals, marriages, and events.  There is an option to skip the sorting of 
particular lists where there are one or more media files with a blank date which would 
force them to the top.  The same is available for sorting all the children for each marriage. 

 
Automatic Sorting While Adding 

As you add or edit media items (pictures, sounds, videos, documents, and website URLs), 
they are automatically placed in chronological date order.  This saves you lots of time.  
(This automatic sorting is optional and can be set separately for adding or editing.  The 
settings can be changed in section 2.2 on the Data Entry Customize screen.) 

  
New QuickHelp Videos 

Many of the screens in Legacy now include QuickHelp videos you can watch to quickly 
see how all the options work. 
 

And dozens of other enhancements  
Digital pictures are now auto-sorted by date. View all 9 tags in the Name List. Support 
for data entry and reporting of same gender relationships. Direct import from the now-
retired Master Genealogist software. Two additional custom toolbar buttons, and much 
more . . . 
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Tips and Tricks 
All the Cool Things that Makes Legacy So Good! 

 
The Fun Stuff  

Legacy is a very full-featured program that has lots of little features and convenience 
options that may not be obvious when you first start using it. Some of these may even 
escape your detection completely although most are documented somewhere in the 
Legacy Help system. Although these features are not essential to the successful operation 
of the program, you will find that they greatly enhance your effectiveness and efficiency 
and make for a very enjoyable experience while you work. 

 (Help index: Tips and Tricks) 
 
You might want to reread this help section from time to time as you become more 
familiar with Legacy. Each time you do, you are likely to pick up and remember new 
capabilities that you never knew were there. 
 
Another great resource is to go to the Tips from the Experts in the Support box of the 
Legacy Home tab. 
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Troubleshooting 
Finding Out What Went Wrong… 

 

Legacy 9 Software Support  
Our technical support staff can answer questions only about Legacy. Questions about 
Microsoft Windows, family history programs made by other companies, or genealogical 
research in general cannot be answered. For help with Windows, please consult your 
Windows user guide. For help with genealogical research, contact your local library, 
genealogical society, or historical society.  

 
Technical Support 

If you are a registered user of the Deluxe Edition of Legacy 9, you can get free technical support 
and notification of product upgrades.  
 
There are many ways to get answers to your questions using Legacy 9 be it software support or 
how-to questions. Below is a list… 

 
1. Read the Legacy 9 manual as there are screenshots and helpful hints. Search the 

Index in the back of the manual to see if the subject is listed. 
2. Have you seen the Legacy 9 training videos created by Geoff Rasmussen?  
3. Try watching the “Legacy for Beginners” video as it is a 45-minute-long video that 

that covers the basics of starting a family file in Legacy. It can be watched by 
choosing it on the Legacy 9 installation CD or from within Legacy and an internet 
connection and then choose HELP at the top and then choose “Beginners Video.” 

4. Try the Help Index from within Legacy. When you run into a problem or have a 
question while using Legacy, click Help and then choose “Help Index Icon” or press 
F1. The help system is context-sensitive and tries to answer questions about the 
current task. Type in a keyword in the top left area and then hit the Enter key on your 
keyboard for a list of help subjects that you can click on to read. 

5. If your program is locked up, frozen or not working right, try quitting the program 
and rebooting the computer. Sometimes Windows just needs a fresh start. 

6. Have you visited our Webinar website? If not, we have hundreds of webinars that 
cover many subjects. You can subscribe monthly or yearly at a very low cost. If you 
are not a member we still have many free webinar videos to watch. You can reach the 
website by going directly from your Internet browser and enter the website address 
which is http://familytreewebinars.com. 

7. Try visiting our huge Knowledge Base (KB) website that has hundreds of helpful 
support topics. Many have screenshots and instructions that you can print out. From 
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within Legacy just click on Help and then choose “Tech Support.” Once there you 
can type in keywords or an error number in the top right area of the screen and then 
choose from the list below. This KB is updated often and we are adding new subjects 
when we see the need. The direct website link is http://support.legacyfamilytree.com. 
Or from within Legacy choose Help at the top and then choose “Tech Support”. 

8. You can now join our new “Legacy User Group” Facebook page and ask fellow 
Legacy users your question. This is a very active group and we have thousands of 
Legacy users eager to share their Legacy knowledge. The support team often drops in 
with helpful hints and or ideas. Just log into your Facebook account and then at the 
top where you see “Search Facebook” enter “Legacy User Group” to join this closed 
group. The direct website is https://www.facebook.com/groups/LegacyUserGroup/ 

9. You can create a support ticket from within Legacy 9 by choosing Help at the top and 
then choose the “Support Ticket Icon” be sure and fill out as much information that 
you can as this will help us when we email you back. 
 

10. If you would like to email us directly please include your name, deluxe customer 
number, email address, the version of Legacy you have installed along with your 
question or problem. Our email address is support@legacyfamilytree.com. 
 

Millennia’s Web Site 
Visit our World Wide Web home page for exciting information on Legacy and other 
related products. We also have many links to other sites that contain more information on 
compiling your family history. 
 
Our home page address is:  

http://www.LegacyFamilyTree.com 
Our online store address is: 

http://legacy.familytreewebinars.com/ 
Download help is available at:  

http://www.LegacyFamilyTree.com/DownloadHelp.asp 
You can download the full Legacy installation program at: 

http://www.LegacyFamilyTree.com/DownloadNewLegacy9Deluxe.asp 
You can view the free Legacy for Beginners training video at: 

http://familytreewebinars.com/video-detail.php?video_id=11 
You can view the free video that shows some of the new Legacy 9.0 features at: 

http://www.legacyfamilytree.com/WhatsNew9.asp 
You can see the other Legacy training videos that are available at: 

http://legacy.familytreewebinars.com 
You can see the additional Legacy add-on products and other related software and books 
at: 

http://legacy.familytreewebinars.com/ 
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Temple names, 218 
To-Do, 119 
To-Do categories, 219 
To-Do localities, 219 

Living 
automate, 219 

Living indicator, 35 
Loading 

GEDCOM file, 221 
Legacy files, 223 
pictures, 247 
source clipboard, 91 

Locating, 257 
Location, 36 

index, 130 
marriage, 56 
master list, 218 

Locations 
county verification, 37 

  
Maintenance of files, 277 
Male, 35 
Manual merging, 229, 230 
Markers, 46 
Marking 

records, 123, 124 
Marriage 

date, 56 
information, 56 
LDS information, 58 
place, 56 
Report phrase, 63 
sources, 57, 121 
status, 56 
Tags, 62 

Marriage List, 100 
bookmarks, 101 
editing, 100 
jumping into, 100 
searching, 100 
selecting a marriage, 101 

Marriage Status master list, 218 
Married names, 61 
Master List 

address, 217 
all lists, 217 
child status, 217 
cleanup, 277 
event definitions, 43, 218 
location, 218 
marriage status, 218 
picture locations, 218 
source types, 218 
sources, 84, 218 
surname, 218 
temple names, 218 
To-Do categories, 219 
To-Do localities, 219 

Media 
adding, 243 
documents, 244 
web links, 244 

Media Gallery, 243 
Medical notes, 50 
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Memorize 
dates, 55 

Menu 
reports, 127 

Merging 
addresses, 239 
AutoMerge, 234 
events, 238 
families, 237 
introduction, 229 
LDS information, 239 
manually, 230 
notes, 239 
pictures, 238 
preserving information, 234 
skip to next pair, 233 
special cases, 231 
two individuals, 232 
undo, 241 

Message Center - charting, 188 
Monthly calendars, 158 
More pictures, 246 
Movies, 245, 246 
Moving pictures, 244 
Multiple Lines of Descent report, 143 
  
Name 

Married, 61 
Name index, 93 
Name List, 93 

Alternate names, 97, 98 
customizing, 96 
editing an individual, 95 
finding an individual, 26, 94 
jumping into the list, 99 
report, 97 
searching, 26, 94 
selecting an individual, 95 
sorting, 26, 94 
surrounding family, 97 
tagging, 99 
User ID numbers, 98 
zoom, 99 

Name Tags, 162 
Name-only events, 46 
Names 

alternate, 47 

Navigating, 17, 22 
Descendant View, 19 

Navigator Square, 194 
Never married, 39 
New 

event definitions, 43 
To-Do item, 122 

Nicknames, 34, 47 
No children, 57 
Notes 

entering, 50 
medical, 50 
merging, 239 
research, 50 
Stories, 52 

  
Options 

chronology report, 136 
Descendant View, 19 
To-Do filters, 120 
wall charting, 186 

Order form, 31, 32 
Ordering 

events, 42 
Origins report, 143 
Override report phrase, 64 
  
PAF 

import, 224 
Page boundries on charts, 186 
Paper for wall chart printing, 184 
Parent List 

add more parents, 107 
removing parents, 107 
zooming, 107 

Parents, 107 
adding, 107 
preferred, 107 

Pedigree chart, 69, 148 
on Name List, 96 

Pedigree View, 17 
Person never married, 39 
Personal Ancestral File 

importing, 224 
Photo album, 247 
Picture 

list, 253 
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Location master list, 218 
preview, 253 
show, 246 

Picture Center, 251 
Picture gallery, 244 
Picture settings, 188 
Pictures, 243 

adding, 50, 243 
borders on wall charts, 190 
brightness, 249 
caption, 254 
changing format, 251 
contrast, 249 
converting to a different format, 249 
converting to black and white, 248 
cropping, 250 
deleting, 244, 245, 246, 247, 254 
editing, 245, 249 
flipping, 250 
flopping, 250 
loading, 247 
merging, 238 
moving, 244 
on wall charts, 181 
preferred, 245, 254 
printing, 247, 249 
renaming, 253 
rotating, 250 
rotating on wall charts, 189 
sharpness, 249 
slide show, 247 
supported formats, 249 
tagging, 247 
thumbnails, 15 
verifying locations, 279 
zooming, 246, 249 

Places, 36 
marriage, 56 

Planning a Web page, 273 
Possible duplicates, 35 
Potential problems, 154 
Potential Problems 

Exclude individual, 39 
Preferred 

child, 104 
parents, 107 
picture, 245, 254 

setting direct-line as preferred, 279 
spouse, 102 

Prefix title, 34 
Preview pictures, 253 
Printing 

ancestor books, 138 
pictures, 249 
wall charts, 182 

Privacy 
On reports, 129 

Privacy on wall charts, 175 
Privacy settings, 39, 105 
Private 

child-parent relationship, 67 
Invisible, 39, 105 

Problem indicators, 17, 18 
Problems 

gaps, 155 
report, 154 
standardization, 155 

Problems indicator, 39 
Publishing Center, 151 
Publishing wall charts, 182 
Purchasing a wall chart, 185 
Purging unused sources, 86 
  
Query by example, 99, 257 
Questionnaire 

report, 152 
QuickHelp videos, 284 
  
Reading 

GEDCOM file, 221 
Records 

tagging, 123 
Reference Number, 37 
Register 

book report, 136, 139 
Register report 

multiple lines, 143 
Relationship 

calculator, 212 
report, 153 

Relationship diagrams, 152 
Relationship to parents, 105 
Reloading a picture, 250 
Reminder 
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Married, 62 
Reminder of birthday, 38 
Reminder of death date, 38 
Reminders 

Anniversary, 13 
Birthday, 13 
To-Do items, 13 

Removing 
a child from child list, 106 
an individual, 216 
deleted records, 278 
event names, 45 
parents from parent list, 107 
pictures, 244, 245, 246, 247 
unused information, 277 

Renaming pictures, 253 
Repair family file, 277 
Repeating 

address fields, 55 
Report 

Default phrase, 64 
Interview, 159 
Marriage phrase, 63 

Report language, 127 
Reports 

ages, 161 
ahnentafel, 133 
ancestor book, 133 
ancestor chart, 135 
anniversaries, 159 
birthdays, 159 
calendar, 159 
chronology, 135 
descendant book, 136, 139 
descendant chart, 138 
family group sheet, 140 
individual, 141 
LDS ordinances, 158 
lineage, 141 
menu, 127 
Multiple lines of descent, 143 
name list, 97 
potential problems, 154 
problems report, 154 
questionnaires, 152 
register, 136, 139 
relationships, 153 

research logs, 153 
source citation, 160 
surname summary, 160 
timeline, 149 

Repository 
address list, 107, 117 

Research 
log, 119, 153 
notes, 50 
sharing, 240 

Restoring 
merge changes, 241 

Ribbon bar, 11 
maximize, 11 
minimize, 11 
quick access, 11 

Role 
event, 42 

Rotating pictures, 189, 250 
  
Saving 

records, 56 
source clipboard, 91 

Screen saver, 246 
Screen show, 246 
Search 

for Hints, 47 
the search list, 261 

Search and Replace, 271 
Search List 

adding 
to, 260 

clearing, 260 
only search the list, 261 

Searching, 257 
ancestors with no parents, 262 
AND, 259 
by tag level, 262, 263 
descendants with no children, 262 
detailed, 258 
for source template, 74 
marriage list, 100 
miscellaneous, 262, 269, 271 
name list, 26, 94 
oldest generation, 262 
OR, 259 
query by example, 99, 257 
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result list window, 261 
sources, 87 
the Internet, 268 
unlinked individuals, 262 
wildcard, 259 
youngest generation, 262 

Select 
Hints, 69 

Selecting 
a family file, 167 
a file to chart, 169 
a wall chart type, 169 
an person to chart, 170 
dates, 39, 54, 58, 121 
marriage from marriage list, 101 
source, 85 

Set 
living, 98, 219 

Setting file sort order, 278 
Setup 

Hints, 69 
Sex, 35 
Share 

Story, 53 
Shared event 

role, 42 
witnesses, 42 

Shared events, 41 
Sharing information, 240 
Sharpness of picture, 249 
Show half-children, 17 
Show list of source users, 87 
Simple searches, 257 
Skip to next merge pair, 233 
Slide show, 247 
Sliding pictures, 246 
Sort order of file, 278 
Sort string, 49 
Sorting 

child list, 105 
events, 43 
name list, 26, 94 
spouse list, 102 
To-Do list, 120 
wall chart family file list, 168 

Sound, 243, 245 
adding, 50, 250 

Soundex calculator, 212 
Source Clipboard, 39, 54, 58, 88, 121 

erasing, 91 
example, 89 
loading, 91 
saving, 91 

Source Labels, 148 
Source Quality Analysis, 82 
Sources 

adding, 72 
adding new master source, 85 
assigned, 71 
choose a template, 73 
citation report, 160 
citing, 71 
combine duplicates, 86 
detail, 72, 85 
editing, 85 
excluding, 85 
list, 84 
list of users, 87 
marriage, 57, 121 
master list, 218 
name, 72 
purging unused, 86 
searching for, 87 
selecting, 85 
tagging, 85 
Types master list, 218 

SourceWriter, 72 
bookmarks, 76 
choose template by type, 74 
choosing a template, 73 
citation details, 80 
filling in a template, 77 
keywords, 74 

Spacing on wall charts, 180 
Special merges, 231 
Spell checking 

global, 217 
Spouse, 101 

adding a new spouse, 102 
attaching, 216 
deleting a spouse, 103 
linking to an existing spouse, 102 
reordering the list, 102 
selecting a spouse to display, 102 
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setting a spouse as preferred, 102 
sorting, 102 
unlinking, 103, 216 

Standardization checking, 39 
Standardization problems, 155 
Starting 

a new wall chart, 174 
person of wall chart, 174 

Starting a new wall chart, 166 
Starting person for wall chart, 170 
Statistics, 13 
Statistics Report, 149 
Status 

child, 105 
marriage, 56 

Stories, 52 
Story 

Add, 52 
Suffix title, 34 
Support, 13 
Surnames 

master list, 218 
summary report, 160 

Surrounding family on Name List, 97 
Swapping 

alternate names, 48 
Swapping husband and wife, 216 
  
Tag 

Marriage, 62 
Tag level, 124 
Tagging, 123 

a family, 124 
advanced, 124 
an individual, 124 
ancestors, 125 
clearing import tags, 279 
descendants, 125 
everyone in the Family File, 125 
names in the Name List, 99 
pictures, 247 
sources, 85 

Template 
choose by type, 74 
choose from list, 74 
filling it in, 77 
search by keyword, 74 

Template for source, 73 
Temple Names master list, 218 
Testing picture and sound locations, 279 
Text on wall charts, 182 
Text settings on wall charts, 190 
Themes on wall charts, 176 
Timeline 

column on report, 24 
report, 149 

Title, 34 
Title of wall chart, 181 
To-Do 

clipboard, 121 
filter options, 120 
list, 97, 119 
new item, 122 
Reminder, 13 
report, 163 
sorting list, 120 

To-Do Category master list, 219 
To-Do Locality master mist, 219 
Toolbars 

customize, 213 
Tree View, 17 
Trees in Family File 

Finding, 279, 280 
  
Undoing a merge, 241 
Unlinking 

a spouse in the spouse list, 103 
child from parents, 216 
marriage, 101 
spouse, 216 

Unlock Deluxe Edition, 32 
Untagging, 124 
Unusual time gaps, 155 
Update, 13 
Updates to wall charting, 188 
US County Verifier, 37 
User ID in Name List, 98 
User reference number, 37 
  
Verifying US counties, 37 
Video, 245, 246 
View 

Chronology, 21 
descendant, 18 



 Index 

Legacy User Guide 301 

 

Family, 15 
Pedigree, 17 

  
Wall charts, 165 

Appearance tab, 175 
background, 180 
box borders, 179 
box items, 177 
box spacing, 180 
box width, 180 
change starting person, 174 
changing chart type, 175 
colors, 176 
creation wizard, 167 
date options, 187 
emailing, 183 
exporting, 183 
filtering the list, 168 
generation width, 180 
generations, 175 
gradient fills, 177 
help, 185, 187 
home tab, 174 
Insert tab, 181 
lines, 179 
loading, 166 
Message Center, 188 
navigator square, 194 
options, 186 
ordering a printed chart, 184 
page borders, 179 
page boundries, 186 
paper descriptions, 184 
picture borders, 190 
picture settings, 188 
pictures, 181 

privacy, 175 
publishing, 182 
purchasing, 185 
quick acesss toolbar, 192 
ribbon bar, 172 
rotating pictures, 189 
screen description, 172 
selecting a chart type, 169 
selecting a file, 169 
side toolbar, 193 
sorting family file list, 168 
starting a new chart, 174 
starting new, 166 
starting person, 170 
status bar, 195 
text boxes, 182 
text settings, 190 
the starting person, 174 
themes, 176 
title, 181 
updates, 188 
zooming, 193 

Web links, 244 
Web pages, 273 

Legacy home page, 288 
Wildcard searches, 259 
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Wizard 

wall chart creation, 167 
  
Zooming 

name list, 99 
parents list, 107 
pictures, 246, 249 
wall charts, 193 

 


